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Getting Started

System Requirements
To use the Eudora Pro electronic mail (e-mail) application (hereafter referred to as
Eudora), you must have the following:

• A Macintosh Plus or later model, with a high-density disk drive.

• Macintosh System 7.0 or later.

• A mail account with an Internet service provider or an Internet-style network
account.

• Access to your mail account via modem or Internet-style network connection.

Note: Some Eudora plug-ins, such as QUALCOMM’s PureVoice™
Player-Recorder, for recording and sending voice messages with
your e-mail, require more advanced configurations, such as a
Power Macintosh and System 7.5 or later, and/or additional
equipment such as a sound card and speakers. Be sure to check the
README for each such Eudora plug-in before you use it. Also see
the section “Using Eudora Plug-ins.”

Drag and Drop Requirements
If you do not have Macintosh® Drag and Drop running on your Macintosh,
certain features may be disabled. Macintosh Drag and Drop is included in System
7.5 and System 7 Pro, but is not in earlier versions of System 7.

Macintosh Drag and Drop requires that Finder 7.1.3 or newer is running for the
Drag and Drop extensions to work properly. Installing the Drag and Drop
extensions with an older Finder has been shown to cause strange behavior, and is
not recommended.

If you are running a system version with a Finder that is older than 7.1.3, you will
be able to drag and drop within the Eudora application. However, you will not be
able to drag between Eudora and other running applications.
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Installing Eudora
You can install this version of Eudora over an earlier version of Eudora Pro or any
version of Eudora Light. Just follow the instructions below, and when you open
the new version of Eudora, your Settings, mailboxes, etc. will be updated for the
new version.

To install Eudora, do the following:

1. Restart your Macintosh while holding down the shift key. This turns off
your Macintosh extensions. You must hold down the shift key until you
see the message “Extensions off.”

2. If you are installing Eudora from CD-ROM, insert the Eudora Pro CD
into your Macintosh CD-ROM drive.

3. If you are installing the Eudora Pro and Eudora Productivity Toolkit™
bundle, the Eudora Productivity Toolkit window is displayed. Double-click
on the Eudora Pro 3.1.1 Installer icon to continue. The Eudora Pro splash
screen is then displayed.

Note: If you are installing Eudora Pro and do not have the Eudora
Productivity Toolkit, the Eudora Productivity Toolkit window
is not displayed. Double-click on the Eudora Pro 3.1.1
Installer icon to display the Eudora Pro splash screen.

The Eudora Productivity Toolkit window
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4. Click Continue to display the Eudora Pro README window.

Note: The contents of the README window can be printed or saved
to a file for later review.

5. Once you have reviewed the contents of the README window, click
Accept. The User Code dialog is displayed.

User Code dialog

Your five-digit User Code is printed on the inside cover of this manual,
or, if you are part of a multiple-user site, it should be provided to you by
your organization’s Eudora support coordinator. If you purchased Eudora
by electronic distribution, the User Code is in the e-mail message you
received when you purchased the product.

6. Type your User Code in the User Code field and click Continue.

Note: If you cannot determine your User Code, you may leave this
field blank.

The Eudora Install dialog is displayed, allowing you to select which items
you want to install. To see a description of an item, click on the item (the
description is displayed just below the selection area).
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Eudora Install dialog

7. To install all of the items except for the connectivity software, be sure the
default item Full Eudora Pro 3.1.1 without connectivity is selected and
click Install.

To install all of the items including the connectivity software, select Full
Eudora Pro 3.1.1 installation and click Install.

Note: Do not use this option if you are already connected to a
TCP/IP network. If you are getting an Internet connection for
the first time, and your Internet service provider does not
provide TCP/IP software, you can use this item to install
MacSLIP and MacTCP.

To install just the items you want, select them by clicking on each one
(hold down the command key to select multiple items, and be sure that
neither Full installation item is selected), then click Install.

If you selected either of the Full installation items, MacSLIP, or
MacTCP, the Restart dialog is displayed, informing you that your
Macintosh will need to be restarted at the end of the installation. Click
Yes.

The Eudora Version Selection dialog is displayed, allowing you to select
which version you want to install.
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Eudora Version Selection dialog

The Eudora Version Selection dialog allows you to select from the
following versions:

680x0
This is the smallest version. It runs on any Macintosh, including Power
Macs, but on Power Macintoshes it is not as fast as the PowerPC or
Universal versions.

PowerPC
This version runs only on Power Macintoshes. It does not run on standard
680x0 machines.

Universal (or Fat)
This version requires the most disk space. It runs on any Macintosh, and
on a Power Macintosh runs as fast as the PowerPC version.

8. Select the version you want. A dialog is displayed asking you where you
want to install the Eudora Pro Folder.

Eudora destination dialog
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9. Select the destination folder and click Install. The install program begins
installing the items you selected onto the appropriate locations on your
disk.

10. Once the installation is complete, you are prompted to restart your
Macintosh. Click Restart.

The Restart alert

This completes the installation of the Eudora Pro software. To find out how to set
up Eudora so that you can send and receive e-mail, see the section “Opening and
Configuring Eudora.” For details about the files in the master Eudora Folder that
has just been installed in your System Folder (this will hold all your mail and
other important files), as well as the Eudora Pro Folder that you’ve just installed
in the destination dialog above, see their corresponding sections in the Reference
chapter. The README referred to in the Restart alert is contained in your Eudora
Pro Folder.

Note: Throughout most of this manual, the Eudora Pro Folder is referred
to as the Eudora Pro Application Folder. This is the folder that
contains your Eudora application.

Installing Connection Tools
To use Eudora with the Communications Toolbox, the Apple Modem Tool and
Serial Tool must be installed on your Macintosh. To do this, drag the Connection
Tools folder onto your System Folder. The Connection Tools folder is found in
the Dialup folder, within the Extras folder in the Eudora Pro Application Folder.
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Opening and Configuring Eudora
After you have installed Eudora, double-click on the application icon to open
Eudora. If you are installing Eudora for the first time, the Getting Started Settings
are displayed.

To send and receive messages, you must have an account on a computer running a
POP (Post Office Protocol) server, and access to a computer running an SMTP
(Simple Mail Transfer Protocol) server. Your incoming e-mail messages are
delivered to your POP account, where Eudora picks them up and transfers them to
your Macintosh. Your outgoing messages are sent to the SMTP server to deliver
to your recipients.

You have to provide basic information about your account, servers, and network
connection before you can send and receive messages. To do this, use the Getting
Started Settings (if this is not open, select Settings... from the Special menu and
click on the Getting Started category).

An example Getting Started Settings

In the Real name field, type your real name as you wish it to appear in the From
field of all your outgoing messages. This lets your recipients know who the mail
is from.
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In the POP account field, type your login name for this account, an “@” sign,
and the full name of the computer. For example, if your assigned login name is
“justine,” and the name of the computer where you receive e-mail is
“pop3.qualcomm.com” type “justine@pop3.qualcomm.com” in this field. Your
Eudora administrator can provide you with your login name and your POP server
name if you do not know these.

Your POP account may or may not be the same as your return address, which is
the address at which you normally receive e-mail. If your return address is
different from your POP account, put the return address in the Return address
field.

Specify a connection method. If you are using Eudora via TCP/IP software (e.g., a
direct network connection, SLIP, or PPP), select TCP/IP. If you are using Eudora
without TCP/IP software, select Communications Toolbox, click OK, then
select Communications... from the Special menu and choose the appropriate
modem/serial communications settings. (See “Installing Connection Tools”
above.) If you are not sure what connection method to use, see your Eudora
administrator.

If your POP and SMTP servers are on the same computer, you do not need to
specify an SMTP server. If they are not on the same computer, click on the Hosts
settings category, and in the SMTP field enter the full name of the computer
running the SMTP server.

You are now ready to go. For detailed explanations of all of Eudora’s available
functions, see the appropriate chapters.

Registering Your Copy of Eudora
Depending on the software license you have for Eudora, you may be eligible for
technical support directly from the Eudora Technical Support group. To receive
technical support, you must register your copy of Eudora Pro in accordance with
the terms defined in your license Agreement. If you have a previous version of
Eudora Pro, you need to register this new version.

Note: If you are part of a site license, you do not need to register.
Contact your organization’s e-mail administrator for support.

If you are eligible for technical support, you are prompted to register after you
send the first message with your new version of Eudora Pro.
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Example of Registration Screen

Complete the registration form and click Register. The registration is put in the
queue in your Out mailbox and is sent the next time you send queued messages.

If you don’t want to register at that time, you can choose Not Now to be prompted
7 days later, or Never Register to never be prompted again. At any time, you can
choose Register Eudora... from the Help menu to display the registration form.
The Help menu, also known as the Apple Guide menu, is accessed from the
question-mark-in-the-balloon icon at the top right corner of your screen.

Quitting Eudora
To quit Eudora, select Quit from the File menu. If you have queued messages, or
timed messages due to be sent in the next 12 hours, you are given the option to
send them (see the section “Queueing a Message to Send Later”).

The Trash mailbox is emptied if the Empty Trash on Quit option is on in the
Miscellaneous Settings.
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Online Help
Eudora has an Online Help feature that provides quick-reference instructions for
accomplishing many of Eudora’s operations. To display an Online Help window,
select the topic you want from the Macintosh Help menu, also known as the
Apple Guide menu.

Eudora Help menu
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Eudora also has extensive Balloon Help. To turn Balloon Help on, select Show
Balloons from the Macintosh Help menu. Move the mouse pointer to a Eudora
menu selection or item on the screen to display a brief description of that item.

Balloon Help

You can use Balloon Help even when a dialog is displayed.

To turn Balloon Help off, select Hide Balloons from the Macintosh Help menu.

Note: If you have an extended keyboard with a help key, it can be used to
turn Balloon Help on and off.

Technical Support
If after reviewing all of the available materials—this User Manual, the Quick
Reference Guide, the README files, the Online Help, and the Balloon Help—
you still need help, contact your e-mail administrator (your Internet service
provider or your company’s Eudora support coordinator) or the Eudora Technical
Support group. If you are eligible for technical support, contact information is
provided in the More Help! Online Help topic, and on the inside cover of this
manual.

You must register your copy of Eudora Pro to receive technical support. See the
section “Registering Your Copy of Eudora” for details.
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Creating an Outgoing Message
An outgoing message is a message you send to someone else. To create an
outgoing message, select New Message from the Message menu. A new message
window is displayed, called the composition window. The section below describes
how to use the composition window.

Using the Composition Window
The composition window consists of the title bar, the icon bar, the formatting
toolbar, the message header, and the message body. The formatting toolbar can be
turned on or off.

The composition window

Title Bar
The title bar provides information about the message, including the name of the
addressee, the time and date the message was sent, and the message subject.

Note: Double-clicking on the title bar opens the mailbox that the
message resides in.
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Note: Holding down the command key and clicking on the title in the title
bar opens a menu containing the mailbox and/or folder(s) that the
message resides in.

Icon Bar
The icon bar consists of a series of objects that are displayed just under the title
bar. It allows you to control the priority of your message, override some of your
default settings for the current message, and send or queue the message. Each icon
can be turned on or off for the current message by clicking on it. A checkmark
symbol next to the icon means the icon is on. The popup menus and icons are
described below.

You can set the defaults for the icon bar in the Sending Mail Settings and the
Attachments Settings.

Priority Popup
This lets you indicate that your message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

Signature Popup
This lets you automatically append one of your signatures to the end of a
message. For details, see the section “Using Signatures.”

Attachment Type Popup
This lets you select the encoding format for attachments. For details, see the
section “Attaching a File to a Message.”

Quoted-Printable Encoding
If this is on, quoted-printable encoding is used when sending messages or plain
text attachments that contain long lines of text or special characters. It is
recommended that this always be on.

Include Macintosh Information
If this is on, the Macintosh file-type and resources are included in AppleDouble
and AppleSingle attachments. For details, see the section “Attaching a File to a
Message.”

Word Wrap
If this is on, a carriage return is not required at the end of each line. When the
message is sent, the text is automatically “wrapped,” meaning that carriage
returns are inserted at the end of each line of text, with roughly 76 characters per
line.
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Keep Copy
If this is on, a copy of each sent message is kept in the Out mailbox. These
messages are saved there until they are deleted or transferred to another mailbox.

Return Receipt
If this is on, a cooperating mailer returns a message to you notifying you when
your outgoing message has been displayed by the recipient. This function does
not work in all cases. For details, see the section “Requesting a Return Receipt.”

Send or Queue
These let you send a message immediately or put it in the queue to send later. If
the Immediate send option in the Sending Mail Settings is on, the button is
labeled Send. If the option is off, the button is labeled Queue. For details, see the
section “Sending or Queueing a Message.”

Other icons may appear on the icon bar that represent the visible means of using
certain installed Eudora plug-ins. For more details, see the section “Using Eudora
Plug-ins.”

Formatting Toolbar
The formatting toolbar, when displayed, appears just under the icon bar. It
consists of a series of popup menus and pushbuttons that let you apply text styles
in the current message.

To display or hide the formatting toolbar in the current message only, select the
Formatting Toolbar command from the Text submenu of the Edit menu. To
display or hide the formatting toolbar in all new messages by default, set the
Show formatting toolbar option on or off in the Fonts & Display Settings or the
Styled Text Settings.

The formatting toolbar is highlighted when the cursor is in the message body; it is
dimmed when the cursor is in the message header or when the composition
window is inactive. You cannot change the style of text you type in the header
fields.

If text in the message body is selected, the popups and buttons apply style changes
to that text. If no text is selected but the cursor is in the message body, then the
popups and font-related buttons apply the styles to text typed beginning at the
insertion point, and the margin-related buttons apply the styles to the paragraph in
which the cursor resides.

From the popups, select the text font, size, and color. Click on the buttons to turn
their styles on or off or step through the choices.
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The popup menus and buttons are described below.

Font
Sets the selected text or the insertion point to the chosen font.

Size
Sets the selected text or the insertion point to the chosen size.

Color
Sets the selected text or the insertion point to the chosen color.

Bold
Sets the selected text or the insertion point to bold.

Italics
Sets the selected text or the insertion point to italic.

Underline
Sets the selected text or the insertion point to underlined.

Bigger
Sets the selected text or the insertion point to one size bigger.
Available sizes are those on the Size popup.

Smaller
Sets the selected text or the insertion point to one size smaller.
Available sizes are those on the Size popup.

Align Left
Aligns the selected or current paragraph to the left of the indent.

Align Center
Aligns the selected or current paragraph to the center of the indent.

Align Right
Aligns the selected or current paragraph to the right of the indent.

Indent In
Indents the selected or current paragraph one level: both the left
and right margins are indented in. Available levels are those in the
Edit/Text/Margins submenu.
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Indent Out
Removes one level of indent from the selected or current
paragraph: both the left and right margins are outdented. Available
levels are those in the Edit/Text/Margins submenu.

Hang Indent In
Indents the selected or current paragraph one level of hanging
indent: the whole paragraph is indented in and the first line is
outdented left (all lines “hang” after the first line). Available levels
are those in the Edit/Text/Margins submenu.

Hang Indent Out
Removes one level of hanging indent from the selected or current
paragraph. Available levels are those in the Edit/Text/Margins
submenu.

Completely Plain
Removes all formatting from the selected text or the insertion
point, except font and size changes; with the option key down, also
restores the font and size to their defaults.

For more information on text styles, see the section “Formatting Text.”

Message Header
Outgoing mail headers consist of six fields: To, From, Subject, Cc, Bcc, and X-
Attachments. Each field is described below. The To, Subject, Cc, and Bcc fields
can be directly edited. To move the cursor from field to field, press the tab key or
click in the desired field with the mouse.

To
The intended recipients’ e-mail addresses, or nicknames you have defined (see the
chapter “Using the Address Book and Quick Recipient List”). Multiple addresses
and nicknames must be separated by commas.

From
The sender’s e-mail address. This is usually your POP account plus your real
name. You can use a return address other than your POP account by entering the
address in the Return address field of the Getting Started Settings.

If you have alternate personalities set up, a popup menu appears in this field. You
can use this popup to change the personality associated with the current message.
Changing the personality changes the sender’s information accordingly. For more
details, see the section “Using an Alternate E-mail Account.” Alternate
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personalities are set up in the Settings dialog, under the Personalities and
Personality Extras Settings.

Subject
Some brief text indicating the contents of the message. This field can be left blank
(though it is considered a breach of e-mail etiquette to do so).

Cc
The e-mail addresses or nicknames of people to whom a copy of the message is to
be sent. These recipients are displayed in the message header for all recipients to
see. Multiple addresses must be separated by commas. This field can be left
blank. Cc stands for “carbon copy.”

Bcc
The e-mail addresses or nicknames of people to whom a copy of the message is to
be sent. These recipients are not displayed in the message header, and the
recipients in the To or Cc fields will not know that a copy went to these
addresses. This is useful when you want to send a copy of a message to someone
without everyone else knowing you did so. Multiple addresses must be separated
by commas. This field can be left blank. Bcc stands for “blind carbon copy.”

This field can also be used to put a copy of the message in one of your mailboxes.
To do this, put the cursor in the Bcc field and select the mailbox from the Fcc
menu (normally the Transfer menu). The name of the mailbox is inserted into the
Bcc field preceded by an italicized “ƒ” and the whole expression placed in quotes,
and when the message is sent, a copy is put in that mailbox. Fcc stands for “folder
carbon copy.”

X-Attachments
A list of documents being attached to and sent along with the message. See the
section “Attaching a File to a Message” for instructions on how to add
attachments. To delete an attachment from an outgoing message, select it and
either press the delete key or select Clear from the Edit menu. This field can be
left blank.

Message Body
After filling in the header fields, move the insertion point to the space below the
message header. Type the body of the message here. For information about
formatting your message text, see the sections “Formatting Text” and “Formatting
Toolbar.”
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Saving a Message for Later Changes
Sometimes it is convenient to save an outgoing message either as a safeguard
when typing long messages, or so you can return to it later to make changes.

To save the current message, select Save from the File menu. To save all of the
messages that you have open, hold down the option key and select Save All from
the File menu.

Saved messages are put in the Out mailbox, and if at least one recipient is entered
in either the To: or the Bcc: field, the saved message is shown with a bullet (•) in
the Status column. If both the To: and the Bcc: fields are empty, the Status
column is blank. The bullet indicates that the message not only has been saved but
is also ready to be sent or queued.

A saved (and sendable) message in the Out mailbox

You can continue making changes to the message or close it. If you try to close an
outgoing message window without saving that version of the message, an alert is
displayed asking if the message should be saved or the changes discarded. If you
select Discard and the message has never been saved, the message is deleted.

Using an Alternate E-mail Account (Multiple Personalities)
You can set up alternate “personalities” in Eudora for each e-mail account you
have. For example, if you have Work, Home, and School e-mail accounts, you
can set up Eudora to send and receive e-mail from each of these accounts, all
without having to quit and restart Eudora. That is, you can check mail for all your
accounts at once or selected accounts at once, and you can do the same for
sending mail. You can even stagger your automatic mail checks.

In the Personalities and Personality Extras Settings you must specify the
following settings for each e-mail account or “personality”: personality name,
POP account, real name, and return address (if different from the POP account).
You can also specify the default domain, SMTP server, default stationery, default
signature (when not using stationery), and Check mail, Leave mail on server,

QUALCOMM Incorporated 29



Sending Messages Eudora User Manual

Send mail, and Authentication functions (for details, see the section “The
Settings Dialog”).

All other settings are effective for all personalities and cannot be changed for
alternate personalities.

Note: Alternate personalities use the connection method of your
dominant personality—your principal e-mail account. We
recommend that you use alternate personalities only with TCP/IP
connections and not with the Communications Toolbox.

If you want to change other settings, or use a separate set of mailboxes for an
account, see the section “Putting Multiple Users on One Macintosh.”

To create an outgoing message from an alternate account—i.e., as an alternate
personality—open a new message window and use one of two methods. Either
select the personality from the Personality submenu under the Message menu’s
Change submenu, or select the personality from the Personality popup in the
From field of the message header.

Personality popup in composition window

In either case, the information in the From field changes to reflect the selected
personality. This generally consists of the real name and POP account for the
personality.

Note: Your Dominant personality is your principal e-mail account: it’s
the personality Eudora uses whenever you don’t specify otherwise,
and it’s also the personality that’s associated with all mail stored
before you began using alternate personalities.
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The Personality submenu and the From field Personality popup are available only
when you have more than one personality. Alternate personalities must be set up
in the Personalities and Personality Extras Settings before they are recognized by
Eudora.

When you respond to a message, Eudora assigns your response the same
personality under which it received the message. For example, if your Clark Kent
personality receives a message, your replies to that message are sent from your
Clark Kent account.

There are two ways to change the personality of a response. The first is to initiate
the response and then change the personality, from either the Personality submenu
or the Personality popup.

The second way is to change the personality associated with the original message
to which you’re responding. Open that message and change its personality using
the Personality submenu (incoming messages do not have a Personality popup in
the From field). From then on, all of your replies to that message will be sent
from the newly assigned personality.

Here’s an example: Suppose your Clark Kent personality receives a message that
says “Help!” and is really intended for your Superman personality. Initiate a reply
and the personality in the reply is Clark Kent. Change it to Superman from the
submenu or popup, and now that response is sent from your Superman account.

But if you go back to the original message you received as Clark Kent, open it and
change the personality to Superman (from the submenu), now that message is
associated with your Superman account, and all of your replies to that message
from now on will be sent from your Superman account (handy if you’re really the
Man of Steel).

Note: You can also set up a filter to automatically assign a desired
personality to incoming or outgoing messages that satisfy the filter
criteria. See the Make Personality action under the section “Filter
Actions.”

In any new message or reply, the default signature for the selected personality is
used, as set in the Personality Extras Settings—but only if you’re not using
stationery. If you’re using a default stationery file, or if you send or reply to a
message with stationery, then the signature stored in the stationery file will
override the default signature. No matter what signature gets assigned to the new
message or reply when you open or initiate it, you can always override that
signature by changing the signature popup in the composition window. For more
details, see the section “Using Signatures.”
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For more information on how to use stationery with alternate personalities, see the
section “Using Stationery Files.”

Using Stationery Files
Stationery files are templates for outgoing messages. If you find yourself
repeatedly sending the same message, save the message as a stationery file and
send it whenever you need to by selecting it from the New Message With or
Reply With submenu on the Message menu. This way you don’t have to copy
and paste text into a message; you can just open a pre-written message and edit it
as necessary.

To create a stationery file, open a new message, put the text you want into the
message body, and fill in the headers as appropriate (subject, copies, etc.). Select
Save As... from the File menu to display the Save As dialog.

Name the file, and select the Stationery option. If you want to keep the file in the
Stationery Folder in your Eudora Folder (within your System Folder), click on the
Go To Stationery Folder button. If not, select any folder you want, and click on
Save to save the file. You can delete the original message.

Creating a stationery file with the Save As dialog

To send a message with a particular stationery, select the stationery file from the
New Message With or Reply With submenu under the Message menu. A
message window is displayed containing the header and body from the stationery
file. If you are replying to a message, the stationery header text is incorporated
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into the reply header text. You can edit and send this new message just as you
would any other message.

To use a particular stationery file for all of your outgoing messages, select a
stationery from the Stationery popup in the Sending Mail Settings (for your
dominant account only) or in the Personality Extras Settings (for any of your
personalities). Most new messages use this file, unless you create the message
using the Redirect, Send Again, New Message With, or Reply With command.
If None is selected in the Stationery popup, no default stationery is used for the
selected account.

To change a stationery file, open a new message with the stationery file, make
your changes, then use the File menu Save As... command again to save your
changes. To delete a stationery file, drag it into the Trash on your desktop.

You can also set up a filter to reply with a stationery message. See the section
“Filtering Messages” for more information.

Note: Settings stored in stationery files override most other settings. For example,
the signature that was set when the stationery file was saved will override any
default signature you select in the Settings dialog. Stationery-dependent settings
appear in the Sending Mail Settings, under the heading Options when not using
stationery, and in the Personality Extras Settings, where the only such setting is
Signature when not using stationery. You can, however, use the icons on the
icon bar of the composition window to override stationery settings.

Also: Exercise caution when using stationery with alternate personalities.
Although stationery settings override most other settings—the signature stored in
a stationery file overrides the default signature of the current personality, for
example—there is one important exception: If you change the personality of the
current message, and that results in a default stationery file being applied, then the
personality stored in the stationery file is ignored. One way to avoid conflicts is
always to do this: when you choose a default stationery file for a personality, in
the Personality Extras Settings, be sure that the personality saved with the
stationery file matches the personality for which you are setting the default. For
more information on alternate personalities, see “Using an Alternate E-mail
Account.”
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Using Signatures
A signature is a few lines of text that are automatically added to the end of an
outgoing message when it is sent. A signature can be whatever you want, but it is
mostly used to give contact information (telephone, address, etc.). You can have
as many signatures as you want.

Note: Your signature is not displayed in the Eudora message window, but
is added to the end of the message when it is sent.

To create or modify your Standard signature, select Signatures→Standard from
the Special menu. The Standard signature window is displayed. Enter your
signature text, and select Save from the File menu to save your changes.

Creating the Standard signature

To create or modify your Alternate signature, select Signatures→Alternate from
the Special menu. The Alternate signature window is displayed. Enter your
signature text, and select Save from the File menu to save your changes.

To create additional signatures, for each one select Signatures→New... from the
Special menu. A dialog is displayed, asking you what you want to call the new
signature. Enter a name and click on OK to display a signature window. Enter
your signature, save the file, and close the window. Your new signature is now
part of the list of signatures.

To modify an additional signature, select Signatures→[Signature Name] from
the Special menu. The signature window is displayed for the signature name you
specified. Make any changes you want, save the file, and close the window. To
remove a signature, drag the file into the Trash on your desktop. Signatures are
stored as files in the Signatures Folder in your Eudora Folder, which resides in
your System Folder. Note: We recommend that you do not remove your Signature
and Alternate files from your system.
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To include a signature in an outgoing message, select the signature you want from
the Signature popup on the icon bar.

Setting the signature for a particular message

To include a particular signature in all of your outgoing messages, select a
signature in the Sending Mail Settings (for your dominant account only), or in the
Personality Extras Settings (for any of your personalities). You can change this
for a particular message by selecting a different signature or None from the
Signature popup on the icon bar of the composition window.

Note: If you are using a default stationery file, or if you send or reply to
a message with a stationery file, then the signature saved with the
stationery file will override your signature selections in the
Sending Mail Settings and Personality Extras Settings. For more
details, see the section “Using Stationery Files.”

Setting the Message Priority
You can assign a priority to incoming and outgoing messages. The priority is only
for you and your recipients—it does not affect the way mail transport systems
handle the messages.

There are five priority levels available, 1 being the highest (expressed as a double-
caret—see figure), 5 being the lowest (expressed as an inverted double-caret).
Each is represented by a small symbol in the icon bar of a message window and
the Priority column of a message summary. Priority 3 (Normal) is used for
messages that have no assigned priorities, and it is not displayed. The High and
Highest priority symbols are red. You can also use Raise or Lower to set the
priority one level higher or lower, instead of setting a particular priority level.
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New messages are created with a Normal priority. To change the priority of the
current message, use the Priority popup.

Changing the priority of a message using the Priority popup

Note: To set up Eudora to always use the sender’s priority on your
replies, turn on the Copy original’s priority to reply option in the
Replying Settings. You can always change the priority in the
message window.

Requesting a Return Receipt
You can request that your recipients notify you when they have seen your
message. To do this, click on the Return Receipt icon (RR) in the message
window.

Your recipients receive a message with a request to notify the sender (you) that
they have seen the message. If a recipient clicks on the Notify Sender button, you
receive a message that tells you when that recipient displayed your message.

A request for notification
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If you sent yourself a copy of the message, you will or will not see the notification
request depending on whether the Prompt for receipts requested by self option
is turned on or off in the Miscellaneous Settings.

Note: To determine who you are, Eudora uses the “me” nickname, if you
create one for yourself. If you do not have a “me” nickname,
Eudora uses the contents of the POP account and Return address
fields from the Getting Started Settings.

If you receive a message with a request for notification of receipt, you can click
on Notify Sender to send the notification, or you can just ignore it. To remove the
request without sending the notification, hold down the option key and click on
Notify Sender.

These Return Receipt options may or may not work as described, depending on
your recipients’ e-mail software.

Formatting Text
You can use standard text editing options to format the text of your outgoing
messages or text files. The formatting is delivered to your recipients using the
“text/enriched” MIME standard, which means that the formatting your recipient
sees depends on how well their e-mail package supports this standard.

It is important to remember that you cannot completely control what happens on
your recipient’s computer. Depending on the type of computer they are using,
their installed fonts, their settings or preferences, etc., they could end up viewing
something different from what you intended. Also, the formatting changes you
make are sent to your recipient, but your default text settings are not. Any text that
you did not make changes to is displayed using your recipient’s default text.

The Styled Text Settings let you specify how you want to send and receive styled
text. If the Discard style information option is on, you will not be able to format
your text at all (this option is off by default). If you want to send styled text, turn
on the Send style information with mail option, and the But warn me first
option if you want to be alerted before sending it.

Text in outgoing messages and text files can be formatted using the text editing
menu commands. Text in outgoing messages can also be formatted using the
formatting toolbar. The menu commands are described below. See the section
“Formatting Toolbar” for information on using the toolbar.
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Text Editing Menu Commands
To format text, use the commands on the Text submenu of the Edit menu. If text
in the message body is selected, the menu command applies the formatting to that
text. If no text is selected but the cursor is in the message body, then the font-
related commands apply the formatting to the next text you type, and the margin-
related commands apply the formatting to the current paragraph—the paragraph
containing the cursor.

The formatting options are as follows:

Plain, Bold, Italic, Underline
Make the text plain (the default), bold, italic, or underlined.

The keyboard shortcuts are, in order as above, -T, -B, -I, and -U.

Left, Center, Right
Align the selected or current paragraph to the left, the center, or the right of the
current indent.

Small, Normal, Big, Very Big, Mondo
Make the text a small size, a normal size (the default), a big size, a very big size,
or a very very very big (mondo) size. The increase or decrease is based on the
next or previous standard point size.

Remember that you are viewing the text based on your default settings, but your
recipient’s settings and fonts will be different. For example, if you have a default
font size of 10, and you edit your message text to be a “Mondo” size, it would
display as 18 points to you, but would display as 24 points for a recipient with a
default font size of 14.

Margins—Normal
Make the selected or current paragraph’s left and right margins normal, or flush
with the message window (the default).

Margins—Indent, Indent 2, Indent 3
Make the selected or current paragraph’s left and right margins indented one, two,
or three times.

Margins—Hang Indent, Hang Indent 2, Hang Indent 3
Make the left and right margins indented one, two, or three times for the first line

of the paragraph, and further indent subsequent lines of the paragraph (as
shown with this paragraph).

Color (No Color, Red, Green, Blue, Yellow, Brown)
Make the text black (the default) or the indicated color.
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Font
Make the text a certain font by choosing from the fonts available on your
Macintosh. Remember that your recipient may not have the same fonts.

Completely Plain
Clear all formatting and go back to the default settings. This option is only
available if you hold down the option key while selecting the Text menu
command.

Formatting Toolbar
Show or hide the formatting toolbar in the current message. For details, see the
section “Formatting Toolbar.”

Other Formatting Options
To copy styled text without taking the styles, hold down the shift key and select
Copy Without Styles from the Edit menu.

If you turn on the Word Wrap icon in the composition window, you do not need
to use carriage returns in the body of your message. When you send the message,
the text is automatically “wrapped,” meaning that carriage returns are inserted at
the end of each line of text, with roughly 76 characters per line. This makes the
message legible on the recipient’s computer.

To manually wrap text, select the text you want, then select Wrap Selection from
the Edit menu. To unwrap text, select the text you want, then hold down the
option key and select Unwrap Selection from the Edit menu.

To copy wrapped text without taking the carriage returns, hold down the option
key and select Copy & Unwrap from the Edit menu.

To copy wrapped and styled text without taking the carriage returns or styles, hold
down the shift and option keys and select Copy Without Styles & Unwrap from
the Edit menu.

To move text around in your messages or text files, or to move text from other
application windows into your Eudora windows, use the Macintosh standard Drag
and Drop functions.
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Attaching a File to a Message
Any Macintosh file can be attached to and sent with a Eudora message. An
attached document functions like a “rider” to the e-mail message, and does not
appear within the message text. Instead, the name of the document and its icon are
displayed automatically in the X-Attachments field of the message header.

To attach a file to a current outgoing message, select Attach Document... from
the Message menu. A standard file dialog is displayed. Once the desired
document is located, select it and click on the Attach button to attach the
document to the message. You can add as many attachments as you want.

You can also drag one or more files from the desktop onto the message window to
attach them.

Note: Use the Attach submenu under the Message menu to attach files
created with Eudora plug-ins. See the section “Using Eudora
Plug-ins” for details.

An outgoing message with an attached document

To detach a document before the message is sent, select the document in the X-
Attachments field, then press the delete key or select Clear from the Edit menu.

When the message is sent, if the chosen document is not a plain (ASCII) text file,
it is encoded in the selected attachment type. This allows you to send any kind of
document through e-mail, even Macintosh applications.

The MIME (Multipurpose Internet Mail Extensions) standard uses Base64
encoding. It is the newest form of encoding and is a good choice for sending files
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to either platform, Macintosh or PC. However, since it is a new standard, only use
this method if you know your recipient is using a mailer that supports MIME.

The attachment types include the following:

  AppleDouble
This is best for recipients with MIME-compliant e-mail readers, regardless of
what operating system they are using. For more information on MIME, see
Appendix D.

  AppleSingle
This works for recipients with MIME-compliant e-mail readers on Macintoshes.
Do not use this type if your recipient is using a PC.

  BinHex
This is best for recipients on a Macintosh with an e-mail reader that is not MIME-
compliant.

  Uuencode Data Fork
This is best for recipients using PC or UNIX systems that are not MIME-
compliant.

If you want to include the Macintosh file-type and resources with an AppleDouble
or AppleSingle attachment, be sure the Include Macintosh Information icon is
checked. This can be important in maintaining the integrity of the file for another
Macintosh, but will confuse other operating systems.

If the chosen document is a plain text file, it is not encoded in any special format
before being sent, but the Include Macintosh Information icon can be used to
force the document to be encoded with the chosen encoding.

Sending Attachments to Non-Eudora Users
If you send an attachment to someone who doesn’t use Eudora, the attached file
may be included at the end of the message in the chosen attachment format
(AppleDouble, AppleSingle, BinHex, or Uuencode). Your recipient should save
the message as a file, then decode the file using an application appropriate for the
encoding method you used when you sent the message.
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Inserting the Contents of a Text File into a Message
The contents of a text file can be inserted directly into a message (and then edited
if desired). To insert a text file into a message, put the cursor where you want the
text inserted, and select Attach Document... from the Message menu. Then select
the text file you want and click on the Insert button. The text from the file is
inserted into your message and you can edit it as normal.

Including a URL in a Message
To include a hot link in a message—also known as a URL, for Uniform Resource
Locator—enclose it with less than and greater than signs (angle brackets) to
ensure that your recipient’s e-mail application can identify it as a URL. For
example, <http://www.eudora.com>. The URL is automatically highlighted as
an active URL in your message window. The default highlighting is blue
underlined text.

A URL in an outgoing message

Checking Your Spelling
Eudora includes the Spellswell 7 Spelling Checker, developed by Working
Software, Inc. Because it is  an Apple Events Word Services Suite application,
Spellswell 7 can be used with Eudora. This section describes the spelling
checker’s basic functions when it is used with Eudora. For more information on
Spellswell 7, how it functions with other applications, specialized dictionaries,
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etc., see the Spellswell 7 User Manual. It is located in the Documentation folder
within the Eudora Pro Application Folder.

The spelling checker includes a customizable 93,000+ word dictionary. It can be
used to check for spelling mistakes and typographical errors in message
composition windows, text files, and signature files.

Besides finding ordinary misspellings, the spelling checker has many additional
options for finding errors. For details, see the section “Spelling Options.”

To check your spelling in Eudora, select Check Spelling from the Edit menu.
The spelling checker starts at the beginning of the document. The subject of the
message and the message body are checked, ignoring the parts of the body that are
identified as quoted text. You can also highlight a word or a block of text to check
only that text and not the rest of the message.

If no misspellings are found, the spelling checker quits.

If a misspelled, unknown, or repeated word is found, the Check Spelling dialog is
displayed with the word listed in the Questioned word field. The word is also
highlighted in context at the bottom of the window.

The Check Spelling dialog

The Replace with field displays the dictionary entry alphabetically closest to the
questioned word. If this suggestion is not acceptable, you can change it by
clicking on a word from the list. Or, you can type the correct spelling of the word
directly in the Replace with field. Once the Replace with field contains the
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correct entry, click the Replace button. The word in the document is replaced
with the word in the Replace with field. The spell checker then proceeds with the
check.

Note: If you select Check Spelling from the Edit menu and an error dialog
appears telling you that the application (Spellswell) cannot be found, it means that
the link between Eudora and Spellswell has somehow been broken and must be
reestablished. This is rare, but easy to fix. Take these steps: Select Add Word
Service... from the Edit menu. Browse through the dialog and find the Spellswell
application on your hard drive. Double-click on the application, or click once on it
to highlight it and then click Open. Now Spellswell is available again: you can
select Check Spelling from the Edit menu to spell-check your messages.

The Check Spelling Dialog
The Check Spelling dialog allows you to skip a questioned word, replace it, guess
the correct spelling, and add or delete the word to or from your user dictionary.
Each of the fields and buttons is described below.

Questioned word
A word that is not found in the spelling checker dictionary.

Replace with
Replace the questioned word with the word in this field. You can select a word
from the Dictionary/Guesses field, or type a new one.

Dictionary/Guesses
This field is labeled Dictionary when the View suggestions instead of
dictionary first option is off (the default), and Guesses when it is on. (See the
section “Spell Checking Options.”)

Dictionary lists all words that are alphabetically similar to the questioned word.
To display the spelling checker’s suggestions for the correct spelling, click on the
Guess button.

Guesses automatically lists all suggestions for the correct spelling.

Skip (All)
Ignore this occurrence of the questioned word. If you use Skip All, you ignore
this and all subsequent occurrences of the questioned word.

Replace (All)
Replace this occurrence of the questioned word with the word in the Replace
with field. If you use Replace All, you replace this and all subsequent
occurrences of the questioned word.
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Guess
Display the spelling checker’s suggestions for the correct spelling of the
questioned word. If the Extended option is checked, the spelling checker displays
more possible choices for the questioned word (an extended guess takes longer
than a regular guess).

Note: You can make a wild card guess if you type some letters followed
by ? in the Replace with field and then press the Guess button. The
more specific you are, the faster the search will be.

View
Display the dictionary list of words that are alphabetically similar to the
questioned word. The View button is active only when Guesses are being
displayed in the Guesses field.

Add
Add the questioned word to the dictionary. If the Quick option is on, then the
questioned word is added to the dictionary immediately when you click this
button. If this option is off, the Adding word to Dictionary dialog is displayed.
This dialog provides you with options for adding the word and its various forms
to the dictionary.

The Adding word to Dictionary dialog
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Remove
Remove a word from the dictionary. If the Quick option is on, then the word is
deleted from the dictionary immediately when you click this button. If this option
is off, you are prompted to confirm the deletion.

Spell Checking Options
There are many spell checking options to use when checking for errors. To set
these options, select Options... from the Spellswell File menu. The available
options are described below.

Spelling Options Dialog Box

Question when a word is uncapitalized following a period
Questions the capitalization of the first word following a period, question mark,
exclamation point, or carriage return/new line character.

Note: The spelling checker does not distinguish between a period ending
a sentence and a period ending an abbreviation.

Question when proper nouns are uncapitalized
Questions the capitalization of words that appear to be proper nouns.
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Question when words appear to to be repeated
Questions words that appear twice in sequence.

Question when there is only one space after a period
Questions periods, question marks, and exclamation points followed by a single
space (represented by a square in the Questioned word field).

Question when there is a space before punctuation
Questions occurrences of spaces before a punctuation mark (comma, semicolon,
period, question mark, or exclamation point).

Question when there are extra spaces between words
Questions occurrences of extra spaces between words.

Question when an “a” is before a vowel or “an” before a consonant
Questions usage of the indefinite articles “a” and “an.”

Treat hyphenated-words as two words
Treats improperly hyphenated words as separate words.

Allow both numbers and letters in words
Allows mixed numbers and letters. Ignores words that contain both upper and
lower case characters or words that contain numbers.

View suggestions instead of dictionary first
Displays in the Guesses field the spelling checker’s suggestions for the correct
spelling of the questioned word.

HTML checking - ignore between brackets: “<>”
Ignores URLs between brackets.

Make a copy of disk documents that are checked
This option does not apply to spell checking from Eudora. It automatically creates
a backup copy of your original document with “sbk” appended to the file name.

Quit after an Apple Events Word Services spellcheck
Quits the spelling checker once the document is checked.

Spell Checking and Curly Apostrophes
In the Spellswell dictionaries, contraction and possessive forms of words contain
conventional, not curly, apostrophes. Therefore, the spell checker might not
recognize curly apostrophes and may mark the words as incorrect.

It is generally not a good idea to use curly apostrophes in e-mail messages
anyway, since they are often not displayed correctly on your recipient’s computer.
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Sending or Queueing a Message
After you compose a message, you can send it immediately, or put it in a queue to
be sent sometime later or at a specified time.

Sending a Message Immediately
If you want to send your messages immediately instead of putting them in a queue
to send later, then be sure the Immediate send option is checked in the Sending
Mail Settings.

To send the current message, click on the Send button or select Send
Immediately from the Message menu. A progress window is displayed to show
the progress of the transmission.

If you have the Immediate send option on, but want to put the current message in
the queue, hold down the option key and click on the Send button. The Change
Queueing dialog is displayed and you can set detailed instructions. For more
details, see the section “Queueing a Message to Send at a Certain Time.”

Queueing a Message to Send Later
If you want to put your messages in a queue (in the Out mailbox) to send all
together at a later time, be sure the Immediate send option is off in the Sending
Mail Settings.

To put the current message in the queue, click on the Queue button or select
Queue For Delivery from the Message menu. The message window is closed (if
it was open) and the message is saved in the Out mailbox marked Q (meaning it’s
ready to be delivered).

Queued messages in the Out mailbox

To send all of your queued messages, select Send Queued Messages from the
File menu. A progress window is displayed momentarily at the top of the screen
indicating the progress of the transmission.
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If you have the Immediate send option off, but want to send a message
immediately, hold down the option key and click on the Queue button. The
Change Queueing dialog is displayed and you can select the Send message Right
Now option.

You can set up Eudora to warn you if you try to delete a queued message, or try to
quit Eudora with queued messages. To do this, turn those options on in the Extra
Warnings Settings.

Queueing a Message to Send at a Certain Time
You can specify that a message be sent at a certain time in the future. To do this
for the current outgoing message, select Change Queueing... from the Message
menu. The Change Queueing dialog is displayed.

The Change Queueing dialog

If you choose Right Now, the message is sent immediately when you click OK. If
you choose Next Time Queued Messages are Sent, the message is sent the next
time queued messages are sent.

If you choose On or after, you can use the Time and Date fields to fill in the
time and date when the message should be sent. The message is saved in the Out
mailbox with a T in the status column, and is sent when the specified time arrives.

Note: For the message to be sent at the correct time, Eudora must be
running when the message is due to be sent. If Eudora is not
running, the message is sent the first time Eudora is run after the
selected time has passed.
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If you choose Don’t Send for a message that has never been queued, nothing
happens. If the message has been queued already, the message status is changed
from queued (Q) to sendable (•). The message is held in the Out mailbox until it is
either deleted, re-queued, or sent.

Editing a Queued Message
To edit a queued message, open the Out mailbox and double-click on the message
summary. Make the necessary edits and save them. The message is returned to the
Out mailbox. If you close the changed message without saving it, an alert is
displayed asking you to verify the changes.

Taking a Message Out of the Queue
A message that is queued but not yet sent can be unqueued using the Change
Queueing... command. Open the Out mailbox and select the desired message
summary. Then select Change Queueing... from the Message menu and click on
Don’t Send. This changes the message status from queued (Q) to sendable (•).
The message is held in the Out mailbox until it is either deleted, re-queued, or
sent.

Sending Queued Messages When Checking Mail
If the Send on check option in the Sending Mail Settings is on, every time Eudora
checks for mail (automatically or manually), all queued messages are
automatically sent.

Sending Messages with Special Server Instructions
To send your queued messages with special instructions for the server, hold down
the option key and select Send Messages Specially... from the File menu. The
Mail Transfer Options dialog is displayed. Set the options you want and click
OK. All the actions you have requested are completed. For details, see the section
“Managing Your Mail on the POP Server.”

Replying to a Message
To reply to the current message, select Reply from the Message menu. A new
message window is displayed, with the original sender’s address automatically
placed in the To field of the header. All of the sender’s original text is quoted in
the message body. This text can be edited as needed. Additional text can be added
to the reply just as to any outgoing message, and the reply can then be sent or
saved for further changes.
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If the sender’s text did not include style information, each line is prefixed by a
greater-than symbol (>).

Quoted text that does not include style information

If the sender’s text did include style information (e.g., bold text), it is quoted with
greater-than and less-than symbols above it and below it, and a left sidebar.

Quoted text that includes style information

Messages that have been replied to are identified with an “R” in the Status column
of their message summary.

Using the Reply Functions
There are several options that you can use when replying to messages.

To quote only some of the sender’s text, select the text you want, then hold down
the shift key and select Reply Quoting Selection from the Message menu.

To include everyone who received the original message, hold down the option key
and select Reply To All from the Message menu. Or, turn on the Reply to all By
default option in the Replying Settings and the Message menu option changes to
Reply To All. In this case, you must hold down the option key to create a reply to
only the original sender.

To include yourself as a recipient, turn on the Include yourself option in the
Replying Settings. This only works if you are using Reply To All.

Note: To determine who you are, Eudora uses the “me” nickname, if you
create one for yourself. If not, Eudora uses the contents of the POP
account and Return address fields from the Getting Started
Settings.

To put the addresses of the other recipients of the original message in the Cc field
(instead of the To field), turn on the Put original To recipients in Cc field, not
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To field option in the Replying Settings. Only the original sender’s address is put
in the To field. This only works if you are using Reply To All.

To copy the original message’s priority to your replies, turn on the Copy
original’s priority to reply option in the Replying Settings.

Replying with a Stationery File
To reply to a message with a stationery file, select Reply With→Filename from
the Message menu. The stationery file is opened as a message and is addressed as
appropriate (your Replying Settings are used). For details about stationery, see the
section “Using Stationery Files.”

To reply to a message with a stationery file and only quote some of the sender’s
original text, select the text you want to quote, then hold down the shift key and
select Reply Quoting Selection With from the Message menu.

Forwarding a Message
Any message can be forwarded to someone else. To forward the current message,
select Forward from the Message menu. A new message window is displayed
with your address in the From field, the original sender’s text quoted in the
message body, and the original attachments in the X-Attachments field. For
details on how text is quoted, see the section “Replying to a Message.” Make any
changes you want, and enter the recipient’s address in the To field. The message
can then be sent or saved for further changes.

To forward a message with just the original text without quote characters, hold
down the option key and select Forward from the Message menu.

Messages that have been forwarded are identified with an “F” in the Status
column of their message summary.

Redirecting a Message
Incoming messages can be sent to a new recipient “by way of” you, maintaining
the original sender’s address in the From field. This is called redirecting.

To redirect the current message, select Redirect from the Message menu. A new
message window is displayed with the original sender’s address in the From field
with the statement “by way of your name,” the original sender’s text in the
message body, and the original attachments in the X-Attachments field. Make
any changes you want, and enter the recipient’s address in the To field. The
message can then be sent or saved for further changes.
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Note: You may want to enclose any changes in brackets ([]) so that you
don’t confuse the recipient about who wrote what.

A redirected message

Messages that have been redirected are identified with a “D” in the Status column
of their message summary.

Turbo Redirecting
You can redirect one or more messages to someone on your recipient list, queue
the new message (without displaying it), and delete the original message, all with
one command. To do this, hold down the option key and select Turbo Redirect
To→Recipient from the Message menu.

To Turbo Redirect a message without deleting the original, hold down the shift
and option keys and select Turbo Redirect Without Delete To→Recipient.

To make Turbo Redirect the default menu option, turn on the Turbo redirect by
default option in the Miscellaneous Settings. To do a regular redirect with this
option on, hold down the option key and select Redirect To.

Redirect and Signatures
When you use Redirect, your signature is not added to the message when it is
sent, unless you originally created the message. Eudora considers the message to
be originally from you if the address in the From field exactly matches either
your return address or one of the addresses belonging to your nickname called
“me.”
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Keeping Copies of Outgoing Messages
There are three ways to keep copies of your outgoing messages.

To put a copy of every outgoing message in the Out mailbox, turn on the Keep
copies of outgoing mail option in the Sending Mail Settings.

To put a copy of the current outgoing message in the Out mailbox, turn on the
Keep Copy icon in the icon bar (there should be a checkmark next to it).

To put a copy of the current outgoing message in a particular mailbox, put the
cursor in the Bcc field of the message and select the mailbox from the Fcc menu
(normally the Transfer menu).

In all these cases, when the messages are sent they are put in the specified
mailbox with an S in the Status column, indicating that the message has been sent.

If none of these options are used, outgoing messages are put into the Trash
mailbox.

Note: You can also set up a filter to save outgoing messages in particular
mailboxes based on information contained in the message. See the
section “Filtering Messages” for more information.

Sending Rejected Messages Again
If for some reason an e-mail message can’t be delivered to a recipient, mail
transport agents return the message to the original sender (you). A message is
typically rejected because of an error in the recipient’s address, although many
other reasons are possible.

The return message usually includes cryptic information that may let you
determine the reason the message was rejected. It also includes the text of the
original message.

You can easily recover the original message, make any corrections, and resend it.
To do this for the current message, select Send Again from the Message menu.
This eliminates the inserted extra text and reformats the message as it originally
appeared. You can then make changes or additions and send the message again.

The Send Again command is also useful for resending saved messages—from
your Out box, for example—and messages you’ve copied to yourself, in order to
save yourself some retyping. You can send the same message to another recipient
to avoid having to retype the whole message, or you can send a different message
to the same recipients to avoid having to retype their addresses in the header.
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Checking for Incoming Mail
The POP server is where your mail is received and stored until it is transferred by
Eudora to your Macintosh. You can use several different POP accounts with
Eudora: your main POP account, or dominant personality, is specified in the
Getting Started Settings, and additional POP accounts, or alternate personalities,
are specified in the Personalities Settings.

There are two ways to check your POP server and transfer mail to your
Macintosh: automatically or manually. These are described in the sections below.

You can also control how your mail is transferred from the server, and what
happens to it on the server. For details, see the section “Managing Your Mail on
the POP Server.”

Note: When you check mail, either automatically or manually, the
progress window shows the name of the personality for which mail
is currently being checked.

Checking for Mail Automatically
To set up Eudora to automatically check your POP account(s) and transfer new
mail, first select Settings... from the Special menu and select the Checking Mail
Settings. Turn on the Check for mail every ? minutes option, and enter the
number of minutes that you want between mail checks. This controls your
dominant account. Then, go to the Personalities Settings and for each personality
that you want to be automatically checked, turn on the Check for mail every ?
minutes option and enter the number of minutes between mail checks for that
personality.

Note: 15 minutes is a good minimum interval, because checking mail
more frequently puts an unnecessary load on your POP server. If
the field is empty or is set to 0, mail is not automatically checked.

If automatic checking is set, the Check Mail command under the
File menu displays the next time that an automatic check is
scheduled to occur.
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Checking for Mail Manually
You can manually check for new mail at any time by selecting Check Mail from
the File menu. Any account that has the Check mail on manual checks option
turned on in the Personalities Settings is checked. If you haven’t successfully
entered your password since opening the Eudora program, you are prompted for it
(for each account being checked). A progress window is momentarily displayed at
the top of the screen indicating that an attempt to reach your POP account is being
made, and showing the personality name for each POP account being checked.

Note: If automatic checking is on and you manually check for new mail,
the next automatic mail check will happen at the specified number
of minutes after the manual check.

Stopping a Mail Check
If you want to stop a mail check in the middle, click on the Stop button in the
progress window, or press the escape key (esc), or hold down the command key
and type a period (.).

Using Your Password
Each time you open Eudora and check mail for the first time, you need to enter a
password for each POP account that you have. This password is required by the
POP server before it will transfer your mail, so that no one else can get your mail
from the server.

Note: This does not protect your mail once it is on your Macintosh.
Unless a message has been sent with some type of security, it is in
plain-text format, which many applications can read. If you are
interested in securing your Eudora messages on your Macintosh,
you may want to consider a disk driver that can encrypt hard disk
data.

If you need to enter a password, the Password dialog is displayed. Type in your
password and click OK. If you make a mistake before clicking OK, simply
backspace and re-enter the password correctly.
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Entering your password

Note: Your POP account password is case-sensitive, so the uppercase
and lowercase characters must be typed in exactly. Be sure that
Caps Lock is off.

If your password is rejected, an error message is displayed indicating that you
have entered the wrong password. Select Check Mail from the File menu to
redisplay the password dialog.

As long as Eudora is running, it remembers all of your passwords. If you don’t
want it to remember (if, for example, you are away from your Macintosh), select
Forget Password(s) from the Special menu. The next time you check mail for
any account, you are prompted for your password again.

You can also make Eudora remember all of your passwords from one session to
the next, which means you never have to enter passwords again, even if you quit
and restart Eudora. You only want to do this if your Macintosh is in a secure
location, where there is no possible chance of someone else having access to it.
To use this option, turn on Save password in the Checking Mail Settings.

Changing Your Password
To change the password for one of your personalities, select the personality from
the Change Password submenu under the Special menu. If you have only one
password-controlled POP account, select the Change Password... command from
the Special menu.

You are prompted to enter your old password once, and your new password twice.
Depending on the server you are using, the password can be up to 30 characters,
but normally it is only 7 or 8.
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Note: This only works if the POP server is running a compatible
password-change server. For information about these servers, see
Appendix A.

When you choose a new password, try not to use real words, names, dates,
familiar acronyms, etc. Some servers require at least one number or symbol in
your password, and you may want to do that even if it is not required.

Receiving New Mail
When Eudora does a mail check, you can be notified of new mail in one or all of
the following ways: an alert dialog, a flashing mail icon in the menu bar, the
opening of the mailboxes to which new mail is delivered, and a special “New
Mail” sound. These options are turned on or off in the Getting Attention Settings.

When you receive notice that new mail has arrived, select Eudora from the
applications menu. Mail usually arrives in the In mailbox (unless you are using
filters to transfer messages). If the In mailbox is not already open, select In from
the Mailbox menu. The messages are listed in the order they are received, with
the most recent message listed last. Unread messages are designated by a bullet (•)
in the Status column of the message summary.

Unread messages in the In mailbox

Double-click anywhere on a message summary to open the message. Incoming
messages are saved indefinitely in the In mailbox (or the mailbox they are filtered
into) until they are deleted or transferred to another mailbox.
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The Incoming Message Window
To open an incoming message, double-click on its message summary in a mailbox
window, or, if the message summary is current (highlighted), select Open
Selection from the File menu or press the space, enter, or return key.

An incoming message window

The incoming message window consists of the title bar, the icon bar, and the
message body.

Title Bar
The title bar provides information about the message, including the name of the
sender, the time and date the message was delivered, and the message subject.

Note: If you hold down the command key and click on the title in the title
bar, a popup menu appears that lets you select the mailbox or mail
folder containing the message. Selecting the mailbox opens that
mailbox; selecting a folder opens the Mailboxes window and
highlights that folder.

Icon Bar
The icon bar consists of a series of objects that are displayed just under the title
bar. To turn an icon on, click on it to put a checkmark next to it.

Priority Popup
This lets you indicate that the message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

Pencil
If this is on, you can edit the message body.
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BLAH BLAH BLAH
If this is on, all the message headers are displayed.

Incoming mail with all headers displayed

Subject
This is the subject that was assigned by the sender, and is shown in the message
summary. For instructions on changing this subject, see the section “Editing
Incoming Messages.”

Fetch
If this is on, the message is transferred in full the next time you check mail. This
icon is only displayed if the message was originally transferred in part. For
details, see the section “Managing Your Mail on the POP Server.”

Trash
If this is on, the message is deleted from the server the next time you check mail.
This icon is only displayed if the original message is still on the server. For
details, see the section “Managing Your Mail on the POP Server.”

Tow Truck
This can be used to drag any current message into a different mailbox. Just hold
the mouse button down on the icon and drag it to an open mailbox window, to a
mailbox button on the main toolbar, or to a mailbox icon in the Mailboxes
window.
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Message Body
The message body contains the message header and text information, as well as
the name and icon, or picture, of each attachment. Attachments can be opened
from within the message window by double-clicking on the attachment icon,
name, or picture, or by holding down the command key and single-clicking on the
item (see the section “Receiving Attachments”).

You can specify what kind of text styles you want or don’t want displayed in
incoming messages. In the Styled Text Settings, just turn off the option for a style
that you don’t want to receive (e.g., bold text). All of the possible styles are on by
default.

Receiving Attachments
Unless you have specified a particular folder for your incoming attachments (see
the section “Specifying an Attachment Folder”), they are automatically decoded
and saved in the Attachments Folder in your Eudora Folder (which is in your
System Folder). If you receive multiple attachments with the same name, a
number is added to the end of each duplicate name, in the order they are received.

Attachments are displayed in the body of incoming messages as name-and-icon
pairs or as pictures (see the section “Viewing Graphics Attachments as Pictures in
the Message”).

To open an attachment from the message window, double-click on the attachment
name, icon, or picture, or hold down the command key and single-click. If you
have the application that the attachment was created in, that application launches
and the attachment opens.

You can move the attachment into another folder on the Finder without leaving
the message window. To do so, drag the attachment from the message window to
the folder where you want it.

You can also copy the attachment into another folder on the Finder without
leaving the message window. To do so, hold down the option key and drag the
attachment from the message window to where you want the copy.

To find out where the attachment is located on your Macintosh, hold down the
control and command keys, then click on the attachment in the message. The
folder that holds the attachment is opened and the attachment is highlighted.
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Viewing Graphics Attachments as Pictures in the Message
To view graphics attachments as pictures in the message rather than as name-and-
icon pairs, turn on the Display graphics attachments inline option in the Fonts
& Display Settings.

Displaying a graphics attachment as a picture in the message

Eudora will let you view any graphics attachment in PICT format or, if
QuickTime 2.5 or later is installed on your Macintosh, any format for which an
image decompressor is also installed on your system. QuickTime 2.5 is included
with Eudora, and comes with compressors for these formats: GIF, JFIF (JPEG),
SGI Images, QuickTime Image File, Photoshop (2.5, 3.0), MacPaint, and Finder
picture clipping files.

If the criteria above are not met or if the attachment file is too large for the
available memory, the graphics attachment will appear in the message as a name-
and-icon pair.
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Specifying an Attachment Folder
If you do not want to use the default Attachments Folder to receive your
attachments, select Settings... from the Special menu and select the Attachments
Settings. Then click on the large button beneath the Attachment Folder prompt. A
standard file dialog is displayed.

Double-click on the name of the folder you want to use (its name should be
displayed in the menu above the list), then click the Use Folder button. The
dialog closes, leaving the Settings dialog displayed. The name of the folder you
just selected is now displayed in the Attachment Folder button.

An attachments folder is selected

If this does not work, you may have a conflicting system extension. To get around
this problem, restart your Macintosh with all of the extensions turned off (hold
down the shift key until you see the message, “Extensions off”), then open Eudora
and set the Attachment Folder again. You should be able to restart your
Macintosh with all of your extensions on and still maintain the specified folder.

Note: If at any time Eudora cannot find your selected folder, an alert is
displayed at startup informing you that the Attachment Folder is
unavailable. Eudora will use the Attachments Folder in your
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Eudora Folder (in your System Folder) for attachments until you
designate a new folder.

Editing Incoming Messages
You can edit the message body in an incoming message if you turn on the Pencil
icon in the icon bar. With the Pencil icon on or off, you can also edit the Subject
in the icon bar (this is the subject shown in the message summary).

To edit an incoming message, click on the Pencil icon to turn it on, then edit the
message body. When you are done, save your changes and close the message.

To edit the subject of an incoming message, open the message (the Pencil icon
can be on or off) and edit the subject in the icon bar, not the subject in the
message body. When you are done, click somewhere else in the message, or close
it. The new subject is displayed in the message summary. The contents of the
Subject field of the message header remain unchanged.

Note: If you reply to the message, the original subject is used for the
reply, not your changed subject. This gives you the freedom to put
information useful to you into the summary, without fear of your
private notes being revealed to your correspondents.

Editing the subject of an incoming message

Using Active URLs
Any string of text that Eudora recognizes as a “hot link,” also known as a URL
(Uniform Resource Locator: http, ftp, gopher, ph, finger, etc.), is active. Active
URLs are normally highlighted in blue text and underlined, and are often enclosed
by less-than and greater-than signs, “<>.” You can hold down the command key
and click on a URL (or just double-click on it) to open a World Wide Web
location, transfer a file, do a gopher search, use the finger tool, etc.

To specify what Internet application you want to use for a URL type, hold down
the option key and double-click on the URL. A standard file dialog is displayed.
Select the application you want, then click on Open. The application is opened

64 QUALCOMM Incorporated



Eudora User Manual Receiving Messages

and goes to the selected URL. The next time you select a URL of that type, the
same application is automatically used.

Sometimes users will send you messages containing hot links that are poorly
formatted, so that Eudora won’t recognize them as URLs. Eudora won’t highlight
these text strings in blue and underline, but you can still use them as active links.
Simply select the entire string of text that you think is a hot link, and choose
Open Selection from the File menu, or hold down the command key and click on
the selection.

We recommend that you encourage your correspondents to enclose hot links in
angle brackets, < >, like this: <http://www.eudora.com/new.html>. This will
help Eudora and other software to recognize the hot link.

Viewing HTML Text
Sometimes you may receive Web pages, or other HTML-formatted text, in e-mail
messages. Eudora displays these messages as best it can, but if you want to
display them in your World Wide Web browser, you can do so right from Eudora.
Just open the message, or highlight its message summary in the mailbox window,
and select Open in Browser from the File menu. Eudora uses the browser you
have selected for use with active HTML hot links (see the section “Using Active
URLs”). If you haven’t yet selected a browser for HTML, Eudora will ask you to
choose one.

Managing Your Mail on the POP Server
During a mail check, your incoming messages are normally transferred from your
account on the POP server to your Macintosh, and then deleted from the POP
server. But this can be awkward if you want to read mail from two or more
Macintoshes, and keep your mail organized at the same time.

There are several options that you can use to control your mail transfers and the
storage on the server. Some of these options are available in the Checking Mail
Settings, and some are available in the Mail Transfer Options dialog.

Leaving Mail on the Server
To transfer all of your new messages from the POP server to the Macintosh you
are on, and also leave copies of those messages on the server, turn on the Leave
on server for ? days option in the Checking Mail Settings. You can set the
number of days the copies should be kept, or leave the field blank to store the
copies indefinitely.
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Note: The Leave mail on server option can also be set for each alternate
personality you have. To do this, use the Personalities Settings.

At the next mail check from that Macintosh, Eudora ignores the copies of those
previously read messages and looks for new ones. However, if you check mail
from another computer, those messages are treated as new and are transferred to
that computer.

Note: The Leave on server options should be used with care, since they
can result in a buildup of messages on the POP servers.

Deleting a Message from the Server
To delete a message that has been left on the server (without retrieving it again),
turn on the Trash icon in the message’s icon bar or set the message summary’s
server action to Delete, then check mail again. Or, use the Delete all messages
that have been retrieved option in the Mail Transfer Options dialog (described
in the section “Checking for Mail with Special Server Instructions”).

Skipping Messages Over a Certain Size
To stop Eudora from transferring incoming messages that are too large, turn on
the Skip messages over ? K option in the Checking Mail Settings, and specify a
size. Only the first few lines of the messages that exceed that size are transferred,
with a note at the bottom stating that the whole message has not been transferred.

If you decide you want to transfer the whole message, click on the Fetch icon in
the incoming message window, or select the Fetch server action in the message
summary, then check mail again. You can also use the Trash icon or the Fetch &
Delete server action so that the message is deleted from the server after
transferring it.

If you decide you don’t want the message and want to delete it from the server,
click on the Trash icon in the incoming message window, or select the Delete
server action in the message summary, then check mail again.

Checking for Mail with Special Server Instructions
To check your mail and give special transfer and storage instructions to the server,
hold down the option key and select Check Mail Specially... from the File menu.
The Mail Transfer Options dialog is displayed. Set the options you want and
click on the OK button to continue checking for mail.
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The Mail Transfer Options dialog

The mail transfer options are described below.

Retrieve new mail
Transfer your new mail from the POP server to your Macintosh.

Send queued messages
Send all the queued messages (marked “Q”) in your Out mailbox.

Delete messages marked for deletion
Delete the messages on the server that are marked Delete in Eudora. This is for
messages that were retrieved only in part, either with the Leave on server or Skip
messages over ? K options (in the Checking Mail Settings), or with the Fetch all
Message Headers option (in the Mail Transfer Options dialog).

Retrieve messages marked for retrieval
Retrieve the messages on the server that are marked Fetch or Fetch & Delete in
Eudora. This is for messages that were retrieved only in part, either with the
Leave on server or Skip messages over ? K options (in the Checking Mail
Settings), or with the Fetch all Message Headers option (in the Mail Transfer
Options dialog).

Note: To mark a message Fetch, Delete, or Fetch & Delete, either click
on the icons in the incoming message window, or select an option
from the Server Action popup of the message summary.

Delete all messages that have been retrieved
Delete all the messages on the server that have already been transferred to the
Macintosh you are on.
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Delete all messages on server (be sure)
Delete all of your messages on the server. Be absolutely sure this is what you
want to do because there is no way to undo it.

Fetch all message headers to In mailbox
Retrieve the header and the first few lines of every new message. If you select this
option, the messages are filtered but Copy or Transfer actions are not done (the
message won’t leave the In mailbox). Set the Server Action in the message
summaries to specify what you want to do with the messages the next time you
check mail.

Important: If you delete the message header, and you have the Delete
from server when emptied from trash option on in the
Checking Mail Settings, the message is gone completely from
Eudora and the server.

Transfer mail for the following personalities
If you have multiple personalities, you can check or send mail based on the
options on the right of the dialog, or as specified in the Personalities Settings. You
can also specify the personalities that you want to check or send with this mail
transfer. Hold down the shift key to select multiple personalities in sequence, or
the command key to select them out of sequence.
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Opening a Mailbox
To open a mailbox, select it from the Mailbox menu. To open a mailbox that is
within a folder (referred to as a “nested” mailbox), select the folder in the
Mailbox menu, then select the mailbox from the submenu (or continue selecting
subfolders until the mailbox can be selected).

                           
Opening mailboxes

Opening Other Mailboxes
You can open a mailbox that is located outside the Eudora Folder (on a different
network volume, for example). To do this, select Other... from the Mailbox
menu. A standard file dialog is displayed asking you to select the mailbox.

Once you have opened a mailbox, it remains on the Mailbox and Transfer menus
until you quit Eudora. However, if you open the mailbox within a folder or
subfolder, it remains on the Mailbox and Transfer menus indefinitely, even if you
quit and restart Eudora.
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The Anatomy of a Mailbox
Mailbox windows are one of the most important elements of Eudora. They
contain all of your incoming and outgoing message summaries.

A mailbox window

Message Summaries
Each line in a mailbox window represents a message and is called a message
summary. To select one or more message summaries, use one of the following
options:

• To select one summary, click on it.

• To select two summaries and all the summaries between them, click on a
summary, hold down the shift key, and click on another summary.

• To make “disjointed” selections, hold down the command key and click on
summaries.

• To select all the summaries that are from or to the same person, hold down the
option key and click on a summary. The summaries are grouped as well as
selected.

• To select a summary that best matches the letters you type, type the first few
letters of a sender or recipient’s name (or the subject, if this mailbox is
currently sorted by subject).

Each message summary is divided into columns: Status, Priority, Attachments,
Label, Sender/Recipient, Date, Size, Server Action, and Subject. You can show or
hide these columns using the Mailbox Columns Settings.

A message’s Status, Priority, Label, and Server Action can be changed directly in
the mailbox window. To do this, click on the message summary column you want
to change. The pointer displays as the popup menu symbol ( ). Hold down the
mouse button and select an option from the popup menu.
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You can copy one or more message summaries. To do so, select the summaries
and then select Copy from the Edit menu. The information in each selected
summary is copied. This information can be pasted into a new message or a text
file for recordkeeping or later use.

The Status Column
This column displays the message status, which is one of the following:

• The message has not been read (all mailboxes except Out), or is
queueable/sendable but has not been queued or sent (Out mailbox
only).

<blank> The message has been read (all mailboxes except Out), or is not yet
able to be queued or sent because it has no recipients in the To: or
Bcc: field (Out mailbox only).

R Reply has been chosen for the message.
F Forward has been chosen for the message.
D Redirect has been chosen for the message.
S The message has been sent (outgoing messages only).
Q The message is queued to be sent (outgoing messages only).
T The message is queued to be sent at a specified time (outgoing

messages only).
- The message was transferred from the Out mailbox before being

sent.

The Priority Column
This column displays the message priority. You can use the popup to set a
particular priority, or to raise or lower the priority.

Highest priority.

High priority.

<blank> Normal priority.

Low priority.

Lowest priority.

Raise Raise the priority one level.

Lower Lower the priority one level.
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For more information on message priorities, see the section “Setting the Message
Priority.”

The Attachments Column
This column displays the attachment icon ( ) if a message has attached
documents.

The Label Column
This column displays the message label. Labels are assigned to incoming
messages by the recipient, either manually or automatically using filters (see the
section “Filtering Messages”). When a message summary is assigned a label, the
entire summary changes color to match the label color.

Note: Label colors and titles are assigned using the Macintosh Label
control panel or the Labels Settings.

The Sender/Recipient Column
This column shows the sender of the message (for incoming messages) or the
intended recipients (for outgoing messages).

To select all the message summaries from a particular sender or recipient, hold
down the option key and click on one of the message summaries from that person.
The summaries are grouped as well as selected. To ungroup them, perform a sort
operation.

Note: Bugs in some POP servers/mail transport systems cause Eudora to
display the sender of incoming messages as ???@???. This is
because the required From: header is missing. If you encounter
such a message, see your e-mail administrator. Administrators can
obtain a copy of qpopper from ftp.eudora.com to correct the
problem (see Appendix A).

The Date Column
This column displays the date and time the message was composed, or, for timed
outgoing messages, the date and time the message is scheduled to be sent. Eudora
uses two methods of displaying date information in mailbox windows, Age-
sensitive and Fixed (this is set in the Date Display Settings). If Age-sensitive is
selected, mail that arrives today has a time stamp, mail that arrived within the last
six calendar days is stamped with the day of the week, and mail that arrived prior
to the previous week is stamped with the date. If Fixed is selected, all mail
messages are stamped with the date and time, with the date formatted according to
the short date format in current use by your Macintosh and the time formatted
according to the current time format.
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The Size Column
This column displays the size of the message in kilobytes, or K, where 1K = 1024
bytes.

The Server Action Column
This column displays the action that is done to the corresponding message on the
server. The next time you check mail, the server action you requested is
automatically completed.

Do Nothing Don’t change the message on the server.

Fetch Download the whole message from the server.

Delete Delete the message from the server.

Fetch & Delete Download the whole message then delete it from the server.

 Note: To control the mail transfer, you can also use the Mail Transfer
Options dialog. For details, see the section “Checking Mail with
Special Server Instructions.”

The Subject Column
This column displays the subject of the message. The sender originally typed this
information into the message header, but you can modify it (see the section
“Editing Incoming Messages”).

Displaying and Resizing Columns
To specify which columns you want to be displayed in your mailboxes, select
Settings... from the Special menu, click on Mailbox Columns and be sure the
columns you want to see are on. You can also turn the separator lines on and off.

To resize a column in a mailbox window, move the mouse pointer until it is over
the dotted column divider to the right of the column you want to resize. The
pointer turns into the column resize cursor ( ).

Simply press the mouse button, drag the divider to the position you desire, and
release the mouse button. The column divider moves to the new location, and the
mailbox is redrawn.

You can only shrink a column as far as its left divider. If you do that, a double
divider line is displayed in place of the column, and its contents are hidden. To
redisplay the column, drag the right divider line to the right.
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Using the Mailbox Size Display
In the lower left corner of each mailbox window, three numbers show the size
information for that mailbox. The first is the number of messages in the mailbox;
the second is the total amount of space those messages require; the third is the
amount of disk space that is wasted with the mailbox.

A mailbox with 5 messages that takes up 3K and wastes 4K of disk space

Wasted space is created when messages are deleted from a mailbox. This wasted
space is automatically removed when the amount of wasted space in the mailbox
is greater than the amount of space the messages in the mailbox use, or if the
amount of space wasted in the mailbox is greater than 5% of the free space on the
volume that contains it.

To manually clean up the wasted space in a mailbox, hold down the command key
and click on the mailbox’s size display. Or, to clean up all your mailboxes, hold
down the option and command keys and click on any mailbox size display.

Using the Title Bar Popup Menu
In an open message or mailbox window, hold down the command key and click
on the title in the title bar. A popup menu appears showing the hierarchy of
mailboxes and folders containing that message or mailbox.

If you select a mailbox from the menu, the mailbox window opens for that
mailbox. If you select a folder, the Mailboxes window opens and the folder is
highlighted in the window.

Creating Mailboxes and Folders
Eudora lets you create mailboxes to put messages in, and folders to put mailboxes
(or more folders) in.

There are three ways to create mailboxes and folders:

• Using the New... option from the Mailbox menu and folder submenus.

• Using the Mailboxes window from the Special menu (see the section “Using
the Mailboxes Window”). The Mailboxes window is most useful if you want to
create several mailboxes at one time.
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• Using the New... option from the Transfer menu (see the section “Transferring
Messages”).

Creating a Mailbox or Folder Using the Mailbox Menu
To create a new mailbox or mail folder, select New... from the Mailbox menu.
The New Mailbox dialog is displayed.

New Mailbox dialog

To create a mailbox, type in the new mailbox name and click OK. The mailbox is
created and added to the Mailbox and Transfer menus.

To create a mail folder, type the name of the new mail folder and check the Make
it a folder option. Click OK to create the folder. The New Mailbox dialog is
displayed again. Type the name of a mailbox to create within the new folder, then
click OK. The new folder and its mailbox are displayed in the Mailbox and
Transfer menus.

Creating a Mailbox Within a Folder
To create a new mailbox within a particular folder, select that folder from under
the Mailbox menu and choose New... from the submenu that is displayed.

The New Mailbox dialog is displayed. Type in the new mailbox name and click
OK. The mailbox is created and added to the Mailbox and Transfer menus. You
can also create a subfolder—just check the Make it a folder option in the New
Mailbox dialog.
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Using the Mailboxes Window
The Mailboxes window lets you create new mailboxes and mail folders, remove
and rename them, move mailboxes among folders, and move messages among
mailboxes. Mailboxes and folders that are underlined have unread messages in
them.

To open the Mailboxes window, select Mailboxes from the Special menu.

The Mailboxes window

Three pushbuttons appear at the bottom of the window: New Mailbox, New
Folder, and Remove. If the window is made narrow, the buttons appear without
their titles.

The Mailboxes window can be placed anywhere on your desktop, and left open if
you like. To move the Mailboxes window, drag it by the title bar, as you would
with any Macintosh window.
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To open a mailbox or mail folder, double-click on it. You can also open a mailbox
by clicking on its icon and pressing return. You can move among the folders and
mailboxes using the up and down arrow keys, and close or open folders by
clicking on the triangle to the left. You can also start typing the name of the
mailbox or folder you want, and it is highlighted when you have typed enough
unique characters to identify it (the item must be displayed, so a mailbox that is in
a closed folder cannot be selected this way).

Select items in the following way: click once to select a single item; use shift-
click to select a range of items; use command-click to add or remove individual
items from a group selection; use drag-select to select a group.

Note: You cannot select the Eudora Folder.

Press command+A to select all items in the Mailboxes window (except the
Eudora Folder).

You can also drag mailboxes (but not mail folders) from the Mailboxes window to
the main toolbar to add them as toolbar buttons.

Creating a New Mailbox or Folder
To create a new mailbox or folder in the Mailboxes window, click on the New
Mailbox or New Folder button at the bottom of the window. An untitled mailbox
or folder is created and placed in one of the following locations:

• If a folder is selected, the item is placed in that folder

• If a mailbox is selected, the item is placed in the folder containing that mailbox

• If nothing is selected, the item is placed in the root folder—the Eudora Folder
(or the name of the folder holding your mail: see the section “The Eudora
Folder” for details)

Type the new name into the name box and press return or click outside the box.
Drag the new mailbox or folder into another folder if desired. The new mailbox or
folder is added to the Mailbox and Transfer menus.

Renaming a Mailbox or Folder
To rename a mailbox or folder, click on the name box. After a short pause, the
name is highlighted for editing. Type in the new name and press return or click
outside the name box. Press the escape key (esc) to cancel the rename.

Note: You cannot rename the Eudora Folder or the In, Out, or Trash
mailboxes.
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Moving a Mailbox or Folder into Another Folder
To move a mailbox or folder into another folder, select the item you want to move
and drag it to where you want it. If you drag it over a closed folder, the folder
opens so you can see its contents. It closes when you drop the item or you drag it
above the folder or out of the window.

To move a mailbox or folder into the root folder, drag it to the Eudora Folder at
the top of the list.

Note: You cannot move the Eudora Folder or the In, Out, or Trash
mailboxes.

Moving a Message from One Mailbox to Another
To transfer an open message into a mailbox in the Mailboxes window, grab the
message by the Tow Truck icon in the upper right-hand corner and drag it to the
mailbox.

You can also drag one or more selected message summaries from an open
mailbox window to a mailbox in the Mailboxes window.

If you drag messages over a closed folder, the folder opens so you can see its
contents. It closes when you drop the messages or you drag them above the folder
or out of the window.

Removing a Mailbox or Folder
To remove a mailbox or folder, select the ones you want to remove and click the
Remove button at the bottom of the Mailboxes window, or press the delete key.
A dialog is displayed asking you to confirm the removal. Click on the Remove It
button to remove the mailbox. If you selected more than one mailbox or folder,
you are prompted for each one of them. Click on the Remove All button to
remove all of them without further prompts.

If you choose to remove a mailbox in which messages are still stored, or a folder
in which other mailboxes or folders are stored, all the messages, mailboxes, and
folders contained within the selected mailbox or folder are also removed.

Note: You cannot remove the Eudora Folder or the In, Out, or Trash
mailboxes.

Items removed from the Mailboxes window are also removed from the Mailbox
and Transfer menus.
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Deleting a Message
As a safeguard against inadvertent deletions, two steps are used to delete a
message from your Macintosh: first you put the message in the Trash, then you
empty the Trash.

To put a message in the Trash, select the message, then select Delete from the
Message menu, or select Trash from the Transfer menu, or press the delete key.
The message is transferred to the Trash mailbox.

To delete the messages in the Trash mailbox (removing them permanently from
your Macintosh), select Empty Trash from the Special menu.

To delete a message permanently without sending it to the Trash first, select the
message, hold down the shift and option keys, and select Nuke from the Message
menu (or use any of the deleting options).

Warning:  You cannot undo a Nuke operation!

If you Nuke a message that has an attachment, the attachment is moved to the
Trash on your desktop.

You can set up Eudora to warn you if you try to delete unread, queued, or unsent
messages. To do this, use the Extra Warnings Settings to turn on those options.

Quitting Eudora empties the contents of the Trash mailbox when the Empty
Trash on Quit option in the Miscellaneous Settings is turned on. Finally, if you
want to delete just a few messages from the Trash mailbox, select them, then
select Delete from the Message menu or press the delete key. Deleting a message
from the Trash removes it completely.

Automatically Deleting Attachments
When you delete messages, you can have their attachments automatically deleted.
To do this, turn on the Trash attachments with messages option in the
Attachments Settings, and be sure the attachments are still in the Attachments
Folder (or the folder you have specified for attachments). If you have this option
on and want to delete a message but save its attachment, move the attachment into
another folder before deleting the message.
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Transferring Messages
You can transfer messages to any of your mailboxes. There are several ways to do
this: use the Transfer menu, drag a message summary to an open mailbox, drag
an open message’s Tow Truck to an open mailbox, drag a message to a mailbox
button on the main toolbar, or drag a message to a mailbox icon in the Mailboxes
window, if it is open on your desktop (see “Using the Mailboxes Window”).

To put a copy of a message in another mailbox (instead of transferring the
message), hold down the option key and use one of the transfer options above.
This is useful if you want to file a message in more than one mailbox.

If you try to transfer a message to the Out mailbox, an alert is displayed informing
you that some header information may be removed from the message during
transfer. Click Yes to transfer the message.

Note: You can undo mailbox transfers using the Undo command under
the Edit menu.

Using the Transfer Menu
The Transfer menu is one way to transfer messages among your mailboxes. With
a current message open, or message summaries selected, select a mailbox from the
Transfer menu. The messages are transferred from their previous mailbox to the
mailbox you selected.

Dragging Messages
You can drag messages from one mailbox to another using the message
summaries or the Tow Truck icon in an open window.

To drag a message summary to another mailbox, select the message summary (or
summaries), place the cursor over the summary, and hold down the mouse button.
The cross pointer will change to an arrow. Drag the summary into any open
mailbox window, or onto a main toolbar mailbox button you have created (see the
section “Customizing the Main Toolbar”), or onto a mailbox icon in the
Mailboxes window, if it is open on your desktop (see the section “Using the
Mailboxes Window”). When you release the mouse button, the message is
transferred.

To drag an open message to another mailbox, hold down the mouse button over
the Tow Truck icon and drag the message into any open mailbox, or onto a main
toolbar mailbox button you have created, or onto a mailbox icon in the Mailboxes
window, if it is open on your desktop. When you release the mouse button, the
message is transferred.
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Creating a Mailbox or Folder During Transfer
To create a mailbox and transfer the current message into it at the same time,
select New... from the Transfer menu instead of the name of a mailbox. The New
Mailbox dialog is displayed.

New Mailbox dialog

You can create a new mailbox or mail folder (for details, see the section “Creating
Mailboxes and Folders”). When you are done, the current message is transferred
into the new mailbox.
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Filtering Messages
Many of the e-mail management functions in Eudora can be done automatically
using filters. For example, you can automatically reply to a request for
information, transfer all the messages from your children into a Personal mailbox,
and label all the messages from your customers as “Hot.”

To open the Filters window, select Filters from the Special menu. The Filters
window is displayed, and any filters you have created are listed on the left.

The Filters window with a sample filter

To create or modify a filter, first click on the New button or select an existing
filter.

Second, select the options for how you want the filter to be used: as an automatic
filter to be invoked on any Incoming and/or Outgoing mail, and as a Manual
filter that can be invoked when you select Filter Messages from the Special
menu. Any combination of these options works.

Third, define the criteria for the filter: use the header item popups and the text
fields to specify which header items should include a particular string of text. You
can define two related terms for the criteria so that your filter is as specific as
possible (see the section “Filter Criteria”).
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Fourth, define the action to be taken on messages that fit the criteria (see the
section “Filter Actions”) and save the filters.

When the filters are invoked (automatically or manually), each message is
matched against each filter, and messages that meet a filter’s criteria are acted on
as specified until a Transfer To or Skip Rest action is done. At that point, the
next message is filtered.

Note: Filters are automatically named based on the criteria for the filter.
They are invoked in order from top to bottom, and you can re-
order them by dragging a filter up or down in the list.

To print your filters, open the Filters window and select Print... from the File
menu. The standard Print dialog is displayed so that you can make your print
selections.

You can change the width of the filters list to create more or less space for your
list. To do this, put the arrow over the vertical dividing line to the right of the list,
until the pointer changes to a resize cursor ( ), then hold down the mouse button
and drag the line to the left or right.

Filter Criteria (the Match Area)
Each filter can use one or two “terms” as its criteria, connecting them as
appropriate with the conjunction popup.

Use the Header field to specify which message header items you want the filter to
search. You can select an option from the popup menu or enter one yourself (this
is helpful if you want to search for a header item that does not appear on the
menu, such as X-Priority). The selections are as follows:

• To

• Cc

• From

• Subject

• Reply-To

• «Any Recipient»

• «Any Header»

• «Body»
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• «Personality»

The «Any Recipient» option searches all possible recipient items (To, Cc, Bcc);
the «Any Header» option searches all message headers (including hidden headers
that are shown with the BLAH BLAH BLAH option); the «Body» option
searches the message body; and the «Personality» option searches the name of the
personality associated with the message.

Use the Match Type popup to control how the header item is matched with the
text string in the text field. The match options are:

contains or does not contain
If the specified header item contains or does not contain the text string, filter the
message.

is or is not
If the specified header item is or is not a complete match of the text string, filter
the message.

starts with or ends with
If the specified header item starts with or ends with the text string, filter the
message. The starts with item refers to the first non-whitespace character after
the colon, so any spaces after the colon are ignored.

appears or does not appear
If the header item appears or does not appear in the message, filter the message
(the text field is ignored). This is useful for filtering messages based only on the
types of fields they contain.

intersects nickname
If the text string is included in a nickname (whether it is a full address or a
nickname within the nickname), filter the message.

Use the Text fields to specify the text strings that the filter is searching for.

Note: It is recommended that the contents of this field be kept as specific
and brief as possible. The greater the complexity, the less the
likelihood of a match.

Note: Be sure not to enter a header label in the Text field as part of the
text string (e.g., To:, From:, Bcc:). For example, to filter all
messages from Justine, do not enter From: Justine in the Text
field. Rather, select From: in the Header field, and enter simply
Justine in the Text field (choosing, for example, contains from the
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Match Type popup). As another example, note this Filters window
Match Area:

Sample Match Area in Filters window

Use the Conjunction popup to link the two terms. The conjunction options are:

ignore
Ignore the second term; if the message matches the first term, filter the message.

and
If the message matches both the first and second terms, filter it.

or
If the message matches either term, filter it.

unless
If the message matches the first term, filter it unless the message also matches the
second term, in which case do not filter it. (This lets you exclude certain
variations of the first term.)

Filter Actions
All messages that match the filter criteria are acted on as specified with the
Actions popups. Each filter can do up to five things to a message that matches the
criteria. You can use the same action twice if it does not directly affect the
original message (for example, Copy To can be used twice, but not Transfer To).

The Actions options are as follows:

None
No action.

Make Status
Assigns the selected status to messages.
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Make Priority
Assigns the selected priority level to messages. If you select a set level, messages
are set to that priority. If you select Raise or Lower, messages are raised or
lowered one priority level based on their pre-filter level.

Make Label
Assigns the selected label to messages. Label colors and names are set in the
Macintosh Labels control panel and the Eudora Labels Settings.

Make Personality
Assigns the selected personality to messages. For outgoing messages, the message
is sent from the assigned personality. For incoming messages, all your responses
to the message will be from the assigned personality until you change the
personality associated with the incoming message or your response. For more
information, see the section “Using an Alternate E-mail Account.”

Make Subject
Assigns the new subject to messages. If you choose this option, the entire subject
of the message is replaced with the new subject. Use the “&” symbol to stand for
the old subject if you want to add the new subject to the old subject. For example,
entering New Subject [was &] results in New Subject [was Old Subject].

Play Sound
Plays the selected sound when messages are received.

Open
Opens the Mailbox and/or Message when a message is received. If you set a
previous action to filter messages into a mailbox, then that mailbox is opened.

Print
Prints one copy of each message.

Notify User
Notifies you As normal and/or In report when messages are received. The As
normal option notifies you based on the options you have selected in the Getting
Attention Settings. The In report option notifies you by displaying a filter report
that details what filter actions have been done.

Forward To
Forwards messages to the e-mail address given. Forwarded messages are placed in
the queue in the Out mailbox, and sent the next time you send queued messages.

Redirect To
Redirects messages to the e-mail address given. Redirected messages are placed in
the queue in the Out mailbox, and sent the next time you send queued messages.
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Reply With
Replies to messages with the selected stationery message. Replies are placed in
the queue in the Out mailbox and sent the next time you send queued messages.
One typical use of this action is to reply to specific senders with stationery telling
them that you’re on vacation: “I’m out till the 10th. I’ll reply to your message
when I get back.” For more details, see the section “Using Stationery Files.”

Server Options
Sets the message’s server action to Fetch and/or Delete (see the section
“Managing Your Mail on the POP Server”).

Copy To
Copies messages to the selected mailbox.

Transfer To
Transfers messages to the selected mailbox.

Skip Rest
Stops filtering for the message (the message is not matched to the rest of the
filters in the filter list).

The Last used field displays the date the filter was last used on a message. This
helps you identify filters that are no longer useful and can be safely deleted.
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Sorting Messages Within Mailboxes
The message summaries in mailboxes are automatically sorted by date, in
ascending order (the newest messages at the bottom of the mailbox). To change
this, select the appropriate command from the Sort submenu under the Special
menu. Or, click on any of the column headings to sort by that column.

The Sort submenu

This sorting method is “sticky,” meaning that each sort is based on the previous
state of the mailbox. For example, if a mailbox is sorted by date, and then you sort
by sender, the messages are grouped by sender and each group is in order by date.

You can change this by holding down the shift key and sorting by another
column. The original sort remains intact, but it is now grouped with the new
selection. For example, if the mailbox is sorted by sender with each group of
messages in order by date, and then you hold down the shift key and sort by size,
the messages are still grouped by sender but the groups are now in order by size.

To sort in descending order, hold down the option key and select a sort option.
The Sort submenu changes to Sort Descending.

To keep messages with the same subject together all the time, select the Group
Subjects option from the Sort submenu. If this is checked, messages with the
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same subject are kept together in the mailbox regardless of whether you sort by
date, sender, etc. A bullet next to the Subject column heading tells you that the
Group Subjects option is active.

Sticky sorting places an underline under the column heading for the sorted
column. To remove this underline (and turn off the sticky sort), repeat the sort for
the same column, or just click on the column heading again. Incoming mail that
arrives in a mailbox with an underlined column heading is automatically sorted by
that column, subject to the restrictions above. For example, if a mailbox is sorted
by sender and a new message comes in from Justine, it will be grouped with other
messages from Justine.

To always put just-arrived mail at the bottom of your mailbox, be sure the Date
column heading is not underlined. To sort by date and time, be sure Date is
underlined. For example, a message dated yesterday at 10:00am arrived today at
11:00pm. If Date is underlined, that message is way back in your mailbox with
yesterday morning’s mail.

Note: Sometimes sorting by Date can be incorrect. This usually happens
if the messages have incorrectly formatted date fields, or unknown
or incorrect time zones.

Note: Double-clicking on a column heading is equivalent to the Sort at
once command that appeared in earlier versions of Eudora.

Finding Text Within Messages
You can find a word or a string of text anywhere in your Eudora messages, your
Address Book, or your Filters. To do this, select Find from the Special menu, and
Find... from the submenu. The Find dialog is displayed.

The Find dialog with a sample search

Enter the word or string of text that you want to find in the Find field. Or, if you
don’t want to type in the text, you can highlight the text in an existing message,
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then select Enter Selection from the Find submenu. The selected text is
automatically inserted in the Find field of the Find dialog.

If you need to specify how the text should appear, use the Whole word and
Match case options:

Whole word
If this option is on, the text is found only if it appears by itself and is not part of
another word. For example, if the text is “info” then the word “information” will
be passed over.

Match case
If this option is on, exact matches of the text are found, taking the capitalization
into account.

When the Find field is filled in and the appropriate options are set, you can use
one of two functions in the dialog to find the text: Find and Search. Use the Find
button to find instances of the text in just the current open message, or use any of
the Search buttons to find instances of the text by searching mailboxes or mail
folders.

Finding Text in the Current Open Message
To find text in the current message, verify that the Find field and options are
filled in correctly, then click the Find button (or select the Find Again command
from the Find submenu) to find the text.

Eudora begins looking for the text at the insertion point (where the cursor is) in
the message. If a match is found, the matching text is highlighted in the open
message. If no match is found, the not found alert is displayed.

To find the next occurrence of the text in the current message, click the Find
button in the Find dialog, or select the Find Again command from the Find
submenu.

To stop Eudora while it is looking for text, press the escape key (esc), or hold
down the command key and type a period (.).

Searching for Text in Messages, Mailboxes, and Folders
To search for text in a certain mailbox or mail folder, first verify that the Find
field and options are filled in correctly. Then use the Starting field to specify
where you want the search to start.

Your folders and mailboxes are searched in order as they appear in your Mailbox
menu, and your messages are searched in order as they appear in your mailboxes.
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The display area tells you where you are in that order using the following format:
Folder:Mailbox:Message headers (if a mailbox is directly under the Eudora
Folder, the folder name is not shown).

To change where you are in your mailboxes and messages, you can use the arrows
in the Starting field or the Choose... button:

Go to the first mailbox that has messages in it, and to the first message in
that mailbox.

Go back to the previous mailbox that has messages in it, and to the first
message in that mailbox.

Go back one message, regardless of what mailbox it is in.

Go forward one message, regardless of what mailbox it is in.

Go forward to the next mailbox that has messages in it, and to the first
message in that mailbox.

Use the Choose... button to select a mailbox from the Mailbox menu and go to
the top of the mailbox you selected.

Once you’ve specified where the search should start, you can specify how to
search:

Summaries only
If this is checked, only the sender and subject fields of message summaries are
searched. The search is much faster when this option is checked.

Search Mailbox
Search all messages in the mailbox shown in the display area.

Search Mailfolder
Search all messages in the folder shown in the display area (even if there are
multiple mailboxes).

Search To End
Start at the message shown in the display area and search the rest of the messages
in the current and subsequent mailboxes and mail folders.

If a match is found, the appropriate message is opened and the matching text is
highlighted.
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Tip: Hold down the command key and click on the title bar of the open
message to see what mailbox and folder the message is in, if you
are searching multiple mailboxes and folders.

Select any of the Search options to search for other instances of the text (or use
the Find option to find more instances in just the current open message).

To stop Eudora from continuing a search, click on the Stop button in the progress
window, or press the escape key (esc), or hold down the command key and type a
period (.).

Saving a Message to a File
You can save a message to a separate text file on your Macintosh. To do this,
open or select the messages you want to save to text. Then, select Save As... from
the File menu. The Save As dialog is displayed allowing you to choose a name
and location for the file.

The Save As dialog

Enter the name you want to give the text file, and select the appropriate options.

Guess Paragraphs removes extraneous carriage returns from the message,
leaving returns only at the ends of paragraphs, and converts multiple spaces into
tabs.

Include Headers retains each message’s header information in the saved
document. If this is not checked, only the body of each message is saved.

Stationery saves the message as a “stationery” file. The Go To Stationery
Folder option puts you in your Stationery Folder so that you can save stationery
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files there. If you are saving an incoming message, these stationery options are not
available. For details, see the section “Using Stationery Files.”

Once you’ve made all of your choices, click on the Save button in the dialog.

Note: If an unread (•) message is saved to a file, its status changes to
read, regardless of whether the message was opened.

If you select multiple messages from a mailbox window and select Save As..., all
of the messages are saved to a single file.

Choosing an Application for Saved Messages
When you save a message to a file using the Save As... command, the new text
file is formatted as basic ASCII text in a Macintosh document. The document type
is determined by the program you select using the TEXT files belong to option in
the Attachments Settings.

To do this, select Settings... from the Special menu. The Settings dialog is
displayed. Then, select the Attachments Settings. Near the bottom of the dialog,
click the TEXT files belong to button. A standard file dialog is displayed. Using
this dialog, search through your disk to locate the desired application (probably
your favorite word processing program). Select the application and then click
Open. The selected application is displayed in the button.

The desired application is now selected

QUALCOMM Incorporated 93



 



Using the Address Book
and Quick Recipient List

Using the Address Book
The Address Book is where you keep information about individuals or groups that
you correspond with. Each entry in the Address Book includes a nickname for a
person or group, their full e-mail addresses, a real name, any contact information,
and any notes. You can also use the Address Book to put nicknames on the Quick
Recipient List, and to address a new message.

To open your Address Book, select Address Book from the Special menu.

The Address Book with example entries
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All of the Address Book entries are kept in files, so you can group your entries by
putting them in different files. The example above shows files for Business,
Family, and Friends (Eudora Nicknames is the default file). To show the entries in
a file, click on the arrow to the left of the file. When the arrow points down, all
the entries for that file are displayed.

You can use the View By option to display the entries using any of the fields
except the Notes field. For example, if you want to view the entries by nicknames,
select View By Nickname. If you view by a field that doesn’t contain any data,
the entry is displayed with «».

You can find and select an entry by typing the first few letters of the entry. The
list of entries must be active (to make the list active, click once somewhere in the
list).

You can page up and down in the list of entries, use the arrow keys to move up
and down through the entries, or hold down the command key and use the arrow
keys to move up and down through the files of entries.

You can also resize the Address Book sections using the dividers between them.
Put your cursor over a line, and drag the line where you want it. This lets you hide
or display fields.

Resizing the Address Book sections

You can show or hide the right side of the Address Book by clicking on the split-
screen button ( ) next to the button cluster at the bottom left of the window.
Hiding the right side is useful in saving desktop space when you keep the Address
Book open to use nicknames.

To print your Address Book entries, select the entries you want and select Print...
from the File menu. The standard Print dialog is displayed.
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Creating New Entries
To create a new file of Address Book entries, click on New. A dialog is displayed
asking what you want to call it. Enter a name for the file and select Make it a file,
then click on OK to create it. The file is displayed in the list, and you can now
add entries to the file.

Creating a new file or entry

To create a new entry to be included in an existing file, click on New. A dialog is
displayed asking what you want to call it. Enter a Nickname for the entry. A
Nickname (sometimes called an alias) is an easily remembered, shorter substitute
for the e-mail addresses in the entry. Nicknames can be used in place of proper
e-mail addresses in the To, Cc, and Bcc fields of outgoing messages.

Specify which file this entry belongs in (if you have multiple files), and select the
Put it on the recipient list option if you want the nickname on your recipient list.
You cannot create a file within a file, so do not use the Make it a file option.
Click on OK to create the entry. Then you can enter the information for that entry.

In the Address(es) field, enter the complete e-mail addresses of the people (or
person) to be included in the nickname, separating the addresses with commas or
returns (this is the only place you can use a return to separate addresses). You can
also use nicknames in this field, but be sure that any nicknames you use are
defined in their own entry. You can use a mix of nicknames and complete e-mail
addresses.

Note: Be sure there is no other information in this field except addresses
or nicknames, or your messages will be addressed incorrectly.
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In the Name field, enter the real name of the person or group. If there is just one
address for the entry, the real name and the address is included in the To field for
your recipient to see. If there is more than one address for the entry, the real name
is the only thing included in the To field for your recipients—they do not see the
whole list of recipients.

In the other fields (Phone, Fax, Postal Address, and Notes), you can enter
contact information for the person or group, and any notes to yourself. This
information is not included in outgoing messages.

We recommend that you have at most 2,000 nicknames per file. If the files are too
large, they may appear collapsed in the Address Book, but you can still use all the
nicknames when addressing messages. If you have a large number of entries, you
may want to consider using a Ph server (for information, see Appendix A).

To save your changes to the Address Book, select Save from the File menu.

Changing and Removing Entries
To make changes to an Address Book entry, select the entry from the list and edit
the fields as appropriate.

To move an entry from one file to another, select the entry and drag it to another
file.

Important: If you change a nickname, be sure to correct any entries
that reference that nickname.

To remove an entry or an address file, select it from the list and click on the
Remove button. You cannot remove the Eudora Nicknames file.

To save your changes, select Save from the File menu.

Including Nicknames on the Quick Recipient List
To include a nickname on the Quick Recipient List, select the appropriate Address
Book entry from the list and click on the Recipient List option (next to the
Nickname field). The nickname for the selected entry is included on the Quick
Recipient List. If you change a nickname or remove an entry, the Quick Recipient
List is updated as appropriate. For details about using the Quick Recipient List,
see the section “Using the Quick Recipient List.”

Note: You can add multiple nicknames to the Quick Recipient List by
selecting multiple entries. Hold down the shift key to select
multiple entries in sequence, or the command key to make disjoint
selections.
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To save your changes, select Save from the File menu.

Addressing a Message from the Address Book
You can open and address a new message from the Address Book using the To,
Cc, and Bcc buttons, or by dragging one or more entries to an open message.

To create a new message from the Address Book, select the entry to which you
want to address the mail (hold down the shift key to select multiple entries in
sequence, or the command key to make disjoint selections). Then click on To, Cc,
or Bcc. A new composition window is displayed with the selected nickname(s)
inserted in the appropriate field.

Note: You can also double-click on one entry to enter that nickname in
the To field, or double-click on one of many selected entries to
enter those nicknames in the To field.

Once the composition window is displayed, you can use the To, Cc, and Bcc
buttons to insert additional nicknames into the corresponding fields. Or, you can
drag the appropriate entries to those fields: Click once on an entry, then drag it to
the appropriate field, or double-click an entry to add it to the To field.

Note: If you hold the shift key down when using the To, Cc, and Bcc
buttons, the Address Book remains current (topmost). If you hold
down the option key when using the To, Cc, and Bcc buttons, the
full e-mail address is inserted instead of the nickname. The full
e-mail address is also inserted if you drag an entry.

The “Make Address Book Entry” Command
The Make Address Book Entry... command is used to create entries in your
Address Book, and is especially helpful for making group entries. You can use
this command from anywhere in Eudora, including the Address Book, mailboxes,
open messages, and the Directory Services window.

From anywhere in Eudora, including open messages, you can highlight the
addresses you want, then hold down the shift key and select Make Address Book
Entry From Selection... from the Special menu. The New Nickname dialog is
displayed prompting you for the nickname of the new entry. The new entry’s
Address(es) field will include all of the addresses that you selected.

Note: If the new nickname has the same name as an existing nickname, a
prompt is displayed asking if you want to add the selected names to
the existing nickname or replace the existing nickname with the
new selection.
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In the Address Book, highlight several different entries (hold down the shift key
to select multiple entries in sequence, or the command key to make disjoint
selections), then select Make Address Book Entry... from the Special menu. The
New Nickname dialog is displayed prompting you for the nickname of the new
entry. The Address(es) field of the new entry will include the nicknames for the
entries you selected, not the real addresses.

Using the “Make Address Book Entry” command from the Address Book

In a mailbox, highlight the message(s) you want and select Make Address Book
Entry... from the Special menu. The New Nickname dialog is displayed
prompting you for the nickname of the new entry. Follow the instructions for
creating a new entry. If the current message is an outgoing message, the new entry
will include all of the addresses in the To, Cc, and Bcc fields. If the current
message is an incoming message, the new entry will include the address in the
From field. If multiple messages are current (i.e., you have several message
summaries selected in a mailbox window), addresses are taken from each message
and are all put in the new entry.

Note: The Make Address Book Entry... command uses the Replying
Settings. If the Reply to all By Default setting is turned on (or you
hold down the option key), the new entry will include all of the
recipients of the messages plus the sender. Or, if the Include

100 QUALCOMM Incorporated



Eudora User Manual Using the Address Book and Quick Recipient List

yourself setting is turned off, your address is not included in the
new entry.

In an open message window, select Make Address Book Entry... from the
Special menu. The New Nickname dialog is displayed so that you can name the
nickname. If the current message is an outgoing message, the new entry will
include all of the addresses in the To, Cc, and Bcc fields. If the current message is
an incoming message, the new entry will include the address in the From field.
See the note above about the Replying Settings.

In the Directory Services window, finish a Ph query and select Make Address
Book Entry... from the Special menu. The New Nickname dialog is displayed so
that you can name the nickname. The real name and e-mail address are included
in the new entry.

The “Finish Address Book Entry” Command
With the Finish Address Book Entry command, you can enter a unique portion
of a nickname in the To, Cc, or Bcc fields of a message, then select Finish
Address Book Entry from the Edit menu, and the nickname will be completed
for you. You must enter the characters in the nickname that make it unique, or
Eudora will not know which nickname to use. For example, if you have two
nicknames, joan and john, you would have to enter “joa” or “joh” for Eudora to
complete them.

To insert the real addresses for the entry, instead of the nickname, hold down the
option key and select Finish & Expand Address Book Entry from the Edit
menu. To set this to happen all the time, turn on the Expand nicknames
immediately option in the Sending Mail Settings.

Using Nicknames that were Not Created by Eudora
To use a nickname file that was not created in Eudora, put the file in the
Nicknames Folder in your Eudora Folder (located in your System Folder), and be
sure the format is correct: One nickname on each line with the word “alias,” a
space, the nickname, a space, and the real addresses separated by commas. For
example,

alias joe joe@wow.com
alias group joe@wow.com,lisa@wow.com,bill@wow.com

You will need to quit and restart Eudora to see your new entries in the Address
Book.
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Saving Your Entries to a File
To save your Address Book entries as a text clipping with tab-delimited entries,
select the entries you want and hold down the option key while dragging them to
the Finder. To save them as a text clipping with the standard nickname format,
use the same process but do not hold down the option key.

Using the Quick Recipient List
The Quick Recipient List is your list of often-used nicknames. If you have
checked the Recipient List option in an Address Book entry, the entry’s
nickname is included in the list.

The Recipient List option

To open a new message addressed to someone on your Quick Recipient List,
select New Message To, Forward To, or Redirect To from the Message menu,
and select the nickname from the displayed list.

To insert a nickname into a message that you have already opened, put the cursor
where you want the nickname and select Insert Recipient from the Edit menu.

To insert the real address(es), instead of the nickname, hold down the option key
and select Insert & Expand Recipient from the Edit menu. To set this to happen
all the time, turn on the Expand nicknames immediately option in the Sending
Mail Settings.

More than one nickname from the Quick Recipient List can be added to the To,
Cc, and Bcc fields of any message. If you use the Insert Recipient command,
commas are added where necessary.
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Opening Directory Services
Eudora can access two different online directory services, Ph and Finger. To use
these services, you must put the name of the host machines for the Ph and Finger
servers in the Hosts Settings.

To use the directory services, select Directory Services from the Special menu.
The active Ph or Finger server (defined in your Hosts Settings) is displayed above
the query field. Or, you can select a string of text (someone’s name or e-mail
address, for example), hold down the shift key, and select Directory Services
from the Special menu. This opens the window and inserts the string of text into
the query field.

Using Ph
To look someone up using Ph, enter your query and click on Ph. The query is sent
to your Ph server, and the response is displayed in the lower section of the
window.

A Ph query and its response

Note: You can type any Ph command in the query field, except login
commands or commands requiring login. For information about
the Ph server source code, see Appendix A.
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If the “Live” Ph queries option is on in your Hosts Settings, the connection with
your server is kept open and Ph queries are automatically sent to the server when
you finish typing the query text.

Note: To add the results of your Ph query to your Address Book, select
Make Address Book Entry... from the Special menu (for details on
how to use this command, see the section “The ‘Make Address
Book Entry’ Command”). This may not work if your Ph server is
not set up for it.

Finding Ph Servers
Some Ph servers keep a list of other Ph servers that are available on the Internet.
This is not always a comprehensive list of every Ph server out there, but it can be
helpful.

To get the list of servers from the active server (the active server is displayed
above the query field), click on the globe in the Directory Services window (next
to the Ph button). A list of servers is displayed in the results area. To go to one of
those servers and do a query, hold down the command key and click on the
server’s URL, or just double-click on the URL.

Using Finger
To use the Finger protocol, enter your query and click Finger. The query should
be in the form “name@domain.” If you omit the “@domain” segment, the host
name displayed above the query field is used (this is the SMTP host from your
Hosts Settings). The Finger query is sent to the Finger server, and the response is
displayed in the lower section of the window.
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A Finger query and its response

Addressing a Message from the Directory Services Window
You can create and address a message with the query results in the Directory
Services window.

To create a new message, be sure there are no outgoing messages already open, do
the Ph or Finger query, then click on the To, Cc, or Bcc button. A new message is
created, and addressed appropriately with the query results.

To add an address to an existing message, make sure the message you want to
address is active, open the Directory Services window, do the Ph or Finger query,
then click on the To, Cc, or Bcc button. The address from the query result is
added to the appropriate field of the current message.

Or, you can select the e-mail address from the results and drag it into the
appropriate field of the outgoing message.
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Customizing the Main Toolbar
The Main Toolbar is a group of buttons giving you easy access to your frequently
used Eudora functions.

The Main Toolbar

You can set the buttons to correspond to your function keys (the F keys on an
extended keyboard), and you can create new buttons for most Eudora commands.

Buttons on the main toolbar are context-sensitive: they are highlighted if they can
be used for the current task, and are dimmed if they cannot. For example: if an
incoming message is currently open or selected in a mailbox, the Reply toolbar
button is highlighted because you can reply to the message. If no incoming
message is open or selected, the Reply button is dimmed because there’s no
message to reply to. For toolbar buttons that correspond to menu commands, the
state of the button—highlighted or dimmed—matches the state of its associated
menu command.

To add a new button to the main toolbar, hold down the command key and put the
cursor between two buttons or at either end of the toolbar, depending on where
you want the new button to go; when the arrow changes to a splitter cursor ( ),
click on it. The Toolbar Button Creation dialog is displayed, prompting you to
choose a menu item or enter a key combination. This can be almost anything you
would do with Eudora, including using modifier keys with the command. When
you are done, the button is added to the toolbar, and named appropriately. If you
change your mind, click Remove Button or Cancel.
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The Toolbar Button Creation dialog

You can also drag files from the Finder to the toolbar to add them as buttons, and
you can drag mailboxes from the Mailboxes window to the toolbar to add them as
mailbox buttons. (You cannot drag mail folders to the toolbar.)

To change what a button does, hold down the command key and click on the
button, then select the function as you would when creating a button, or click
Cancel if you change your mind.

To change the placement of a button, hold down the command key and drag the
button to where you want it.

To remove a button from the toolbar, hold down the command key and drag the
button to the trash on your desktop. Or, hold down the command key and click on
the button, then click Remove Button in the dialog.

If you put a mailbox in the toolbar, you can drag messages to it to transfer them to
that mailbox. Use the tow truck icon in an open message, or drag selected
message summaries from an open mailbox window.

To set the options for displaying the main toolbar, use the Toolbar Settings. There
are options to display or hide the toolbar, to display it horizontally or vertically, to
display large or small icons, names, or combinations of icons and names, to map
the buttons to function keys, and to display the corresponding function key with
the buttons.

If you choose a display option that makes the toolbar very long, arrow buttons are
added to the ends of the toolbar so that you can easily move through it and find
the button you need.
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Using Eudora Plug-ins
Eudora plug-ins are software programs and resources developed by
QUALCOMM Incorporated, and by third-party vendors in conjunction with
QUALCOMM, to extend the standard Eudora program.

There are two kinds of Eudora plug-ins.

Message plug-ins are system extension files whose icons often look like puzzle
pieces. Resource plug-ins are system preference files whose icons often look like
a stamped envelope with two arrows on it.

              
Sample message plug-in (left) and resource plug-in (right)

The Eudora software includes both message and resource plug-ins, described
further below.

Additionally, you can purchase third-party Eudora plug-ins. For information on
plug-in software that’s available for use with Eudora, visit the World Wide Web
site <http://www.eudora.com>, or send e-mail to <eudora-rep@eudora.com>.

To use Eudora plug-ins, you must install them. Installation instructions appear
below.

If you would like to write a Eudora message plug-in, you can obtain the Software
Developer’s Kit (SDK) for the Extended Messaging Services Application
Programming Interface (EMSAPI) by anonymous ftp at ftp.eudora.com.

Plug-in Software That Comes with Eudora
When you install Eudora, the following three message plug-ins are automatically
installed in the Eudora Stuff folder contained in your Eudora Pro Application
Folder (the folder containing your Eudora application). These message plug-ins
operate on text in open outgoing and incoming messages:

• Rot13 Text — Scrambles message text by rotating the letters 13 places through
the alphabet. Your recipient must apply Rot13 at the receiving end in order to
unscramble the text and read the message.

• Space & Tab Converter — Converts multiple spaces in message text to tabs,
or vice versa.
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• Upper/Lower Text — Converts message text to either all upper case, all lower
case, initial word capitals, or initial sentence capitals.

When you start Eudora, these conversion services appear on the Message Plug-
ins submenu under the Edit menu. To use one of the services, open an outgoing
or incoming message, then select the service from the Message Plug-ins
submenu. The conversion is performed on the entire text in the message. If text is
selected in the message when you choose the service, the conversion is performed
only on that text.

For more information on these three message plug-ins, see their READMEs in the
Eudora Stuff folder.

Also when you install Eudora, a number of resource plug-ins are automatically
placed in the Plugins folder that resides under the Extras folder, in your Eudora
Pro Application Folder. These resource plug-ins, however, are not installed. To
use them, you must install them—see the installation instructions below.

For more information on these resource plug-ins, see the section “The Eudora Pro
Application Folder,” and also see the README in the Plugins folder itself.

Installing and Using Eudora Plug-ins
The procedure for installing a message plug-in and a resource plug-in is the same:

First, quit Eudora. Next, drag the message or resource plug-in file into the
Eudora Stuff folder contained in the Eudora Pro Application Folder. When you
next start Eudora, the message or resource plug-in will become available as
described below.

Note: You can also install both message and resource plug-ins in the
Eudora Pro Application Folder itself, or whatever folder you keep
the Eudora application in. Further, message plug-ins can be
installed in your system Extensions folder, and resource plug-ins
can be installed in your system Preferences folder, or in the
Eudora Folder in your System Folder.

Message plug-ins, once installed, become available in one of the following places
in Eudora, depending on the kind of function they perform:

• As commands on the Message Plug-ins submenu, under the Edit menu

• As icons on the icon bar of outgoing message windows or in the message body
of incoming message windows

• As commands on the Attach submenu, under the Message menu
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• As commands at the bottom of the Special menu

• Some message plug-ins may not be available through the menus or in message
windows because they perform their functions automatically, behind the scenes

Resource plug-ins, once installed, can appear in a variety of places within Eudora,
including in a dialog, a menu, a string of text, or a picture. A resource plug-in may
also operate behind the scenes without your input.

To change the settings for those installed message plug-ins that have settings,
select the message plug-in from the Plug-in Settings submenu under the Special
menu.

To see which message plug-ins are currently installed, select About Message
Plug-ins... from the Apple Menu (generally in the upper left corner of your
screen, with the Apple logo). The dialog that displays shows all installed message
plug-ins including those not visible on menus or as icons. Click OK to close the
dialog.

To remove a message or resource plug-in, simply quit Eudora and drag the plug-
in file out of your Eudora Stuff folder or the other folder in which you installed
it. The next time you start Eudora, the Eudora plug-in will no longer appear in its
former location in the menu system or in windows or dialogs.

Word Services
Eudora lets you add word services to the Eudora editor for use with outgoing
messages. However, only applications that support the Word Services Suite can
be used.

To add a word service to Eudora, select Add Word Service... from the Edit
menu. The Choose a “Word Services” application dialog is displayed.

First, locate the application and single-click on it to highlight it. Then click Open.
The word service is added to the Edit menu. To use this service for a current
outgoing message, select it from the Edit menu.

Printing
You can print the current message or messages, a plain text window, selected text
within a message or text window, the contents of the Directory Services window,
and your filters, signatures, and Address Book entries. Eudora automatically
prints headers and footers on each page, giving the window title, page number,
and your return address.
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To print the current message or item, select Print... from the File menu.

To print just the selected text, hold down the shift key and select Print
Selection... from the File menu.

To print one copy and bypass the standard Print dialog, select Print One Copy
from the File menu.

Putting Multiple Users on One Macintosh
If you have a multiple-user license for Eudora, you can set it up so that more than
one user can be on a single Macintosh. This also works if you have multiple
e-mail accounts but you don’t want to have alternate personalities set up and using
the same set of mailboxes, or if you want to store your mail in a folder other than
your System Folder. You will need to quit and restart Eudora to switch users.

To have multiple users on one Macintosh, for each user make a copy of the
Eudora Folder that resides in the System Folder. The copies can be named
whatever the users want, and put anywhere they want, including on a floppy disk
or network volume.

Each user can open Eudora by double-clicking on the Eudora Settings file within
their assigned folder. They can make changes to the Settings, create new
mailboxes, nicknames, and filters, etc., and not affect other users on the
Macintosh.

Note: To give users easy access to their mail, you can create aliases for
their Eudora Settings files and put them wherever you want on the
Macintosh (the Apple Menu Items folder is a good option).

Troubleshooting
Occasionally, you may encounter a problem or bug when using Eudora (as
indicated by an error message or some other type of symptom).

Make sure you have the current maintenance release of Eudora: First, locate the
Eudora application in your Eudora Pro Application Folder. Click once on the
application to highlight it, and select Get Info from the Finder File menu. Look
for the Eudora version number in the dialog. Next, using your World Wide Web
browser, go to the Eudora Web site, <http://www.eudora.com>, and check to see
what the latest version of Eudora is. If that version is later than the one you have,
see your Eudora administrator about obtaining the later version. This may solve
the problem or bug you’ve encountered.
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If you do have the latest version of the Eudora software, check the current
README file for potential known conflicts. The README may also contain
suggestions on how to resolve some of these problems.

The following troubleshooting table provides the corrective action for some of the
most common error messages or symptoms.

Symptom Corrective Action

Eudora displays the following error
when you try to send or queue
mail:

“Sorry, can’t queue this message;
all messages must have addresses
in the to: or bcc: fields. 0,
{compact:131}”

Either the message you are trying to send,
or the first message queued in your Out
mailbox, has one of these two problems:
(1) It doesn’t have anything in the To: or
Bcc: field, or (2) All it has in the To: or
Bcc: field is a nickname that doesn’t point
to an address. An example of the second
problem is to have the word Mickey in
the To: field and to have a nickname entry
for Mickey in your Address Book but no
address associated with that nickname.

Eudora has trouble with Spellswell
(spell checking).

Select Add Word Service... from the
Edit menu. Browse through the dialog
until you find the Spellswell application
on your hard drive, then double-click on
the application, or click once on it to
highlight it and then click Open.

Eudora displays the following alert
when you try to launch the
program:

“Memory is tight. You may need
to close some windows, clean up
your In, Out, and Trash
mailboxes, or increase Eudora’s
memory size”

Mail stored in Eudora’s In, Out, Trash,
and any open mailboxes increases the
amount of memory Eudora needs to
operate (mail stored in other mailboxes
does not). If you have a large amount of
mail in these mailboxes, try transferring
them to other mailboxes to decrease
Eudora’s memory requirements. If that
does not stop the alert from appearing,
increase Eudora’s memory size from the
Finder: First, quit Eudora. Then, highlight
the Eudora application icon, select Get
Info from the File menu, and increase the
Preferred Size for the application.
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Symptom Corrective Action

Eudora displays the following alert
when you try to launch the
program:

“Eudora cannot continue. Error
opening your settings file.”

If this happens, Eudora automatically
switches to your backup settings file
“Eudora Settings.bkup.” Quit and restart
Eudora. If the problem is not resolved,
you must throw away the “Eudora
Settings” and “Eudora Settings.bkup”
files, as they are not repairable. When you
restart Eudora, a new Eudora Settings file
will be created for you and you will need
to reconfigure Eudora.

Eudora displays the following error
when you try to check mail:

“-ERR Maildrop lock busy”

This usually happens after your
Macintosh has “hung” during a mail
check and you are now attempting to re-
connect to the mail server. Try checking
your mail again in ten minutes. If the
problem persists, contact your e-mail
administrator and tell them you have a
POPper process that needs to be
disconnected. System Administrators:
You might also want to try the
QUALCOMM popper. It has a timeout
that will reset the mailbox if the
connection closes abnormally. You can
ftp it anonymously from ftp.eudora.com
in the quest/unix/servers/popper directory.

Eudora displays the following error
when you try to check mail:

“There has been an error
transferring your mail. I said:
PASS and then the POP server
said: -ERR Password supplied
for “<username>” is incorrect.”

First, verify the correct spelling of your
POP account in the Getting Started
Settings. Make sure the account address is
complete, paying particular attention to
the part before the ‘@’ symbol, and
ensuring proper lettercase throughout the
address. Second, verify that you’re
entering your password correctly (Caps
Lock must be off). See your e-mail
administrator if the problem persists.
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Symptom Corrective Action

Eudora displays the following alert:

“Mailbox <mailboxname> has a
damaged table of contents. Shall
I build a new one?”

If a table of contents file for a particular
mailbox should become corrupt for one
reason or another, Eudora will not be able
to open the mailbox until it is rebuilt. If
this happens to you more than once with a
given mailbox, quit Eudora, then check
your Eudora Folder (in your System
Folder) for a .toc file for that mailbox,
and if you have such a file, delete it. You
will not lose any mail, though you will
lose the status information for the
messages. If the problem persists, you
may want to have your Macintosh
checked for possible problems.

Eudora displays the following error
message when you try to check
mail:

“Connection came up halfway
then failed.”

This message indicates that TCP/IP did its
“half” to open the connection, but the
other end didn’t respond. Although it
could indicate a network problem, it
usually indicates that your mail server
does not support POP3 or that your POP3
server is not currently available. You
should contact your e-mail administrator
and inquire about the status of the POP3
service if the problem persists.

Eudora displays the following error
message when you try to check or
send mail:

“A TCPClose command was
already issued, so there is no
more data to send on this
connection.”

This is a problem with your SMTP or
POP3 server. It is dying shortly after
startup. Contact your e-mail administrator
if the problem persists.
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Symptom Corrective Action

Random display problems. Rebuild your desktop: While holding
down the command and option keys,
restart your Macintosh, and continue to
hold down the command and option keys
until an alert appears asking if you’re sure
you want to rebuild the desktop file on
your hard drive. Click OK (you can
release the command and option keys at
this point). If this doesn’t help, you may
want to have your Macintosh checked for
possible problems.

Correspondents are complaining
that lines in the messages you send
are not wrapping correctly (lines
are broken in funny places).

The best solution is to turn on the Word
wrap option in the Settings dialog
(Sending Mail) and only press return
when you want to start a new paragraph.
Eudora will take care of breaking your
paragraphs into lines.

Your mail server complains that
you do not have a Date header in
your mail.

Eudora will not put a Date header on your
mail if you haven’t set the correct time
zone information on your Macintosh. You
can set the time zone using the Map
control panel, or, if you have System 7
Pro or System 7.5, the Date & Time
control panel. Remember to change your
time zone for Daylight Savings Time so
that Eudora can set the Date header
correctly.

You received a message containing
columns and the columns are not
lining up correctly

Your screen font is probably a
proportional font. Change your display
font to a non-proportional font (such as
Courier) in the Settings dialog (Fonts &
Display).
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The Settings Dialog
The Settings dialog lets you specify how you want to use Eudora. To display the
Settings dialog, select Settings... from the Special menu.

The Settings dialog contains many categories, which are described below. The
default setting for each option is listed in square brackets, [ ], after the name of the
option.

Note: For your convenience, some options appear in more than one
category. For example, your real name appears in the Getting
Started, Personal Information, and Personalities Settings.
Changing a setting in one group changes the setting in all groups
in which it appears.

Getting Started
The Getting Started Settings determine the minimum information necessary to
send and receive mail. The information here is for your “dominant” personality
(primary e-mail account).

The Getting Started Settings
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Real name [none]
The text you enter here (generally your first and last name) is included in the
From field of all your outgoing messages, and identifies to your recipients who
the mail is from.

POP account [none]
This is the address for your account on the POP server. Enter your login, an “@”
sign, and the full domain name of the computer. For example, if your assigned
login is “justine,” and the name of the computer where you receive e-mail is
“pop3.qualcomm.com” type “justine@pop3.qualcomm.com” in this field.

Return address (if different from POP account) [none]
This is your e-mail address. It is included in the From field of all your outgoing
messages, and when a recipient replies, this address is used. Your POP account is
used if you do not enter an address here. Continuing from the example above, if
Justine’s return address is justine@qualcomm.com (slightly different from her
POP account), she would enter that return address in this field.

Note: If you do enter an address in this field, first test the address to be
sure that mail sent to it is indeed delivered to you. If you use an
invalid return address, no one will be able reply to your mail.

Note: If you use UUCP as your mail transport, see Appendix C.

Connection method [TCP/IP]
This specifies how you are connecting to the network. If you are using Eudora via
TCP/IP software (e.g., a direct network connection, SLIP, or PPP), select
TCP/IP. If you are using Eudora without TCP/IP software, select
Communications Toolbox (meaning you are using the Communications Toolbox
software for communications). If you don’t want Eudora to attempt to make any
connections, select Offline. With Offline on, Eudora does not attempt to make
automatic mail checks and warns you when you attempt to make a manual mail
check.
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Personal Information
The Personal Information Settings determine your personal identity on the POP
and mail servers, for incoming and outgoing mail.

The Personal Information Settings

POP account [none]
This is the address for your account on the POP server.

Real name [none]
The information you put in this field (generally your first and last name) is
included in the From field of all your outgoing messages.

Return address (if different from POP account) [none]
This is your e-mail address. It is included in the From field of outgoing messages,
and when a recipient replies, this address is used. Your POP account is used if you
do not enter an address here.

Note: If you do enter an address in this field, first test the address to be
sure that mail sent to it is indeed delivered to you. If you use an
invalid return address, no one will be able reply to your mail.

Dialup username [none]
This is your username for dialup connections. If you use Eudora with the
Communications Toolbox, and you have a secondary username for use during the
dialup process, enter it here (e.g., your login name on a terminal server). See
Appendix B for details regarding how this field can be used.
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Hosts
The Hosts Settings determine what servers to use, and how to use them.

The Hosts Settings

POP account [none]
This is the address for your account on the POP server.

SMTP [none]
This is the name of your SMTP server. If the computer that your POP account is
on also runs an SMTP server, you can leave this field blank.

Note: If you use UUCP as your mail transport, see Appendix C.

Ph [none]
This is the name of your Ph server. It is necessary for doing Ph queries in the
Directory Services window.

Finger [none]
This is the name of your Finger server. If you leave this blank, Eudora uses your
SMTP server as your Finger server.

DNS load balancing [off]
If this is on, the workload of a community of Eudora users is spread over several
host computers. Turn this on if your network administrator tells you to.

DNS Load Balancing works by making Eudora choose a random address from the
list of addresses returned by the DNS (without DNS load balancing, Eudora will
always choose the first address from the list). Network administrators: If you have
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several machines that can perform the exact same service, list all their IP
addresses under one domain name, then instruct your users to use that domain
name and to turn on DNS Load Balancing. Now the users are equally likely to use
any one of the “balanced” machines for the service.

Overlap POP3 commands for better performance [off]
If this is on, commands are sent immediately to your server, instead of waiting for
a previous command to be completed. This is faster, but your POP server may not
be able to handle it.

Live Ph queries [off]
If this is on, the connection with your server is kept open with the Directory
Services window. Ph queries are automatically sent to the server when you finish
typing the query text.

Use mail-exchange records (SMTP Servers Only) [off]
If this is on, then when Eudora makes an SMTP connection, it asks your domain
name server to tell it which host would be best for accepting your mail. See your
system administrator before turning this setting on. The setting works only with
Open Transport.

Checking Mail
The Checking Mail Settings determine how Eudora checks for and receives your
incoming mail messages.

The Checking Mail Settings
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POP account [none]
This is the address for your account on the POP server.

Check for mail every ? minutes [off, none]
If this is on and you enter a number, Eudora automatically checks your POP
server for new mail at regular intervals and transfers to your Macintosh any mail
addressed to you. The number you enter specifies the number of minutes between
checks. It’s a good idea to set this at no less than 15 minutes. Checking mail more
often puts an unnecessary drain on your POP server. This option only works when
Eudora is running. Leaving this field empty disables automatic checking (even if
the box is checked).

Don’t check when using battery [off]
If this is on and your Macintosh is running on battery power, mail is not
automatically checked (even if you have the check mail option on).

Skip messages over ? K [off, 40]
If this is on, messages over the specified size are downloaded only in part. These
messages include the first few lines, and a statement that says the message is not
complete. This can be useful on slow connections. For details, see the section
“Managing Your Mail on the POP Server.”

Leave on server for ? days [off, none]
If this is on, Eudora copies incoming messages to your Macintosh and leaves the
message on the POP server for the specified number of days. If you leave it blank,
your mail is left on the server indefinitely. For details, see the section “Managing
Your Mail on the POP Server.”

Send on check [on]
If this is on, any messages that are queued in the Out mailbox are sent when mail
is checked, whether automatically or manually.

Save password [off]
If this is on, your password is remembered even if you quit and restart Eudora, so
you’ll never be prompted to enter it. Only use this option if your Macintosh is in a
secure place.

Delete from server when emptied from trash [off]
If this is on, any messages that are deleted from your Trash mailbox are also
deleted from the POP server. For details, see the section “Managing Your Mail on
the POP Server.”
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Overlap POP3 commands for better performance [off]
If this is on, commands are sent immediately to your server, instead of waiting for
a previous command to be completed. This is faster, but your POP server may not
be able to handle it.

Authentication [Passwords]
This specifies which authentication technology to use: Passwords, Kerberos, or
APOP. Ask your e-mail administrator which one to use.

Sending Mail
The Sending Mail Settings determine how Eudora sends your outgoing mail
messages.

The Sending Mail Settings

Return address (if different from POP account) [none]
This is your e-mail address. See the Getting Started Settings.

Domain to add to unqualified names [none]
This is the domain name that Eudora automatically adds to an unqualified name.
An unqualified name is a name that doesn’t have an “@” sign followed by a
domain name. This can be used to save time when addressing large numbers of
messages to users in the same domain.

SMTP Server [none]
This is the name of your SMTP server. If the computer that your POP account is
on also runs an SMTP server, you can leave this field blank.
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Immediate send [on]
If this is on, the rightmost button in the icon bar of the message composition
window is labeled Send. Clicking on this button immediately sends the message
to the SMTP server. If this option is off, the button is labeled Queue and clicking
on it places the message in the Out mailbox marked ready for delivery (Q).

Send on check [on]
If this is on, any messages that are queued in the Out mailbox are sent when mail
is checked, whether automatically or manually.

Fix curly quotes [on]
If this is on, Eudora replaces all “curly” quotation marks in message text or
attachments with "conventional" quotation marks prior to sending the message. It
also replaces bullets (•) and en/em dashes (–/—). These marks are special
characters, and this option allows messages to be sent without using quoted-
printable encoding.

Note: If your recipients have MIME, there’s no reason to use the above
option. Only turn it on if most of the people you correspond with
don’t use MIME.

Expand nicknames immediately [off]
If this is on, nicknames in message headers are replaced with the real addresses
when you switch fields.

Automatically Fcc to original mailbox [off]
If this is on, replies are automatically copied to the same mailbox that contains the
original message.

Stationery [None]
The default stationery for your dominant account: select a stationery file from the
popup, or select None for no stationery. If a stationery file is selected, that file is
used when you open new messages (except with the Redirect or Send Again
commands). The icon bar in the message window is set according to how the
stationery message was saved, regardless of how the options below are set. But,
you can always change them after you open the message. For more details, see the
section “Using Stationery Files.”

Options when not using stationery
The values you choose for the following options apply only when you are not
using stationery—that is, when the Stationery popup, above, is set to None. If, on
the other hand, you have selected a default stationery file in that popup, then the
values below are ignored. Instead, Eudora uses their corresponding values that
were set when the stationery file was saved. So, for example, if you choose
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default stationery that uses your Alternate signature and you set the Signature
popup below to your Standard signature, your Alternate signature will be used.

Signature [Standard]
The default signature for your dominant account: select one from the popup, or
select None for no signature. If you select a signature, Eudora automatically
attaches that signature to the end of outgoing messages from your dominant
account. You can override this setting with the Signature popup in the
composition window. For more details, see the section “Using Signatures.”

May use Quoted-Printable [on]
If this is on, Eudora uses quoted-printable encoding when necessary, such as
when sending messages that contain long lines of text or special characters. If this
option is off, quoted-printable encoding is never used. We recommend that you
leave this option on.

Word wrap [on]
If this is on, a carriage return is not required at the end of each line of type in an
outgoing message. Eudora automatically wraps text to the next line, with line
breaks at roughly 76 characters per line. This makes your mail more legible to
recipients using line-oriented mail systems. It is strongly recommended that you
leave this option on.

Keep copies of outgoing mail [off]
If this is on, a copy of each message you send is kept in the Out mailbox. If this
option is off, outgoing messages are put in the Trash mailbox after they are sent.
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Attachments
The Attachments Settings determine how Eudora sends and receives attachments.

The Attachments Settings

Encoding method [BinHex]
This specifies what encoding method to use for attached documents. To change
the method for just the current message, use the Attachment Type popup in the
outgoing message window. For details, see the section “Attaching a File to a
Message.”

Always include Macintosh information [off]
If this is on, Macintosh resources and types are included in attachments if they are
basic MIME types. It may be advisable to turn this off when sending attachments
to non-Macintosh users. For more information, see the section “Attaching a File
to a Message,” and also see Appendix D.

Receive MIME digests as attachments [on]
If this is on, MIME digests are converted to Eudora mailboxes. If this is off,
MIME digests will be displayed as a single long message.

Attachment Folder [none]
This specifies what folder to put incoming attachments into. To specify a folder,
single-click on the folder name button. A dialog is displayed prompting you to
select a folder. If you do not select an attachment folder, Eudora stores your
incoming attachments in the Attachments Folder in your Eudora Folder,
contained in your System Folder. See the section “Receiving Attachments.”
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Trash attachments with messages [off]
If this option is on, Eudora automatically deletes an attachment received with a
message when that message is deleted. The attachment must still be in the folder
defined as the Attachment Folder. If you want to save an attachment but delete the
message, move the attachment to another folder or turn this option off.

TEXT files belong to [TeachText]
This specifies what application is used to open text files. When you choose Save
As... from the File menu, Eudora creates a Macintosh document that is saved for
the application named in this field. That way, when you double-click the saved
file, this application is used to open it. You may want to set this option to your
favorite word processing program. To change the application, single-click on the
application name button (the default is TeachText). A dialog is displayed allowing
you to select an application.

Fonts & Display
The Fonts & Display Settings determine how Eudora displays windows and text.

The Fonts & Display Settings

Screen Font, Size, and Text Color [Mishawaka, 9, black]
These options specify the font, point size, and color to be used for text displayed
in Eudora messages and mailbox windows. Select the color using the Macintosh
color wheel.

QUALCOMM Incorporated 127



Reference Eudora User Manual

Background Color [white]
This specifies a background color to be used in Eudora messages and mailbox
windows. Select the color using the Macintosh color wheel.

Print Font and Size [Courier, none]
The Print Font popup menu lets you select a font to be used when you print
messages using the Print command. Enter a point size in the box.

Message window width [80]
This specifies the width of new and received message windows (in characters). If
you leave this field blank, Eudora uses the default value of 80. This setting has no
effect on what your mail looks like when it is sent. When mail is sent, Eudora
wraps at or before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based
on the width of the “0” character.

Message window height [none]
This specifies the height of new and received message windows (in lines). If you
leave this field blank, Eudora uses a default value of 20.

Note: If the Zoom windows when opening option is turned on, received
messages’ window heights are automatically adjusted to the height
of the message text.

Zoom windows when opening [on]
If this is on, new mailbox and message windows automatically open to their
“zoomed” size. The zoomed size is computed on a window-by-window basis. For
mailbox windows, zoomed size is just wide enough to display the widest
summary, and just long enough to display all the summaries (but no longer than
the Macintosh display screen). For message windows, zoomed size is just long
enough to display all of the message (but no longer than the Macintosh display
screen), and as wide as the Message window width setting. Composition
windows zoom to the height specified by the Message window height setting.

Waste cycles drawing trendy 3D junk [on]
If this is on, interface items are displayed in 3D. If this is off, interface items are
displayed in 2D.

Display graphics attachments inline [off]
If this is on, Eudora displays graphics attachments as pictures in the open
incoming message window. If this is off, Eudora displays the graphics
attachments as name-and-icon pairs. See the section “Receiving Attachments.”
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Show formatting toolbar [off]
If this is on, the formatting toolbar displays by default in new message windows.
If this is off, the formatting toolbar is hidden by default in new message windows.
This toolbar lets you easily format text styles in new messages. You can turn the
toolbar on and off in the current message using the Formatting Toolbar
command from the Text submenu of the Edit menu. See the section “Formatting
Toolbar.”

Date Display
The Date Display Settings determine how the date is displayed in message
summaries.

The Date Display Settings

Date formats [Age-sensitive]
This specifies how to display the date. If Age-sensitive is selected, messages
dated today are displayed with the time, messages dated within the last six
calendar days are displayed with the day of the week, and messages dated seven
calendar days or more ago are displayed with the date. If Fixed is selected, all
messages are displayed with the time and date.

Display dates using [Sender’s timezone]
This specifies what time zone to use. If Local timezone is selected, messages are
displayed with your time and date. If Sender’s timezone is selected, messages are
displayed with the sender’s time and date.

QUALCOMM Incorporated 129



Reference Eudora User Manual

Toolbar
The Toolbar Settings determine how the main toolbar is displayed.

The Toolbar Settings

Show toolbar [on]
If this is on, the main toolbar is displayed on your desktop.

Orientation [Horizontal toolbar]
This specifies the orientation of the main toolbar: horizontal or vertical.

Button type [Big icons only]
This specifies how the button names and icons are displayed.

Map function keys to buttons [on]
If this is on, the function (F) keys mimic the main toolbar buttons.

Show function key labels [on]
If this is on, the function key labels are displayed in the main toolbar.
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Eudora Labels
The Eudora Labels Settings determine the additional labels that are available for
messages. Eudora supports up to 15 labels. The first 7 labels (1 through 7) are
selected via the Macintosh Labels control panel.

The Eudora Labels Settings

You can use the Macintosh color wheel to select new Eudora label colors, and
enter the text for the label. To change a label title, type the new title in the text
field. To change a label color, click on the color field to display the Apple Color
dialog. You can select from one of the pre-defined colors or create your own
custom color.
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Getting Attention
The Getting Attention Settings determine what Eudora does when it is running in
the background and wants your attention, or when new mail arrives.

The Getting Attention Settings

Use an alert [on]
If this is on, an alert dialog notifies you when new mail is received.

Flash an icon in the menu bar [on]
If this is on, an icon is flashed in the menu bar when Eudora needs attention.
Eudora uses two different icons—a Mail flag when you have new mail and an
envelope with an exclamation point in it for everything else.

The new mail and attention icons

Open mailbox (new mail only) [on]
If this is on, mailboxes are automatically opened when new mail arrives in them,
and the first unread message of the last unread batch of messages is selected.

Play a sound [on]
If this is on, a sound is played when Eudora needs attention. There are two
different sounds, the New mail sound (played when new mail arrives) and the
Attention sound (played for everything else). Popup menus next to these titles let
you select the sound you want from the available sounds on your Macintosh.
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Say OK to alerts after 2 minutes [on]
If this is on, any alerts that announce a problem sending and receiving mail
automatically go away after two minutes. Many network problems are temporary,
so this allows Eudora to try the communication again. This is most useful if you
have automatic mail checking enabled.

Note: Turning this option on may cause some Communications Toolbox
connection tools to give you less progress information.

Extra Warnings
The Extra Warnings Settings determine if you are warned before making a
possible mistake. Most of the warnings are displayed with an option to stop that
warning from being displayed again. If you chose that option, you can turn the
warning back on using the Extra Warnings Settings.

The Extra Warnings Settings

Try to delete unread mail [on]
If this is on, you are warned if you try to delete unread mail.

Try to delete queued mail [on]
If this is on, you are warned if you try to delete queued mail.

Try to delete any unsent messages [on]
If this is on, you are warned if you try to delete unsent messages.

Try to queue a message with no subject [off]
If this is on, you are warned if you try to queue a message with no subject.
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Try to queue a message with styled text [off]
If this is on, you are warned if you try to queue a message with styled text. (You
can also use the Styled Text Settings to set several options related to styled text.)

Try to quit with messages queued to be sent [on]
If this is on, you are warned if you try to quit Eudora and you have queued
messages.

Try to send a message whose size is more than ? K [on, 900]
If this is on, you are warned if you try to send a message whose size is more than
the specified number. This number must be between 0 and 1000000.

Set a changed message back to read-only [on]
If this is on, you are warned if you try to make an edited incoming message
uneditable.

Empty the Trash mailbox [on]
If this is on, you are warned if you try to empty the Trash mailbox. Once
messages are deleted from the Trash, they are completely gone.

Try something that requires too much memory [on]
If this is on, you are warned if you try to do something that might take more
memory than you have available.

Replying
The Replying Settings determine how replies are created.

The Replying Settings
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Reply to all [When option key is down]
This specifies which recipients to include in a reply. Reply to all By default (use
option key for sender only) creates a reply addressed to the sender and all the
recipients of the original message. You can hold down the option key to create a
reply to only the sender. Reply to all When option key is down creates a reply
addressed to only the sender. You can hold down the option key to create a reply
addressed to the sender and all the recipients of the original message.

When replying to all
This specifies how to address a reply. If Include yourself is on, when you Reply
to all (as described above) your address is left in the address list of the new
message and you receive a copy of your own reply. If this option is off (the
default), your address is removed from the reply message and you do not receive a
copy of the reply. If Put original To: recipients in Cc: field, not To: field is on
(the default is off), the addresses of the original message recipients are moved
from the To field to the Cc field of the reply-to-all message. Only the address of
the original sender is placed in the To field.

Note: To determine who you are for the Include yourself option, Eudora
uses the “me” nickname, if you create one for yourself. If you do
not have a “me” nickname, Eudora uses the contents of the POP
account and Return address fields from your Getting Started
Settings.

Copy original’s priority to reply [on]
If this is on, your replies use the same priority as the original message.
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OT/PPP and MacSLIP
The OT/PPP and MacSLIP Settings determine what Eudora does when you are
connecting to your service provider using MacSLIP From Hyde Park Software or
Apple’s Open Transport PPP 1.0. Normally, when Eudora or any other
application tries to make a connection, MacSLIP or OT/PPP will automatically
dial your provider and establish a connection. This connection remains open until
you close it or a timeout period elapses. The settings below modify this behavior.

The OT/PPP and MacSLIP Settings

Don’t make automatic checks when MacSLIP or OT/PPP is not already connected
[off]
If this is on, automatic mail checks are not done unless your MacSLIP or OT/PPP
connection is currently running (this avoids unnecessary connections to your
service provider).

Disconnect MacSLIP or OT/PPP if Eudora connected it [on]
If this is on, MacSLIP or OT/PPP disconnects at the end of a mail check when it
was connected by Eudora, but it does not disconnect at the end of a mail check
when it was connected by another application. If this option is off, MacSLIP or
OT/PPP will not automatically disconnect at the end of a mail check, even if it
was connected by Eudora. Use this option to minimize the time you are connected
to your service provider.
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Moving Around
The Moving Around Settings determine how you open messages and switch fields
in Eudora.

The Moving Around Settings

Arrow+these modifiers to switch messages [Command]
If any of these are on and there is a message window open, you can hold down all
of the keys you have selected and use the Macintosh keyboard arrows to close the
current message and open the next or previous message in the mailbox. The up
and left arrow keys open the previous message; the down and right arrow keys
open the next message. The arrow keys can be used by themselves to move the
insertion point in messages.

After transferring or deleting or paging past end of current message, open
[Next unread message]
This specifies whether to automatically open the next message after you delete or
transfer the current message. Nothing means nothing is opened. Next message
means the next message in the mailbox is always opened. Next unread message
means the next unread message in the mailbox is always opened (could be way
down the list). Next message if unread means the very next message in the
mailbox is opened but only if it’s unread.

Tab to switch fields, option-tab to insert tab [off]
If this is on and your cursor is in the body of a message, the tab key moves the
cursor to the To field, and the option and tab keys together insert a tab at the
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insertion point. If this option is off, the tab key inserts a tab, and the option and
tab keys together move the cursor to the To field.

Return switches among header fields [on]
If this is on, the return key moves the cursor to the next header field in outgoing
messages. If this is off, the return key inserts a carriage return into outgoing
message headers.

Miscellaneous
The Miscellaneous Settings determine assorted Eudora functions that are not
otherwise categorizable.

The Miscellaneous Settings

Close messages with mailbox [off]
If this is on, closing any mailbox window (except Out) closes all the open
messages from that mailbox.

Empty Trash on Quit [on]
If this is on, the Trash mailbox is emptied when you quit Eudora. If this is off, the
Trash is only emptied when you select Empty Trash from the Special menu.

Turbo redirect by default [off]
If this is on and you select Turbo Redirect To, a redirected message is created
with the specified recipient, the message is queued, and the original message is
deleted. You can hold down the option key to do a regular Redirect.
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Re-sort mailboxes less often [off]
If this option is on, mailboxes are only sorted when they are opened or mail is
added to them.

Lock whole program in memory [off]
If this is on, the whole program is loaded into memory and kept there until you
select Quit. This takes more memory, but runs a little faster. This option is only
for 68k versions.

Use old-style “.toc” files [off]
If this is on, each mailbox stores its table of contents in a “mailbox.toc” file,
instead of in its resource fork (the default in 3.0 and later versions of Eudora). If
you have upgraded to version 3.0 or later, this is automatically on. You should
turn this off at some point so that your mailboxes convert to using resource forks.

With this option, each mailbox is converted as it is used. To convert your
mailboxes all at once (either to .toc files or to resource forks), use the TOC
converters provided with Eudora. The TOC README file explains the
differences between the two formats and how to use the TOC converters.

Convert Hesiod names to lower-case [on]
If this is on, Hesiod results are converted to lower-case, except for user names.

Note: Hesiod, developed at MIT under Project Athena, is server software
that provides to Eudora the name of your mail server. Hesiod is
used at few sites.

Include outdated Return-Receipt-To: [off]
If this is off, Eudora uses the “Disposition-Notification-To:” header in return
receipt requests to request that you be sent a notification when your message is
displayed by the recipient. If this is on, Eudora also sends the “Return-Receipt-
To:” header in return receipt requests. This header is understood by some older
mail delivery systems, and may return you a receipt when your message is
delivered to your recipient’s mailbox. The “Return-Receipt-To:” header cannot
give you any information about whether or not your recipient displayed your mail,
and is not supported by many newer mail delivery systems.

Write to Internet Config [off]
If this is on, preferences are written to Internet Config. Internet Config is not
supported, so this is not recommended.

Read from Internet Config (not recommended) [off]
If this is on, preferences are read from Internet Config. Internet Config is not
supported, so this is not recommended.
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Correct (but slow) international sorting [off]
If this is on, slower but internationally correct string comparisons are used.

Require control key for text/message dragging [off]
If this is on, you can only drag items when the control key is down.

Generate filter reports [off]
If this is on, a filter report is generated when messages are filtered from the In
mailbox.

Prompt for receipts requested by self [on]
If this is on, if you request a return receipt in an outgoing message and you
include yourself as a recipient, then when you receive the incoming message, you
are asked to respond to the request. If this is off, you are not asked to respond to
the request. This setting does not affect whether your other recipients get the
request: they will always get the request in a return-receipt message provided they
have a compatible mailer.

Note: To determine who you are for the above option, Eudora uses the
“me” nickname, if you create one for yourself. If you do not have a
“me” nickname, Eudora uses the contents of the POP account and
Return address fields from your Getting Started Settings.

Settings Icons
The Settings Icons Settings determine the display of category names and icons in
the Settings dialog.

The Settings Icons Settings
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Mailbox Columns
The Mailbox Columns Settings determine which columns are displayed in
mailbox windows.

The Mailbox Columns Settings

Show columns [Status, Priority, Attachments, Label, Who, Date, Size, Server]
If any of these options are on (all are on by default), that column is displayed in
mailbox windows. The Subject is always displayed.

Draw separator lines [on]
If this is on, separator lines are drawn in mailbox windows.
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Styled Text
The Styled Text Settings determine when to use style information in outgoing and
incoming messages.

The Styled Text Settings

Show formatting toolbar [off]
If this is on, the formatting toolbar displays by default in new message windows.
If this is off, the formatting toolbar is hidden by default in new message windows.
This toolbar lets you easily format text styles in new messages. You can turn the
toolbar on and off in the current message using the Formatting Toolbar
command from the Text submenu of the Edit menu. See the section “Formatting
Toolbar.”

When sending mail with applied fonts & styles [Send style information with mail]
This specifies what to do with text styles when you are sending mail. If you select
Send style information with mail, the text styles are sent with your messages.
Check the But warn me first option if you want to be warned when you try to
send or queue a message with styles. If you select Discard style information,
style information is not sent with your messages.

When receiving styles, pay attention to [Bold, Italic, Underline, Font, Size, Color,
Left/right/center, Margins, Excerpts]
If any of these options are on (all are on by default), that style is displayed in your
incoming messages (if the sender allows it). “Excerpts” refers to excerpt bars
(sidebars) included at the left of quoted text containing styles.
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Personalities
The Personalities Settings, along with the Personality Extras Settings, are used to
define the necessary information for your alternate e-mail accounts.

The Personalities Settings

Personality [«Dominant»]
A popup menu of your alternate e-mail accounts, or “personalities.” Your
Dominant personality is your primary e-mail account: the one Eudora uses when
you don’t specify otherwise, and the one that’s associated with all mail stored
before you began using alternate personalities.

The New and Remove buttons let you create a new personality or delete the
selected personality. You cannot delete the Dominant personality.

To set the following options for a personality, just be sure that personality is
selected in the popup. The settings for the Dominant personality are reflected in
the other Settings categories—if you change them in the Personalities Settings
they will change in all other categories in which they appear.

Pers. Name [«Dominant»]
Stands for Personality Name. For the Dominant personality, this field is display-
only and cannot be changed. For an alternate personality, enter the name you wish
to assign to the personality. This name appears on the Change Personality
submenu under the Message menu, and on the Personality popup in the From field
of new message windows.
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Note: Eudora uses the personality name to mark your mail for that
personality. If you change the name of the personality, you break
the link between the mail and that personality. As a result, mail
that had been associated with the old personality name is now
assigned to the Dominant personality. Therefore, choose
personality names wisely, and refrain from changing names unless
absolutely necessary.

POP account [none]
The address for this personality’s account on the POP server. For details about
this option, see the Getting Started Settings.

Real name [none]
The real name assigned to this personality (generally a first and last name). This
name is used in the From field of all outgoing mail for this personality.

Return address [none]
The return e-mail address used in outgoing messages and recipients’ replies for
this personality, if this address is different from the personality’s POP account.
For more details about this option, see the Getting Started Settings.

Check for mail every ? minutes [off, none]
If this is on and you enter a number, then mail is automatically checked for this
personality at the specified interval. If this is off, no automatic mail checking
takes place for this personality (even if a number is in the box). For more
information, see the Checking Mail Settings. Note that you can have different
mail-checking intervals for different personalities, but if automatic mail-checking
is set for the Dominant personality, then the Check Mail command on the File
menu reflects the time of the next check for the Dominant personality.

Check mail on manual checks [on]
If this is on, each time you do a manual check for mail, by selecting the Check
Mail command from the File menu, then mail is checked for this personality. If
this is off, manual mail-checks do not check mail for this personality.

Note: To turn off all mail checking for the selected personality, turn off
both the Check for mail every ? minutes option and the Check
mail on manual checks option.

Leave mail on server [off]
If this is on, mail for this personality is left on the POP server and a copy is
transferred to your Macintosh. If this is off, mail for this personality is deleted
from the POP server after it is transferred to your Macintosh. For more details, see
the section “Managing Your Mail on the POP Server.”
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Authentication [Passwords]
This specifies which authentication technology to use for this personality:
Passwords, Kerberos, or APOP. Ask your e-mail administrator which one to use
for this personality.

Personality Extras
The Personality Extras Settings supplement the Personalities Settings in defining
your alternate e-mail accounts.

The Personality Extras Settings

Personality [«Dominant»]
A popup menu of your alternate e-mail accounts, or “personalities.” Your
Dominant personality is your primary e-mail account: the one Eudora uses when
you don’t specify otherwise, and the one that’s associated with all mail stored
before you began using alternate personalities.

To set the following options for a personality, just be sure that personality is
selected in the popup. The settings for the Dominant personality are reflected in
the other Settings categories—if you change them in the Personality Extras
Settings they will change in all other categories in which they appear.

Domain to Add [none]
This is the domain name that Eudora automatically adds to an unqualified name
addressed in messages sent from this personality. An unqualified name is a name
that doesn’t have an “@” sign followed by a domain name. This can be used to
save time when addressing large numbers of messages to users in the same
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domain. Also, different personalities can be used to send messages to different
domains. For example, you can use one personality to send work-related messages
to the domain qualcomm.com, and another personality to send personal messages
to the domain in your home e-mail address, or to your school account, e.g.,
myschool.edu.

SMTP Server [none]
This is the name of the SMTP server for this personality. If the computer that this
personality’s POP account is on also runs an SMTP server, you can leave this
field blank.

Note: If you use UUCP as your mail transport, see Appendix C.

Stationery [None]
The default stationery for this personality: select a stationery file from the popup,
or select None for no stationery. For more details about using stationery with
alternate personalities, see the section “Using Stationery Files.”

Signature when not using stationery [Standard]
This sets the default signature for this personality, when you are not using
stationery: that is, when the Stationery popup (above) is set to None. If you have
chosen a stationery file in the above popup, then the signature used when that
stationery file was saved overrides your setting here.

Select a signature from this popup, or select None for no signature. If you select a
signature, Eudora automatically attaches that signature to the end of outgoing
messages for this personality. For more details about using signatures with
alternate personalities, see the sections “Using Signatures” and “Using an
Alternate E-mail Account.”

Send mail whenever sends are done [on]
If this is on, queued mail for this personality is sent whenever Eudora sends
queued mail. However, timed-queue messages, marked with a T in the Status
column of the Out mailbox, are sent subject to their time specifications. See the
section “Queueing a Message to Send at a Certain Time.”

If this is off, queued mail for this personality is not sent when Eudora sends
queued messages, and you must send such mail manually. See the section
“Sending or Queueing a Message” for more information.
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Menu Commands
File
This menu provides basic file and mail functions.

New Text Document
Create a new text file.

Open...
Open a selected (highlighted) message summary, a text file,
or a Eudora Settings file.

Open Selection
Open a selected (highlighted) message summary, attachment,
URL, or mailbox (from the Mailboxes window).

Open in Browser
Open a selected (highlighted) message summary, or an open
message, in your World Wide Web browser. Used for
enhanced display of messages containing HTML-formatted
text (e.g., Web pages).

Close
[option] Close All
Close the current window.
Close all windows.

Save
[option] Save All
Save the changes to the topmost window.
Save the changes to all open windows.

Save As...
Save the current message(s) to a plain text file or a Stationery
file.

Send Queued Messages
[option] Send Messages Specially...
Send all messages that have been queued for delivery.
Display the Mail Transfer Options dialog.
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Check Mail
[option] Check Mail Specially...
Pick up new mail from the POP server.
Display the Mail Transfer Options dialog.

Page Setup...
Set printing options.

Print...
[shift] Print Selection...
Print the current message(s), or window.
Print just the selected text.

Print One Copy
Print one copy of the selection (bypass the Print dialog).

Quit
Quit the Eudora application.
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Edit
This menu provides text editing tools.

Undo
Reverse the last action taken.

Cut
Delete the selected text and place it on the clipboard.

Copy
[option] Copy & Unwrap
[shift] Copy Without Styles
[option]-[shift] Copy Without Styles & Unwrap
Copy the selected text and place it on the clipboard.
Copy it without carriage returns.
Copy it without the text styles.
Copy it without text styles or carriage returns.

Paste
[shift] Paste Without Styles
Paste the contents of the clipboard.
Paste it without text styles.

Paste As Quotation
Paste the contents of the clipboard as quoted text.

Clear
Delete the selected text, or detach the selected attachment (in
the X-Attachments field) before sending the message.

Text
[option] Text
Apply text styles to the selected text or paragraph.
Display the Completely Plain option.
Note: The Formatting Toolbar command under this
submenu turns the formatting toolbar on or off in the current
message.

Select All
Select the entire contents of a message or a mailbox.

Wrap Selection
[option] Unwrap Selection
Insert carriage returns into the selection, as appropriate.
Remove the carriage returns from the selection.
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Finish Address Book Entry
[option] Finish & Expand Address Book Entry
Complete the partial text of a nickname.
Complete it and expand it to its real address.

Insert Recipient
[option] Insert & Expand Recipient
Insert the chosen nickname.
Insert the real address of the nickname.

Message Plug-ins
Use on-request or on-demand plug-ins to modify text in
outgoing and incoming messages. See the section “Using
Eudora Plug-ins.”

Add Word Service...
Add AppleEvent-aware word processing functions to the Edit
menu.

Check Spelling
Display the Check Spelling dialog.
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Mailbox
This menu lets you open a mailbox, or bring an open mailbox to the front.

In
Open the mailbox where incoming messages are stored until
deleted or transferred to another mailbox.

Out
Open the mailbox where messages you compose are stored,
where queued messages are held until actually sent, and
where copies of sent messages may be initially stored.

Trash
Open the mailbox where deleted messages are stored.

New...
Display the New Mailbox dialog to create a new mailbox.

Other...
Open a mailbox that is not located in the Eudora Folder (in
your System Folder) and add it to the Mailbox and Transfer
menus.

[Your Mailboxes]
Open the selected mailbox that you have created.
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Message
This menu lets you create, send, and delete messages.

New Message
Open a new message composition window.

Reply or Reply To All
[option] Reply To All or Reply
[shift] Reply Quoting Selection or Reply Quoting
      Selection To All
[option]-[shift] Reply Quoting Selection To All or
      Reply Quoting Selection
Reply to the sender of the current message.
Reply to the sender and all the original recipients.
Reply and quote only the selected text from the sender.
Reply to all and quote only the selected text from the sender.
(Based on the Reply to all option in the Replying Settings.)

Forward
Forward the current message to someone else.

Redirect
Forward the current message to someone else, but make the
return address be the person who originally sent the message.

Send Again
Resend a message rejected by the mail system. Be sure to fix
whatever caused the problem before you queue the message.

New Message To
Send a message to someone on the Quick Recipient List.

Forward To
Forward a message to someone on the Quick Recipient List.

Redirect To or Turbo Redirect To
[option] Turbo Redirect To or Redirect To
[option]-[shift] Turbo Redirect Without Delete To or
      Redirect To
[shift] Redirect To or Turbo Redirect Without Delete To
Redirect the message to someone on the Quick Recipient List.
Redirect it, queue it, and delete the original message.
Redirect it, queue it, and keep the original message.
(Based on the Turbo redirect by default option in the
Miscellaneous Settings.)
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New Message With
Create a new message with the selected stationery file.

Reply With or Reply To All With
[option] Reply To All With or Reply With
[shift] Reply Quoting Selection With or Reply Quoting
     Selection To All With
[option]-[shift] Reply Quoting Selection To All With or
     Reply Quoting Selection With
Reply to the sender with the selected stationery file.
Reply to the sender and all of the original recipients with the
stationery file.
Reply with the stationery file and quote the selected text.
Reply to all with the stationery file and quote the selected
text.
(Based on the Reply to all option in the Replying Settings.)

Attach Document...
Attach a Macintosh file or application to the current message.

Attach
Use attachment plug-ins to create and attach special files to
the current message. See the section “Using Eudora Plug-ins.”

Send Immediately or Queue For Delivery
[option] Change Queueing...
Send the message immediately, or queue the message in the
Out mailbox.
Display the Change Queueing dialog.

Change
Change the queueing, status, priority, label, or personality of
a message.

Delete
[option]-[shift] Nuke
Transfer the current message into the Trash mailbox.
Delete the current message permanently. The message is
removed from your Macintosh, and any attachments are
moved into the Trash on your desktop. Warning: There is no
way to undo a Nuke operation.
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Transfer
This menu lets you transfer the current message(s) to another mailbox.

In
Transfer the current message(s) to the In mailbox.

Out
Transfer the current message(s) to the Out mailbox.

Trash
Transfer the current message(s) to the Trash mailbox.

New...
Display the New Mailbox dialog to create a new mailbox,
then transfer the current message(s) into that mailbox.

Other...
Open a mailbox not located in the Eudora Folder (in your
System Folder) and add it to the Transfer and Mailbox menus.

[Your Mailboxes]
Transfer the current message(s) to the selected mailbox that
you have created.
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Special
This menu lets you use additional Eudora functions.

Filter Messages
Run the manual filters for the current message(s).

Make Address Book Entry...
[shift] Make Address Book Entry From Selection...
Create an Address Book entry (nickname) from the current
message.
Create an entry from the selected addresses.

Find
Search for the designated character string within a message,
messages, mailboxes, or mail folders.

Sort
[option] Sort Descending
Sort the message summaries in a mailbox in ascending order.
Sort them in descending order.

Filters
Display the Filters window.

Mailboxes
Display the Mailboxes window.

Address Book
Display the Address Book window.

Directory Services
Display the Directory Services window.

Settings...
Display the Settings dialog.

Plug-in Settings
Set the preferences for settable message plug-ins. See the
section “Using Eudora Plug-ins.”

Communications...
Display the Communications Toolbox settings (not needed
when using TCP/IP—see the Getting Started Settings).
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Signatures
Display the Standard, Alternate, or additional signature
windows.

Change Password...
Change your password on the POP server.

Forget Password
Make Eudora forget your password so mail can’t be checked.

Empty Trash
Delete all messages from the Trash mailbox.

[Plug-in Names]
Use special plug-ins. These menu items are added to the
bottom of the menu when certain Eudora plug-ins are
installed. See the section “Using Eudora Plug-ins.”

Window
This menu lets you work with Eudora windows.

Send to Back
Send the topmost (current) window to the back of all
displayed windows.

[Eudora Windows]
Bring the selected window to the front of all displayed
windows.
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The Eudora Folder
The first time you start Eudora, it creates a Eudora Folder within your System
Folder. Even though you do not need to access the Eudora Folder during normal
operation, this section is provided to show you where Eudora stores your
mailboxes and messages.

Attachments Folder
Incoming attachments are saved in the Attachments Folder until you specify
another folder in the Attachments Settings.

Eudora Filters
Filters are saved in the Eudora Filters file.

Eudora Items
The Eudora Items folder contains special files and folders for use with Eudora.
The Plugins folder (different from the Plugins folder in the Eudora Pro
Application Folder) contains settings and information files for your Eudora plug-
ins.

Eudora Log
Mail transfers and errors are logged in the Eudora Log file. When the file reaches
100k in size, it is saved as Old Log (replacing any existing Old Log file) and a
new Eudora Log file is created.

Eudora Nicknames and Nicknames Folder
Address Book entries are saved in the default Eudora Nicknames file. If you
have created additional files, those are kept in the Nicknames Folder. These files
are in UNIX “.mailrc” format.

Eudora Settings
Settings information is saved in the Eudora Settings file.

Signature Folder
Signatures (Signature, Alternate, and others) are kept in the Signature Folder.
“Signature” contains your Standard signature.

Spool Folder
Attachments that are being resent or forwarded are kept in the Spool Folder until
the corresponding message is deleted.
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Stationery Folder
Stationery message files are kept in the Stationery Folder.

In, Out, and Trash
Mail is saved in the In, Out, and Trash mailbox files. Mailboxes that you create
are also saved in files like these. These files are in UNIX spool format.

Mailbox Aliases
Eudora supports the use of aliases for mailboxes that, for some reason, you have
moved to a location outside the Eudora Folder. This allows you to use these
mailboxes from within Eudora. Place the mailbox aliases in the Eudora Folder or
a subfolder within the Eudora Folder.

Note: A mailbox alias is automatically created and placed in the Eudora
Folder when the Mailbox menu Other... command is used to open the
mailbox. It is then deleted when you quit Eudora. However, if the
Other... command is used to open the mailbox from within a mail
folder or subfolder, the alias remains in the Eudora Folder
indefinitely.

The Eudora Pro Application Folder
During the installation, the Eudora Pro folder is installed on your hard drive in the
location you specify. This folder contains the following:

• Eudora Pro, the Eudora Pro application.
• Eudora Stuff, the folder to use for installing message plug-ins and resource

plug-ins that you want available in Eudora.
• Extras, the Extras folder.
• Documentation, the Documentation folder.
• ObjectSupportLib, a system library used by Eudora running on a Power

Macintosh.
• README, the text file with important information and instructions that are not

provided in this manual.
• Spellswell, the Spellswell folder.
• Filter Converter, a folder containing the FilterConverter utility and

README, for use in converting filters created in this version of Eudora
into a form suitable for use in pre-3.0 versions.
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Extras
The Extras folder contains the following items:

• Dialup, the folder with files to be used for direct serial dialup.

• MacSLIP, the folder with MacSLIP applications and examples.

• Plugins, the folder with various Eudora resource plug-ins.

Dialup
The Dialup folder contains the following:

• Direct UNIX Navs, a plug-in file for direct UNIX dialups.

• README, the Dialup folder README text file.

• srialpop.shar, a program for use on UNIX systems to ensure that Eudora
can transfer mail.

• GV Modem Definitions, Apple Modem Tool 1.5 settings for all current
Global Village Modem products.

• Connection Tools, the Connection Tools folder containing the Apple
Modem and Serial Tools for the Communications Toolbox (see the section
“Installing Connection Tools”).

• Internet Service Providers, resource plug-in files for accessing service
providers (see the README for more details). To use a Eudora resource
plug-in file, first quit Eudora, then drag the plug-in file into your Eudora
Stuff folder, or into your Preferences Folder or your Eudora Folder (both
are located inside your System Folder), and then restart Eudora.

MacSLIP
The MacSLIP folder contains the following:

• MacSLIP Apple Events, an application that handles AppleEvents for
MacSLIP.

• NetStat, an application that displays the current MacSLIP Script Status.

• AppleScript Examples, examples of using AppleScript with MacSLIP.

• Script Examples, examples of MacSLIP connection scripts.
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Plugins
To use a Eudora resource plug-in file, first quit Eudora, then drag the plug-in file
into your Eudora Stuff folder, or into your Preferences Folder or your Eudora
Folder (both are located inside your System Folder), and then restart Eudora.

The Plugins folder contains the following (all plug-in files are resource plug-ins):

• README, the Plugins folder README text file.

• Esoteric Settings, a plug-in file that adds extra settings screens to the
Eudora Settings dialog. Only recommended for use by the most advanced
users.

• EudoraTables, a plug-in file for use with the Eudora transliteration
function.

• Forward934, a plug-in file that makes Eudora do RFC 934-style
forwarding.

• Kerberos Settings, a plug-in file that adds the settings necessary for using
Kerberos with Eudora. Consult with your Kerberos administrator prior to
using this file.

• Synch I/O, a plug-in file that turns on synchronous I/O, which can improve
compatibility with problem extensions and disk drivers.

• Toshiba, a plug-in file for use with a certain model of Toshiba PowerBook
hard drives, to prevent the drives from corrupting Eudora mailboxes.

Documentation
The Documentation folder contains the following:

• Release Notes, the release notes for this version of the Eudora software.

• MacTCP Admin Guide.sea, a self-extracting archive containing the Apple
Computer instructions for installing and configuring MacTCP. This
document is provided for system administrator reference.

Note: This file may not be included with some Eudora licenses.

• MacSLIP Manual.dp, the MacSLIP manual in Common Ground format.

• Resources, a list of Eudora resources that can be edited with ResEdit.
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Spellswell
The Spellswell folder contains the following:

• Read Me First, the Spellswell README text file.

• Spellswell 7 2.0.1, the Spellswell 7 2.0.1 application.

• Dictionary-93000+, the Spellswell dictionary file.

• Check this document, supplementary Spellswell file.

• Spellswell™7 Manual.dp, the Spellswell manual in Common Ground
format.

• Omnis Developers Read Me, supplementary Spellswell file.

• About Working Software, supplementary Spellswell file.

• Working Software’s Products, supplementary Spellswell file.

• Dictionary Merge Utility, supplementary Spellswell folder.
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Anonymous ftp (ftp.eudora.com)
QUALCOMM’s Eudora Division has an anonymous ftp server, ftp.eudora.com,
that has information and software related to Eudora. These are located within the
quest directory. Included are POP3, Ph, and password changing servers, the
srialpop program, current product information, dialup files, and more.

Eudora Information
The information in this manual was correct at the time of printing. However,
things happen very quickly in the electronic world, meaning that some of this
information may already be out of date. For the very latest information about
Eudora, send e-mail to eudora-info@eudora.com.

Obtaining a POP Server
If you would like to run a POP server on your own UNIX system, we suggest you
use popper. Popper is available via anonymous ftp from ftp.eudora.com. Popper
versions are available for a number of UNIX systems.

VAX/VMS systems may try the Multinet package from TGV, or IUPOP3,
available via anonymous ftp from ftp.indiana.edu.

Ph Server Source Code
A server for the Ph protocol is available via anonymous ftp from ftp.eudora.com.

Password Change Server
Three sample UNIX servers for Eudora’s Change Password... command (on the
Special menu) are available via anonymous ftp from ftp.eudora.com.

Kerberos
To learn more about the Kerberos authentication system that is supported in this
version of Eudora, anonymous ftp to athena-dist.mit.edu and begin in the
pub/kerberos subdirectory.
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Introduction
Eudora is designed for use with MacTCP or for dialup to Cisco terminal servers.
It can be used with other dialup connections as well. Complicated setups are
likely to be unreliable, but if the setup commands to connect are simple, Eudora
works well.

These instructions assume you are familiar with ResEdit, your communications
equipment, and your hosts. It is suggested that one person make these changes to
Eudora and then redistribute the customized version to other users at your site.

Macintosh Requirements
To use Eudora over a dialup connection, you must have the Communications
Toolbox installed. System 7 has it built in.

Dialup Requirements
Eudora needs a “transparent” connection to your POP, SMTP, and (optionally) Ph
servers. Transparent means primarily two things:

1. Characters Eudora sends should not be echoed back to Eudora. Most
systems do echo characters, so something special may need to be done to
achieve this.

2. You must pay close attention to how carriage returns are treated. UNIX
systems routinely translate carriage returns into linefeeds; you must either
disable this on your system or teach Eudora how to deal with it.

Navigation
Eudora has a very rudimentary scripting system built in. This capability is called
“navigation” to separate it from the rather sophisticated connotations of
“scripting.”

Eudora uses a list of strings that it sends out the serial port one at a time. After
each string, it waits until there is no output from the remote system for 2 seconds
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or until a given string is matched, after which Eudora continues with the next
string.

There can be three sets of navigation strings contained in STR# resources: one is
used when connecting (Navigate In), one is used when disconnecting (Navigate
Out), and one is used when switching from SMTP to POP (Navigate Mid). You
can use ResEdit to manipulate these resources. Any of the resources can be
absent, in which case Eudora skips the navigation it would otherwise have done
with that resource.

For each function, Eudora selects an appropriate resource in the following
manner. First, it takes the name of the connection tool currently in use (e.g.,
“Apple Modem Tool”); then, it appends a space and the current type of navigation
(e.g., “Navigate In”). Eudora looks for an STR# resource with that name (e.g.,
“Apple Modem Tool Navigate In”). If that is not found, Eudora looks for an
STR# resource named after the navigation type (e.g., “Navigate In”). Finally, it
looks for specific resource ids (2400 for Navigate In, 2600 for Navigate Out, and
4200 for Navigate Mid). The first STR# resource found is the only one used.

Navigation resources can be in the Eudora application itself, in your Eudora
Settings file, or in a resource plug-in file. The latter is a file with type “rsrc” and
creator “CSOm” placed in your Preferences folder; use of a plug-in file is highly
recommended.

Plug-in files go in the Preferences folder

Special Sequences in Navigation Resources
Eudora provides a set of special character sequences for use in Navigation
resources. These sequences are all two characters long, the first character being a
backslash. Either they are replaced with items from your Eudora Settings, or they
modify the Navigation process.
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Replacements
These special characters are replaced with strings. They can appear at any place in
a navigation string.

\u POP account user name.

\h POP account host name.

\p POP account password.

\s SMTP server host name.

\U Dial-in user name.

\P Dial-in password.

\n A linefeed (ASCII 10).

\r A carriage return (ASCII 13).

\\ A single backslash character.

\^ Enter a prompt for the \a modifier.

\a Ask the user for something.

\c Cancel if a string appears.

When \^ appears, all the text after it (up until the end of the string or the next ‘\’)
goes into a prompt string that will be used with the \a modifier.

When \a appears, a dialog will be used to ask the user to type something. What the
user types will be used where the ‘\a’ appears.

Example: \^Enter the SecureId code below:\a\r

This will put up a dialog with the prompt “Enter the SecureId code below:”, and
then wait for the user to type in the code. The code will then be sent, along with a
carriage return.

\c is used to enter text that will abort the navigation process. The text is valid only
for the duration of the particular string it appears in. If you wish to look for it in
another string, you must specify it again.

Example: \P\r\eaccepted\cdenied
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Eudora will send the dial-in password and a return, then wait until it sees either
“accepted” (in which case the navigation process will continue) or “denied”
(which will abort the navigation process and the mail transfer).

Modifiers
\b Hide from Progress window.

\D Delay.

\B Break.

\e Expect something.

\b – When this appears as the first character in a given string, Eudora won’t print
the string in the Progress window when it is sent. This is useful for passwords or
other state secrets.

\D – Should be the first character in the string and followed only by digits or an
expect string. The digits are taken as a number of seconds to delay (e.g., “\D2” is
a two-second delay). As with other strings, Eudora will wait for output to stop for
two seconds, or for an expect string, before proceeding.

\B – Should be the first character in the string and followed only by digits or an
expect string. The digits are taken as the number of ticks (60ths of a second) to
send a break signal (e.g., “\B30” is a half-second break). As with other strings,
Eudora waits for output to stop for two seconds, or for an expect string, before
proceeding.

\e – Makes Eudora expect to see a specific string in the output from the dialup
server. Eudora sends whatever comes before the \e, and then waits for whatever
comes after it to occur in the data sent from the host. There are two caveats to this.
First, Eudora only matches on the first 7 bits; the high bit of each character is
ignored for matching. This is needed for systems that use parity. Second, Eudora’s
matching is fast and sloppy; highly repetitive data streams and long expect strings
might fool it (for example, Eudora wouldn’t see “Login:” if your server said:
“LogLogin:”).

Eudora follows its normal time-out process when looking for an expect string.
That is, after 45 seconds Eudora asks you if you want to keep waiting or cancel
the process. If you cancel, the connection process is stopped.

If you use either of the password replacement sequences (“\p” for your POP
account password or “\P” for your dialup password) in the same string as an
expect, Eudora assumes the password is wrong if the expect string isn’t found.
This causes Eudora to ask for your password the next time it tries to connect.

168 QUALCOMM Incorporated



Eudora User Manual Appendix B – Dialup Eudora

Connecting to Servers
Once the navigation is done, Eudora issues a command to connect to the proper
port of the server you are using. Once this command is sent, the connection must
be transparent, as discussed above; no echoes and no carriage return translation.
Eudora comes configured to send the command

telnet hostname portnumber /stream<return>

The “<return>” means a carriage return in this document only; you must type
actual carriage returns in ResEdit. A template for the command is kept in 7400.13
(“7400.13” is shorthand for STR# resource id 7400, string 13). The template
begins life as “telnet %p %d /stream\n”. The %p is replaced with the hostname
and the %d with the port number. It is acceptable to change this string however
you please, except that %d, if it is used, must come after %p. The best way to
change this string is not to modify it, but to override it. You can do this by
creating an “STR” resource of id 7413 and putting the string you want Eudora to
use in that.

A Return By Any Other Name
When Eudora is communicating with your POP or SMTP server, it’s important
that they agree on what constitutes a line. The Internet specification stipulates that
a line ends with a carriage return followed by a linefeed. Most UNIX systems will
“helpfully” translate carriage returns into linefeeds. If you can’t get that feature
turned off, it may help to make Eudora send only a carriage return, and not the
carriage return/linefeed pair. You can edit 6000.17 to be what you want Eudora to
send at the end of a line. The best way to change this string is not to modify it, but
to override it. You can do this by creating an “STR” resource of id 6017 and
putting the string you want Eudora to use in that.

An Example: Direct Connection To A UNIX Machine
Here’s a suggested connection method if your Macintosh has a serial line to a
UNIX machine, or if there are modems on your Macintosh and UNIX machine.

1. Install the srialpop program on your UNIX system. Source to this is part
of the Eudora distribution.

2. Put the following strings in the “Navigate In” resource.

1: \r\r\eogin:

2: \u\r\essword:
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3: \p\r\r\r\e%

4: exec srialpop\r

3. Put one empty string in the “Navigate Mid” resource.

Resources for dialing directly in to a UNIX machine

Srialpop takes care of the terminal settings for you.

Note: A plug-in with these strings in it is part of the Eudora distribution.
The file name is “Direct UNIX Navs.”

Need More Options?
If Eudora’s scripting isn’t adequate for you, one alternative is the Calypso
connection tool. It lets you use CCL scripts for the connection/disconnection
process. Calypso can be found on major Macintosh archive sites.
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Introduction
Eudora works with UUCP in almost exactly the same way as it works with the
POP and SMTP servers. Attachments are supported, as is regular mail checking
and the other features. It is possible to mix methods; for example, you can use
UUCP for reading mail but SMTP for sending it.

Eudora does not come with UUCP. Three available Macintosh UUCP systems are
“uupc 3.0” (dplatt@snulbug.mtview.ca.us), “gnuucp” (jim@fpr.com), and
“UUCP/Connect” (formerly “µAccess,” sales@intercon.com). “UUCP/Connect”
is commercial; the other two are freeware. Eudora has been tested with all three
packages; it works well with uupc 3.0 and UUCP/Connect, but it does not work
very smoothly with gnuucp.

Settings Dialog for UUCP

Personal Information Settings for UUCP
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Hosts Settings for UUCP

POP Account
If you are going to receive mail via UUCP, you should put the full path name of
your “mail drop” (the file where UUCP leaves mail for you) in the POP account
field. Precede the name with an exclamation point.

TCP/IP or Communications Toolbox
This setting (Connection method in the Getting Started Settings) doesn’t matter
if you’re doing pure UUCP mail. If you’re trying to mix UUCP with SMTP or
POP, set this to whatever is appropriate for your SMTP or POP connection.

SMTP Server
If you want to send mail via UUCP, several items have to go in the SMTP field.
Each one should be preceded by an exclamation point. The items are, in order:

mac - the UUCP name of your Macintosh.

spoolpath: - the full path name of the UUCP working directory.

user - your user name on your Macintosh.

0000 - a four-digit sequence number; will be incremented by Eudora.
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Return Address
If you use UUCP for reading your mail, you must put your correct return address
in the Return address (if different from POP account) field. It is absolutely
vital that this address be correct. If it’s wrong, no one is able to reply to your mail
and the mail transport system is unable to tell you your mail can’t be delivered.

Operation
Almost all Eudora features work normally with UUCP. The one exception is the
Leave on server for ? days option in the Checking Mail Settings. When Eudora
is used with POP and this option is on, only unread mail is downloaded. With
UUCP, however, Eudora does not distinguish between read and unread mail; it
downloads all the mail at each check. This results in duplicate messages, unless
you use some other means to clean out your mail drop between Eudora checks. It
is suggested that this option remain off when using UUCP.

Internals
Mail Drop Format
Eudora expects the mail drop to be in standard UNIX mailbox format, with UUCP
envelopes (“From” lines) at the beginning of each message. The mail drop should
use carriage returns (not line feeds) for new lines.

Working Files
When sending mail, Eudora creates two files in the UUCP work directory. These
files are as follows:

D.mac0####
The message itself is put in this file. As distributed, Eudora uses returns for new
lines in this file. That can be changed by editing the last characters of STR#
resource id 8000, string 5; Eudora will use whatever nonprintable characters are at
the end of the string. The mail begins with a UUCP envelope. The “####” stands
for the four-digit sequence number mentioned above in the section “SMTP
Server.” It increments as each message is sent.

X.mac0####
Commands for the UUCP system are put in this file. These commands are all
editable via ResEdit; they are distributed with returns at the ends.

U user mac

; identifies you (STR# id 8000, string 1)
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F D.mac0####

; this file contains your message (8000,2)

I D.mac0####

; use your mail for input (8000,3)

C rmail recipient...

; all recipients of the mail are listed here (8000,4)
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What is MIME?
“MIME” stands for Multipurpose Internet Mail Extensions. MIME serves two
major purposes: it allows mail applications to tell one another what sort of data is
in mail, and it also provides standard ways for mail applications to encode data so
that it can be sent through the Internet mail system.

MIME Encodings
The Internet uses SMTP (Simple Mail Transfer Protocol) to move mail around.
SMTP is limited to the US-ASCII character set. This is a problem for people who
speak languages other than American English and so need accented characters or
non-American letters, or for people who want to use special symbols like the
section mark (§).

MIME provides a way around this restriction. It offers two encodings, “quoted-
printable” and “base64.” These encodings use US-ASCII character codes to
represent any sort of data you like, including special characters or even non-text
data.

“Quoted-printable” is used for data that is mostly text but has special characters or
very long lines. It’s very simple. Quoted-printable looks just like regular text,
except when a special character is used. The special character is replaced with an
“=” and two more characters that represent the character code of the special
character. So, a section mark (§) in quoted-printable looks like this: “=A8”.

However, there are some other things that quoted-printable does. For one, since it
uses an “=” to mean something special, equals signs must themselves be encoded
(as “=3D”). Second, no line in quoted-printable is allowed to be more than 76
characters long. If your mail has a line longer than 76 characters, the quoted-
printable encoding will break your line in two and put an “=” at the end of the first
line, to signal to the mail reader at the other end that the two lines are really
supposed to be all one line. Finally, a few mail systems either add spaces to or
remove them from the ends of lines. So, in quoted-printable, any space at the end
of a line gets encoded (as “=20”), to protect it from such mail systems.
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Let’s try an example. Here’s a passage of text that you might type on your
Macintosh:

«Il est démontré, disait-il, que les choses ne peuvent être

autrement; car tout étant fait pour une fin, tout est nécessairement

pour la meilleure fin.»

Without any encoding, this might show up on your recipient’s screen as:

+Il est dimontri, disait-il, que les choses ne peuvent btre

autrement; car tout itant fait pour une fin, tout est nicessairement

pour la meilleure fin.;

This corruption happens because SMTP cannot handle the special characters.
However, if you and your recipient both have MIME, quoted-printable encoding
would be used, and your text would show up properly:

«Il est démontré, disait-il, que les choses ne peuvent être

autrement; car tout étant fait pour une fin, tout est nécessairement

pour la meilleure fin.»

While your mail was actually in transit, however, it would have looked like this:

=ABIl est d=E9montr=E9, disait-il, que les choses ne peuvent =EAtre

=

autrement; car tout =E9tant fait pour une fin, tout est n=E9cessairement =

pour la meilleure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail
system. However, Base64 makes no attempt to be legible, and is most appropriate
for non-text data.
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MIME Labeling
The other important part of MIME is that it lets mailers communicate what kind
of data is in a message (or part of a message). The primary mechanism used for
this is the Content-Type header:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts: the content type, the content
subtype, and the parameters. In this case, the content type is “text,” meaning the
message contains mostly legible text. The content subtype is “plain,” which
means there aren’t any formatting commands or anything like that embedded in
the text. Finally, “charset=iso-8859-1” is a parameter; in this case it identifies the
character set the message uses.

The major content types are as follows:

text legible text

image pictures and graphics

audio sound

video moving pictures

message messages or pieces of messages

multipart several different kinds of data in a single message

application everything else

Practical Issues
There are really only two things you sometimes need to do with Eudora and
MIME. One is that it may occasionally be necessary to turn off quoted-printable
encoding. Another is that you may want to know how to define mappings between
MIME types and Macintosh types.

Turning Off Quoted-Printable
Eudora automatically uses quoted-printable encoding if your mail or your plain
text attachments contain special characters. If your recipients don’t have MIME,
quoted-printable can hurt more than it helps. If that’s the case, just turn off the QP
icon in the outgoing message icon bar when you are sending text files to those
recipients.
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Mapping Between MIME Types and Macintosh Types
When you send attached files to other Eudora users, Eudora automatically knows
what kind of data is in the files, because Eudora sends along special information
with the file. However, if you’re sending the file to a non-Macintosh user, or
receiving files from a non-Macintosh user, it’s important to get the right MIME
type information on the file, or for Eudora to understand what the MIME type
information means.

Eudora knows about some MIME types. However, since new MIME types are
being defined all the time, it may be necessary to add to Eudora’s knowledge from
time to time. If you’re familiar with ResEdit, this isn’t too hard to do.

The way Eudora maps between MIME and Macintosh types is with EuIM and
EuOM resources. EuOM resources are used for sending attachments, EuIM for
receiving. They have the same basic structure.

EuOM and EuIM resources are lists of individual elements called “maps.” Each
map describes a Macintosh document type (or MIME data type) and then lists
what MIME data type (or Macintosh document type) it corresponds to. For any
given type, Eudora looks through all the maps in all the EuOM or EuIM
resources, and uses the best match.

Note: EuOM and EuIM resources are also used when uuencoding and
uudecoding files, so that filename suffixes can be mapped to and
from Macintosh types. A good set of EuIM and EuOM resources
can substantially improve document exchange with systems that
use uuencode.

Sending
When you create a map in an EuOM resource, you use the “Creator Code” and
“Type” fields to specify what documents the map applies to. These fields should
be filled with the four-byte creator code or Macintosh type of the documents you
want to send. If you leave the Creator Code blank, but fill in the type, the map is
used for any document of that type, regardless of creator. If you fill in both
Creator Code and Type, a document has to match both for the map to be used.
Given the choice, Eudora uses the map that matches both creator and type.

The other parts of the map are used to construct the MIME information. Content
Type and Content SubType are the MIME type and subtype to use for the
document. Filename suffix allows you to tell Eudora to add a suffix to the
filename, as an extra hint to the receiving system (for example, you might have
Eudora add “.xls” to Excel files).
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“Newline conversion?” tells Eudora whether or not to convert carriage returns in
the file to carriage return, linefeed. Usually, you should set this to 1 for text data,
but to 0 for binary files.

Finally, “May suppress resource fork?” is used in conjunction with Eudora’s
Always include Macintosh information option (in the Attachments Settings). If
you set this to 1, and Always include Macintosh information is off, Eudora
won’t send Macintosh type and creator information with the file, and won’t send
the resource fork. Instead, it will just send the data fork with the MIME
information attached to it.

An Example Map in an EuOM Resource

The map above says that all files of type “EPSF,” no matter what the creator,
should be sent as “application/postscript,” that “.eps” should be added to the
filename, that carriage returns should not be turned into carriage return/linefeed
pairs, and that when the Always include Macintosh information switch is off,
the resource fork won’t be sent.

Receiving
EuIM resources are used for receiving files. They’re pretty much the same as
EuOM resources, except that the MIME type and subtype are used for matching,
and the Macintosh creator code and type are applied to the file received.

As with EuOM resources, you can leave parts blank. If you want to match all files
with an “.eps” suffix, regardless of the MIME type or subtype, leave the type and
subtype blank. If you don’t care what the filename suffix is, leave that blank and

QUALCOMM Incorporated 179



Appendix D – MIME and Mapping Eudora User Manual

match with the MIME type and/or subtype only. Again, as with EuOM resources,
Eudora will choose the map that matches best.

With EuIM resources, it’s sometimes a good idea to use several maps to catch all
important cases. For example, it might be a good idea to have three maps for
dealing with PostScript files, as follows:

Content Type: application
Content SubType: postscript
Filename suffix:
Creator Code: mlpr
Type: TEXT

This map will catch most MIME PostScript files, and set their creator to MacLPR.

Content Type:
Content SubType:
Filename suffix: .eps
Creator Code: dPro
Type: EPSF

This map will match any incoming file with a suffix of “.eps,” regardless of the
MIME type info, and set its type to “EPSF” and creator to “dPro” (MacDraw
Pro). But what if a file comes in with a suffix of “.eps” and a MIME type/subtype
of “application/postscript”? Which map gets used? The first one gets used; when
Eudora has a choice between matching a suffix and matching MIME type
information, MIME wins. A third map may be in order:

Content Type: application
Content SubType: postscript
Filename suffix: .eps
Creator Code: dPro
Type: EPSF

This makes application/postscript files with suffixes of “.eps” get type EPSF and
creator dPro.
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Symbols make address book entry from 99

maximum entries in 98
“me” nickname, for personal identification 37, 51,
53, 135, 140

Name field in 98
New button in 97

-, in the Status column 71 Notes field in 98
6000.17 169 paging up and down in 96
7400.13 169 Phone field in 98
???@??? 72 Postal Address field in 98
\^ 167 printing 96
\a 167 Recipient List option 98
\b 168 removing entries from 98
\c 167 resizing 96
\D 168 saving changes to 98
\e 168 saving entries to a file 102
\h 167 showing/hiding right side 96
\n 167 type to select entries in 96
\p 167, 168 using non-Eudora nicknames 101
\r 167 View By option 96
\s 167 Address Book command 95, 155
\u 167 Address(es) field 97
\\ 167 After transferring or deleting or paging past end of

current message, open option 137•, in the Status column 29, 50, 58, 71
µAccess 171 Aliases

mailboxes 158
Settings files 112A

Align Center button 26
About Message Plug-ins command 111 Align Center text option 38
Add button 45 Align Left button 26
Add Word Service command 44, 111, 113, 150 Align Left text option 38
Address Book Align Right button 26

adding nicknames to the Quick Recipient List
98

Align Right text option 38
Allow both numbers and letters in words option 47

Address(es) field in 97 Alternate personalities 29, 55
addressing a message from 99 Always include Macintosh information option 126
changing entries in 98 and option 85
creating a message from 99 Any Header field 83
creating new entries in 97 Any Recipient field 83
displaying entries in 96 APOP option 123, 145
dragging entries to another file in 98 appears option 84
Fax field in 98 Apple Guide menu 19, 21
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AppleDouble encoding 41 Receive MIME digests as attachments option
126AppleSingle encoding 41

Arrow+these modifiers to switch messages option
137

TEXT files belong to option 127
Trash attachments with messages option 79,
127Attach Document command 40, 42, 153

Attach submenu 40, 110, 153 Authentication option 123, 145
Attachment Folder option 63, 126 Automatically Fcc to original mailbox option 124

conflicts with 63
Attachment plug-ins 40

BAttachment type popup 24
Attachments Background Color option 128

Always include Macintosh information option
126

backslash 167
Balloon Help 22

and UUCP 171 Bcc button
attaching files to outgoing mail 40 in Directory Services 105
Attachment Folder 126 in the Address Book 99

changing 63 Bcc field
conflicts with 63 in outgoing mail 28

Attachments Folder 61 to copy outgoing messages 54
automatically deleting 79 Bigger button 26
copying 61 BinHex encoding 41
decoding 41 BLAH BLAH BLAH icon 60
detaching from a message 40 blank, in the Status column 71
displaying graphics attachments inline 62 Blind copy
dragging to attach 40 with Bcc field 28
encoding 40 with Name field in Address Book 98
Encoding method option 126 Body field 83
graphics Bold button 26

setting for displaying inline 128 Bold text option 38
moving 61 Bounced mail 54
opening 61 Break 168
Receive MIME digests as attachments option
126

But warn me first option 37
Button type option 130

receiving 61
showing location 61

CTEXT files belong to option 127
Trash attachments with messages option 127 Carriage return 167, 169

Attachments column 72 And dialups 165
Attachments Folder 61, 79, 126, 157 Cc button
Attachments Settings 126 in Directory Services 105

Always include Macintosh information option
126

in the Address Book 99
Cc field

Attachment Folder option 126 in Filters 83
Encoding method option 126 in outgoing mail 28
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Change Password command 57, 156 Skip button 44
Change Password submenu 57 View button 45
Change Queueing command 49, 50, 153 Options command 46
Change Queueing dialog 48, 49 Options dialog 46
Change submenu 30, 153 Allow both numbers and letters in words

option 47Check for mail every ? minutes option 55, 122, 144
Check mail HTML checking - ignore between

bracketsautomatically 55, 122, 144
Check for mail every ? minutes option 55 “<>“ option 47
Check Mail command 56 Make a copy of disk documents that are

checked option 47Delete server action 66
entering password 56 Question when a word is uncapitalized

following a period option 46Fetch & Delete server action 66
Fetch icon 66 Question when an “a” is before a vowel or

“an” before a consonant option 47Fetch server action 66
Forget Password command 57 Question when proper nouns are

uncapitalized option 46from multiple Macintoshes 65
Leave mail on server option 66 Question when there are extra spaces

between words option 47Leave on server for ? days option 65
Leave on server option 122 Question when there is a space before

punctuation option 47manually 144
manually check 56 Question when there is only one space

after a period option 47minimum interval 55
Save password option 57 Question when words appear to to be

repeated option 47Skip messages over ? K option 66, 122
stopping 56 Quit after an Apple Events Word Services

spellcheck option 47Trash icon 66
with special instructions 66 Treat hyphenated-words as two words

option 47Check Mail command 55, 56, 57, 148
Check mail on manual checks option 56, 144 View suggestions instead of dictionary

first option 47Check Mail Specially command 66, 148
Check spelling 42 Spellswell 7 42

and curly apostrophes 47 Check Spelling command 150
Check Spelling command 43 Checking Mail Settings 65, 121
Check Spelling dialog 43, 44 Authentication option 123

Add button 45 Check for mail every ? minutes option 55, 122
Delete button 46 Delete from server when emptied from trash

option 68, 122Dictionary field 44
Guess button 45 Don’t check when using battery option 122
Guesses field 44 Leave on server for ? days option 65
Questioned word field 44 Leave on server option 122
Replace All option 44 Overlap POP3 commands option 123
Replace button 44 POP account option 122
Replace with field 44 Save password option 57, 122
Skip All option 44 Send on check option 122
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Skip messages over ? K option 66, 122 Cut command 149
Checkmark on icon bar 24
Choose a “Word Services” application dialog 111

DChoose button 91
Clear command 28, 40, 149 D, in the Status column 53, 71
Close All command 147 Date column 72
Close command 147 Date Display Settings 129
Close messages with mailbox option 138 Date formats option 129
Color popup 26 Display dates using option 129
Color text options 38 Date formats option 129
Command-click on title bar 24 Delay 168
Communications command 18, 155 Delete all messages on server (be sure) option 68
Communications Toolbox 165 Delete all messages that have been retrieved option

67Communications Toolbox option 18
and UUCP 172 Delete button 46

Compact Delete command 79, 153
all mailboxes 74 Delete from server when emptied from trash option

68, 122one mailbox 74
Completely Plain button 27 Delete key 78
Completely Plain option 39, 149 Delete messages marked for deletion option 67
Composition window 23 Delete server action 66, 73, 87
Connecting to servers with dialup 169 Detaching attachment 40
Connection method option 18, 118 Dial-in password 167
Connection tool 166 Dial-in username 167
Connection Tools 16 Dialup 165
contains option 84 Dialup username option 119
Convert Hesiod names to lower-case option 139 Dictionary field 44
Copy & Unwrap command 39, 149 Direct UNIX Navs 170
Copy action 68 Directory Services
Copy blind addressing a message from 105

with Bcc field 28 Bcc button 105
with Name field in Address Book 98 Cc button 105

Copy command 71, 149 finding Ph servers 104
Copy original’s priority to reply option 36, 52, 135 Finger button 103
Copy To action 87 Finger option 120
Copy Without Styles & Unwrap command 39, 149 Finger queries 104
Copy Without Styles command 39, 149 Live Ph queries option 121
Copying a message to a mailbox 28, 80 Ph button 103
Copying message summaries 71 Ph option 120
Correct (but slow) international sorting option 140 Ph queries 103
Creating a new mail folder 77 To button 105
Creating a new mailbox 77 with the shift key 103
CSOm 166 Directory Services command 103, 155
Current maintenance release Discard style information option 37

how to determine 112

184 QUALCOMM Incorporated



Eudora User Manual Index

Disconnect MacSLIP or OT/PPP if Eudora
connected it option 136

Eudora Settings file 157
In file 158

Display dates using option 129 Mailbox Aliases 158
Display graphics attachments inline option 62, 128 Nicknames Folder 157
DNS load balancing option 120 Out file 158
Do Nothing server action 73 Signature Folder 157
does not appear option 84 Spool Folder 157
does not contain option 84 Stationery Folder 158
Domain to Add option 145 Trash file 158
Domain to add to unqualified names option 123 Eudora Information 163
Dominant personality 30, 55, 143, 145 Eudora Items folder
Don’t check when using battery option 122 Plugins folder 157
Don’t make automatic checks when MacSLIP or
OT/PPP is not already connected option 136

Eudora Labels Settings 131
Eudora Pro Application Folder 16

Don’t Send option 50 Eudora Pro Folder 15, 16, 158
Draw separator lines option 141 Documentation Folder 160

Extras Folder 159
Dialup Folder 159

E MacSLIP Folder 159
Plugins Folder 160Echo and dialups 165

Filter Converter folder 158Edit
README file 158incoming mail 64
Spellswell Folder 161outgoing mail 37

Eudora Stuff folder 109, 110, 111Edit menu 149
Excerpt bars 142Add Word Service command 111, 113
Expand nicknames immediately option 101, 102,
124

Clear command 28, 40
Empty the Trash mailbox option 134

Expect 168Empty Trash command 79, 138, 156
Extra Warnings Settings 49, 133Empty Trash on Quit option 19, 79, 138

Empty the Trash mailbox option 134Encoding method option 126
Set a changed message back to read-only
option 134

Encoding methods
AppleDouble 41

Try something that requires too much memory
option 134

AppleSingle 41
BinHex 41

Try to delete any unsent mail option 79Uuencode Data Fork 41
Try to delete any unsent messages option 133ends with option 84
Try to delete queued mail option 79, 133Enter key 59
Try to delete unread mail option 79, 133Enter Selection command 90
Try to queue a message with no subject option
133

Eudora Folder
Attachments Folder 157

Try to queue a message with styled text option
134

Eudora Filters file 157
Eudora Items folder 157

Try to quit with messages queued to be sent
option 134

Eudora Log file 157
Eudora Nicknames file 157
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Try to send a message whose size is more than
? K option 134

Matching Text field 84
None action 85

Extras folder 110 Notify User action 86
Open action 86
or option 85

F Outgoing option 82
Play Sound action 86F, in the Status column 52, 71
Print action 86Fax field 98
re-ordering 83Fcc menu 28, 54
Redirect To action 86Fetch & Delete server action 66, 73
Reply With action 87Fetch icon 60, 66
resizing the list 83Fetch server action 66, 73, 87
Server Options action 87File menu 147
Skip Rest action 87Open in Browser command 65
starts with option 84Quit command 19
Transfer To action 87Filter Converter 158
unless option 85Filter Messages command 82, 155

Filters command 82, 155Filters
Filters window 82and option 85

New button in 82appears option 84
Find Again command 90automatically named 82
Find button 90Conjunction field 85
Find command 89contains option 84
Find dialog 89Copy To action 87
Find submenu 155does not appear option 84
Finding textdoes not contain option 84

Match Case option 90ends with option 84
Search mailboxes option 91Forward To action 86
Search mailfolder option 91Generate filter reports option 140
Search To End option 91header field 83
Summaries only option 91ignore option 85
within a message 90Incoming option 82
within mailboxes and folders 90intersects nickname option 84

Finger button 103, 104invoked from top to bottom 83
Finger option 120is not option 84
Finish & Expand Address Book Entry command
101, 150

is option 84
Last used field 87

Finish Address Book Entry command 101, 150Make Label action 86
Fix curly quotes option 124Make Personality action 86
Flash an icon in the menu bar option 58, 132Make Priority action 86
Font popup 26Make Status action 85
Font text options 39Make Subject action 86
Fonts & Display Settings 127Manual option 82

Background Color option 128Match Type field 84
Display graphics attachments inline option 128
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Message window height option 128 Formatting Toolbar command 25, 39, 149
Message window width option 128 Forward command 52, 152
Print Font and Size options 128 with the option key 52
Screen Font, Size, and Text Color options 127 Forward To action 86
Show formatting toolbar option 129 Forward To submenu 102, 152
Waste cycles drawing trendy 3D junk option
128

Forwarded (F) status 52
From field

Zoom windows when opening option 128 in a forwarded message 52
Forget Password command 57, 156 in Filters 83
Formatting text in outgoing mail 27

Big 38 in redirected message 52
Bold 38 ftp.eudora.com 163
Center 38
Color 38

GCompletely Plain 39
Copy & Unwrap 39 Generate filter reports option 140
Copy Without Styles 39 Getting Attention Settings 132
Copy Without Styles & Unwrap 39 Flash an icon in the menu bar option 58, 132
dragging text 39 Open mailbox option 58, 132
Font 39 Play a sound option 58, 132
Italic 38 Say OK to alerts after 2 minutes option 133
Left 38 Use an alert option 58, 132
Margins Getting Started Settings 17, 117

Hang Indents 38 Communications Toolbox option 18
Indents 38 Connection method option 18, 118
Normal 38 POP account 55, 118

Mondo 38 POP account option 18
Normal 38 Real name option 17, 118
Plain 38 Return address (if different from POP account)

option 18, 27, 118Require control key for text/message dragging
option 140 TCP/IP option 18
Right 38 globe 104
Small 38 gnuucp 171
Styled Text Settings 37 Go To Stationery Folder button 32
text/enriched MIME 37 Go To Stationery Folder option 92
Underline 38 Guess button 45
Unwrap Selection 39 Guess Paragraphs option 92
Very Big 38 Guesses field 44
When receiving styles, pay attention to option
142

HWhen sending mail with applied fonts & styles
option 142 Hang Indent In button 27
Wrap Selection 39 Hang Indent Out button 27

Formatting Toolbar Help menu 19, 21
in outgoing mail 25
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Hide Balloons command 22 Fetch icon 60
More Help! command 22 pencil icon 59
Register Eudora command 19 priority popup 59
Show Balloons command 22 Subject field 60

Hesiod, definition 139 Tow Truck icon 60
Hide Balloons command 22 Trash icon 60
Hide the recipient list message body 61

with Bcc field 28 title bar 59
with Name field in Address Book 98 zooming the window 128

Hosts Settings 103, 120 Incoming option 82
DNS load balancing option 120 Indent In button 26
Finger option 120 Indent Out button 27
Live Ph queries option 121 Insert & Expand Recipient command 102
Overlap POP3 commands option 121 Insert & Expand Recipient submenu 150
Ph option 120 Insert button 42
POP account option 120 Insert Recipient command 102
SMTP option 18, 120 Insert Recipient submenu 150
Use mail-exchange records (SMTP Servers
Only) option 121

Inserting a file 42
Installation 12

Hot link Connection Tools 16
in incoming mail 64 Internet Config
in outgoing mail 42 read from option 139

HTML checking - ignore between brackets write to option 139
“<>” option 47 intersects nickname option 84

HTML text is not option 84
how to view 65 is option 84

Italic text option 38
Italics button 26

I

Icon bar K
in incoming mail 59
in outgoing mail 24 Keep copies of outgoing mail option 54, 125

ignore option 85 Keep copy icon 25, 54
Ignoring previously read messages 66 Kerberos 163
Immediate send option 25, 48, 49, 124 Kerberos option 123, 145
In command 151, 154
In mailbox 58

LInclude Headers option 92
Include Macintosh information icon 24, 41 Label column 72
Include outdated Return-Receipt-To option 139 Labels
Include yourself option 51 creating 131
Incoming message window Last used field 87

icon bar 59 Leave mail on server option 66, 144
BLAH BLAH BLAH icon 60 Leave on server for ? days option 65
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and UUCP 173 Mailboxes
Leave on server option 122 Close messages with mailbox option 138
Linefeed 167, 169 compacting all 74
Live Ph queries option 104, 121 compacting one 74
Lock whole program in memory option 139 creating during transfer 81

creating in folders 75
creating in the Mailboxes window 77

M creating using Mailbox menu 75
displaying columns 73MacSLIP
dragging to main toolbar to create buttons 77AppleScript Examples 159
Draw separator lines option 141MacSLIP Apple Events 159
Make it a folder option 75NetStat 159
message summaries 70Script Examples 159
moving in the Mailboxes window 78MacTCP & MacSLIP
New command 75MacSLIP Manual 160
number of messages 74MacTCP Administrator’s Guide 160
opening 69Mail drop 172
opening other 69Mail folders
removing in the Mailboxes window 78creating during transfer 81
renaming in the Mailboxes window 77creating in the Mailboxes window 77
resizing columns 73creating using Mailbox menu 75
Show columns options 141Make it a folder option 75
size display 74moving in the Mailboxes window 78
sorting messages in 88New command 75
space messages require 74removing in the Mailboxes window 78
space wasted 74renaming in the Mailboxes window 77
transferring messages among 80Mail Storage 157
zooming windows 128Mail Transfer Options dialog 50, 65, 66, 73

Mailboxes command 76, 155Delete all messages on server 68
Mailboxes window 76Delete all messages that have been retrieved

67 New Folder button 77
New Mailbox button 77Delete messages marked for deletion 67
Remove button 78Fetch all message headers to In mailbox 68

Main Toolbar 107Retrieve messages marked for retrieval 67
Make a copy of disk documents that are checked
option 47

Retrieve messages marked for retrieval option
67

Make Address Book Entry command 99, 100, 101,
104, 155

Retrieve new mail 67
Send queued messages 67

from a mailbox 100Transfer mail for the following personalities
68 from an open message window 101

from Directory Services 101Mailbox Columns Settings 73, 141
from selection 99Draw separator lines option 141
from the Address Book 99Show columns options 141

Make Address Book Entry From Selection
command 99, 155

Mailbox menu 151
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Make it a file option 97 Priority column 71
Make it a Folder option 75 resizing columns 73
Make Label action 86 selecting 70
Make Personality action 86 Sender/Recipient column 72
Make Priority action 86 Server Action column 73
Make Status action 85 Size column 73
Make Subject action 86 Status column 71
Managing mail on the server Subject column 73

Delete from server when emptied from trash
option 68, 122

Message window height option 128
Message window width option 128

Delete server action 66, 73 Messages
Do Nothing server action 73 transferring to a mailbox in the Mailboxes

window 78Fetch & Delete server action 66, 73
Fetch icon 66 Miscellaneous Settings 138
Fetch server action 66, 73 Close messages with mailbox option 138
Leave mail on server option 66 Convert Hesiod names to lower-case option

139Leave on server for ? days option 65
Leave on server option 122 Correct (but slow) international sorting option

140Mail Transfer Options dialog 66
Skip messages over ? K option 66, 122 Empty Trash on Quit 79
Trash icon 66 Empty Trash on Quit option 19, 138

Manual option 82 Generate filter reports option 140
Map function keys to buttons option 130 Include outdated Return-Receipt-To option

139Margin Hang Indent text options 38
Margin Indent text options 38 Lock whole program in memory option 139
Margin Normal text option 38 Prompt for receipts requested by self option

140Match case option 90
May use Quoted-Printable option 125 Re-sort mailboxes less often option 139
Message body Read from Internet Config option 139

in incoming mail 61 Require control key for text/message dragging
option 140in outgoing mail 28

Message header Turbo redirect by default 53
in incoming mail 61 Turbo redirect by default option 138
in outgoing mail 27 Use old-style “.toc” files option 139

Message menu 152 Write to Internet Config option 139
Message plug-ins 109 More Help! command 22
Message Plug-ins submenu 110, 150 Moving Around Settings 137
Message priority After transferring or deleting or paging past

end of current message, open option 137how to set 35
Message summaries 70 Arrow + these modifiers to switch messages

option 137Attachments column 72
changing the subject of 64 Return switches among header fields option

138copying 71
Date column 72 Tab to switch fields, option-tab to insert tab

option 137Label column 72
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Multiple accounts in Eudora 29 O
Multiple accounts on one Macintosh 112

On or after option 49Multiple Macintoshes
Online Help 21checking mail from 65
Open action 86Multiple personalities 29
Open command 147
Open Eudora 17

N Open in Browser command 65, 147
Open mailbox option 58, 132

Name field 98 Open Selection command 59, 147
Navigate Options when not using stationery 124

In 166, 169 or option 85
Mid 166 Orientation option 130
Out 166 OT/PPP and MacSLIP Settings 136
special characters 166 Disconnect MacSLIP or OT/PPP if Eudora

connected it option 136New button
in Personalities 143 Don’t make automatic checks when MacSLIP

or OT/PPP is not already connected option 136New button in Address Book 97
New button in Filters window 82 Other command 69, 151, 154
New command 75, 81, 151, 154 Out command 151, 154
New Mailbox dialog 75, 81 Out mailbox 50, 80
New Message command 23, 152 Outgoing message window
New Message To submenu 102, 152 Formatting Toolbar 25
New Message With submenu 32, 153 Align Center button 26
New Text Document command 147 Align Left button 26
Next Time Queued Messages are Sent option 49 Align Right button 26
Nicknames 97 Bigger button 26

“me” 37, 51, 53, 135, 140 Bold button 26
adding to the Quick Recipient List 98 Color popup 26
creating in the Address Book 97 Completely Plain button 27
Expand nicknames immediately option 124 Font popup 26

None action 85 Hang Indent In button 27
Notes field 98 Hang Indent Out button 27
Notification Indent In button 26

Flash an icon in the menu bar option 132 Indent Out button 27
Open mailbox option 132 Italics button 26
Play a sound option 132 Size popup 26
Say OK to alerts after 2 minutes option 133 Smaller button 26
Use an alert option 132 Underline button 26

Notify Sender button 36 icon bar 24
return a receipt 37 attachment type popup 24

Notify User action 86 include Macintosh information icon 24
Nuke command 79, 153 keep copy icon 25

priority popup 24
Queue button 25
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quoted-printable icon 24 Personalities Settings 29, 143
Return Receipt icon 25 Authentication option 145
Send button 25 Check for mail every ? minutes option 55, 144
signature popup 24 Check mail on manual checks option 56, 144
word wrap icon 24 Leave mail on server option 66, 144

message body 28 Pers. Name option 143
message header 27 Personality option 143

Bcc field 28 POP account option 144
Cc field 28 Real name option 144
From field 27 Return address option 144
Subject field 28 Personality Extras Settings 29, 33, 145
To field 27 Domain to Add option 145
X-Attachments field 28 Personality option 145

title bar 23 Send mail whenever sends are done option 146
zooming the window 128 Signature when not using stationery option 146

Outgoing option 82 SMTP Server option 146
Overlap POP3 commands for better performance
option 121, 123

Stationery option 146
Personality field 84
Personality option 143, 145
Personality popup 27, 30

P Personality submenu 30
PhPage Setup command 148

button 103Password
option 120changing 57
query 103server source code for 163
server source code 163Dialup 168

Ph button 103entering 56
Phone field 98forgetting 57
Plain text option 38After failed expect 168
Play a sound option 58, 132remembering 57
Play Sound action 86Saving 57, 122
Plug-in Settings submenu 111, 155Passwords option 123, 145
Plug-ins 109, 166Paste As Quotation command 149

attachment 40Paste command 149
how to purchase third-party Eudora plug-in
software 109

Paste Without Styles command 149
Pencil icon 59, 64

how to remove 111Pers. Name option 143
included with Eudora 109Personal Information Settings 119
message 109Dialup username option 119
resource 109POP account option 119
Rot13 Text 109Real name option 119
Space & Tab Converter 109Return address (if different from POP account)

option 119 Upper/Lower Text 110
PluginsPersonalities 29

Esoteric Settings 160
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EudoraTables 160 Question when an “a” is before a vowel or “an”
before a consonant option 47Forward934 160

Kerberos Settings 160 Question when proper nouns are uncapitalized
option 46Synch I/O 160

Toshiba 160 Question when there are extra spaces between
words option 47Plugins folder 110

POP Account hostname 167 Question when there is a space before punctuation
option 47POP account option 18, 118, 119, 120, 122, 144

and UUCP 172 Question when there is only one space after a
period option 47POP Account password 167

POP Account username 167 Question when words appear to to be repeated
option 47POP server 55, 65, 163

UNIX 163 Questioned word field 43, 44
VAX/VMS 163 Queue button 25, 48, 49

Popper 163 Queue For Delivery command 48, 153
Popup menu Queue mail 48

title bar 74 Change Queueing command 49, 50
Postal Address field 98 Change Queueing dialog 49
Print Don’t Send option 50

current item 112 editing before sending 50
selection only 112 for a certain time 49

Print action 86 Immediate send option 48
Print command 83, 112, 148 Next Time Queued Messages are Sent option

49Print Font and Size options 128
Print One Copy command 112, 148 On or after option 49
Print Selection command 148 Queue button 48
Priority column 71 Queue For Delivery command 48
Priority popup Right Now option 49

default for replies 36 Send message Right Now option 49
in composition window 36 Send Queued Messages command 48
in incoming mail 59 sending queued mail when checking mail 50
in outgoing mail 24 taking mail out of the queue 50
levels 35 Queued (Q) status 48
Raise and Lower 35 Quick Recipient List

Prompt for receipts requested by self option 37,
140

Forward To submenu 102
Insert & Expand Recipient command 102

Put it on the recipient list option 97 Insert Recipient command 102
Put original To recipients in Cc field option 51 New Message To submenu 102

putting nicknames on 98
Recipient List option 102

Q Redirect To submenu 102
QuickTime 2.5 62Q, in the Status column 48, 50, 71
Quit after an Apple Events Word Services
spellcheck option 47

Question when a word is uncapitalized following a
period option 46

Quit command 19, 148
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Empty Trash on Quit option 138 Put original To recipients in Cc field option 52
Quoted text quoting original text 51

in replies 51 Reply command 50
with styles in replies 51 Reply Quoting Selection command 51

Quoted-printable icon 24 Reply Quoting Selection With command 52
Reply to all By default option 51
Reply To All command 51

R Reply With command 52
with stationery 33, 52R, in the Status column 51, 71

Reply command 50, 152Re-sort mailboxes less often option 139
Reply Quoting Selection command 51, 152Read from Internet Config option 139
Reply Quoting Selection To All command 152Real name option 17, 118, 119, 144
Reply Quoting Selection To All With submenu 153Receive MIME digests as attachments option 126
Reply Quoting Selection With command 52Recipient List option 98, 102
Reply Quoting Selection With submenu 153Redirect
Reply to all By default option 51automatically put new message in the queue 53
Reply To All command 51, 52, 152no signature 53
Reply to all option 135Redirect command 52
Reply To All With submenu 153Redirect To submenu 53
Reply With action 87Turbo redirect by default option 53, 138
Reply With submenu 32, 52, 153Turbo Redirect To submenu 53
Reply-To field 83Turbo Redirect Without Delete To submenu 53
ReplyingRedirect command 52, 152

Copy original’s priority to reply option 135Redirect To action 86
Reply to all option 135Redirect To submenu 53, 102, 152
When replying to all option 135with the option key 53

Replying Settings 134Redirected (D) status 53
Copy original’s priority to reply 52, 135Register Eudora command 19
Copy original’s priority to reply option 36Registration 18
Include yourself 51Rejected mail 54
Put original To recipients in Cc field 52Remove All button 78
Reply to all By default 51Remove Button 107
Reply to all option 135in Personalities 143
When replying to all option 135Remove It button 78

Require control key for text/message dragging
option 140

Renaming a mail folder 77
Renaming a mailbox 77

Requirements 11Replace All option 44
resize cursor ( ) 73Replace button 44

Replace with field 43, 44 Resource plug-ins 109
Replied (R) status 51 Retrieve new mail option 67
Reply Retrieve only message headers 68

Copy original’s priority to reply option 52 Return address (if different from POP account)
option 18, 27, 118, 119, 123in a filter with stationery 33

Include yourself option 51 and UUCP 173
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Return address option 144 May use Quoted-Printable option 125
Return key 59 Options when not using stationery 124
Return Receipt icon 25, 36 replies 50
Return switches among header fields option 138 Send button 48
Right Now option 49 Send Immediately command 48
Rot13 Text plug-in 109 Send message Right Now option 49
rsrc 166 Send Messages Specially command 50

Send on check option 122, 124
Send Queued Messages command 48

S sending queued mail when checking mail 50
Signature option 125S, in the Status column 54, 71
Stationery option 124Save All command 29, 147
with server instructions 50Save As command 32, 92, 147

Send mail whenever sends are done option 146Save command 29, 98, 147
Send message Right Now option 49Save mail as text
Send Messages Specially command 50, 147as a single file 93
Send on check option 50, 122, 124Go To Stationery Folder button 92
Send Queued Messages command 48, 147Guess Paragraphs option 92
Send queued messages option 67Include Headers option 92
Send style information with mail option 37Stationery option 92
Send to Back command 156TEXT files belong to option 93
Sendable (•) status 29, 50Save password option 57, 122
Sender/Recipient column 72Saving messages 29
Sending Mail Settings 123Say OK to alerts after 2 minutes option 133

Automatically Fcc to original mailbox option
124

Screen Font, Size, and Text Color options 127
Scripting 170

Domain to add to unqualified names option
123

Scripting, and dialups 165
Search button 90

Expand nicknames immediately option 124Search mailbox option 91
Fix curly quotes option 124Search mailfolder option 91
Immediate send 48Search To End option 91
Immediate send option 25, 124Select All command 149
Keep copies of outgoing mail 54Send Again command 54, 152
Keep copies of outgoing mail option 125Send button 25, 48
May use Quoted-Printable option 125Send Immediately command 48, 153
Options when not using stationery 124Send mail
Return address (if different from POP account)
option 123

all at once 48
at a certain time 49

Send on check 50Change Queueing dialog 48
Send on check option 124Immediate send option 48, 49, 124
Signature option 125keeping copies of outgoing mail 125
SMTP Server option 123keeping copies of outgoing mail in original

mailbox 124 Stationery option 124
Word wrap option 125Mail Transfer Options dialog 50

Sent (S) status 54
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Server Action column 73 Sort Descending submenu 88, 155
Server action popup 66 Sort submenu 88, 155
Server Options action 87 Sorting 88
Set a changed message back to read-only option
134

Correct (but slow) international sorting option
140

Settings command 17, 117, 155 Group Subjects option 88
Settings Icons Settings 140 in descending order 88
Sharing a Macintosh 112 Re-sort mailboxes less often option 139
Show Balloons command 22 sticky 88
Show columns options 141 with the shift key 88
Show formatting toolbar option 25, 129, 142 Space & Tab Converter plug-in 109
Show function key labels option 130 Space bar 59
Show toolbar option 130 Special menu 155
Sidebars, in quoted text 142 Communications command 18
Signature option 125 Settings command 17
Signature popup 24 Spelling checker problems

in composition window 35 how to correct 44
Signature when not using stationery option 146 Spellswell (spell checker)
Signatures what to do if Eudora has trouble with it 113

and redirect 53 Split-screen button 96
creating an additional 34 Splitter cursor 107
creating or modifying the Alternate 34 Srialpop 169
creating or modifying the Standard 34 Starting field 90, 91
including in a message 35 starts with option 84
including in all messages 35 Stationery files 32
modifying an additional 34 Stationery messages
removing an additional 34 changing 33

Signatures command 34 creating 32
Signatures submenu 156 creating a default 33
Size Big text option 38 deleting 33
Size column 73 opening 32
Size Mondo text option 38 opening with a filter 33, 87
Size Normal text option 38 Stationery option 32, 92, 124, 146
Size popup 26 Stationery popup 33
Size Small text option 38 Status
Size Very Big text option 38 -, never sent 71
Skip All option 44 <blank>, read or unsendable 71
Skip button 44 D, redirected 53, 71
Skip messages over ? K option 66, 122 F, forwarded 52, 71
Skip Rest action 83, 87 Q, queued 48, 50, 71
Smaller button 26 R, replied 51, 71
SMTP option 18, 120 S, sent 54, 71
SMTP server hostname 167 T, timed 49, 71
SMTP Server option 123, 146 •, sendable or unread 29, 50, 58, 71

and UUCP 172 Status column 71
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Sticky sort 88 To field
Styled Text Settings 37, 61, 142 in a reply 50, 51

But warn me first 37 in Filters 83
Discard style information 37 in outgoing mail 27
Send style information with mail 37 Toolbar
Show formatting toolbar option 142 Button type option 130
When receiving styles, pay attention to option
142

formatting 25
show/hide by default setting 129, 142

When sending mail with applied fonts & styles
option 142

main 107
adding a button 107

Subject column 73 changing a button 108
Subject field displaying 108

changing in message summaries 64 dragging files to create buttons 108
in Filters 83 mapping to function keys 108
in incoming mail 60 moving a button 108
in outgoing mail 28 removing a button 108

Summaries only option 91 scrolling arrows 108
settings 130
transferring messages using 108

T Map function keys to buttons option 130
Orientation option 130T, in the status column 49, 71
Show function key labels option 130Tab key
Show toolbar option 130switching fields with 27

Toolbar Button Creation dialog 107Tab to switch fields, option-tab to insert tab option
137 Toolbar Settings 108, 130

Button type option 130Tabs
Map function keys to buttons option 130and the Save As command 92
Orientation option 130inserting 137
Show function key labels option 130switching fields 137
Show toolbar option 130TCP/IP option 18

Tow Truck icon 60, 78and UUCP 172
Transfer action 68Technical support 22
Transfer mail for the following personalities option
68

More Help! topic 22
TEXT files belong to option 93, 127

Transfer menu 154Text submenu 38, 149
Transfer To action 83, 87Timed (T) status 49
Transferring mail to another mailboxTimeout 168

and creating a mailbox or folder 81Title bar
by dragging it 80for incoming mail 59
by dragging the Tow Truck icon 80for outgoing mail 23
using the option key 80Title bar popup menu 74
using the Transfer menu 80To button

Transferring mail to the Out mailbox 80in Directory Services 105
Trash attachments with messages option 79, 127in the Address Book 99
Trash command 151, 154
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Trash icon 60, 66 unless option 85
Trash mailbox 54, 79 Unqualified name, adding domain 123, 145
Treat hyphenated-words as two words option 47 Unread (•) status 58
Troubleshooting 112 Unwrap Selection command 39, 149

“-ERR Maildrop lock busy” 114 Upper/Lower Text plug-in 110
“A TCPClose command was already issued”
115

URL
choosing an application 64

“Can’t queue this message” 113 in incoming mail 64
“Connection came up halfway then failed” 115 in outgoing mail 42
“Error opening your settings file” 114 Use an alert option 58, 132
“Mailbox has a damaged table of contents”
115

Use Folder button 63
Use mail-exchange records (SMTP Servers Only)
option 121“Memory is tight” 113

“Message columns don’t line up” 116 Use old-style “.toc” files option 139
“Messages not wrapping correctly” 116 UUCP 171
“No Date header in your mail” 116 Mail drop format 173
“Password is incorrect” 114 Working files 173
“Random display problems” 116 D.mac0 ###
“Spellswell trouble (spell checking)” 113 X.mac0 ###
and README file 113 UUCP/Connect 171
Spell-checking problems 44 Uuencode Data Fork encoding 41

Try something that requires too much memory
option 134

uupc 171

Try to delete any unsent mail option 79
VTry to delete any unsent messages option 133

Try to delete queued mail option 79, 133 View button 45
Try to delete unread mail option 79, 133 View By option 96
Try to queue a message with no subject option 133 View suggestions instead of dictionary first option

47Try to queue a message with styled text option 134
Try to quit with messages queued to be sent option
134

WTry to send a message whose size is more than ? K
option 134 Warnings
Turbo redirect by default option 53, 138 Empty the Trash mailbox option 134
Turbo Redirect To submenu 53, 152 Set a changed message back to read-only

option 134with the option key 53
Turbo Redirect Without Delete To submenu 53,
152

Try something that requires too much memory
option 134
Try to delete any unsent mail option 79
Try to delete any unsent messages option 133U
Try to delete queued mail option 79, 133

Underline button 26 Try to delete unread mail option 79, 133
Underline text option 38 Try to queue a message with no subject option

133Undo command 149
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Try to queue a message with styled text option
134
Try to quit with messages queued to be sent
option 134
Try to send a message whose size is more than
? K option 134

Waste cycles drawing trendy 3D junk option 128
When receiving styles, pay attention to option 142
When replying to all option 135
When sending mail with applied fonts & styles
option 142
Whole word option 90
Window menu 156
Windows

sending to the back 156
zooming 128

Word Service, adding 111
Word wrap icon 24, 39
Word wrap option 125
Wrap Selection command 39, 149
Wrapped text 24, 39
Write to Internet Config option 139

X

X-Attachments field
in a forwarded message 52
in outgoing mail 28, 40
in redirected messages 52

Z

Zoom windows when opening option 128
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